Contents

About FileMaker Server ...................................................... 8

New features in FileMaker Server 11 ................................. 9

Deploying FileMaker Server ............................................... 11
  Which deployment type is right for me? ................................ 12
  Testing FileMaker Server .............................................. 13
  Checking the status of your deployment ............................... 15
  Changing a FileMaker Server deployment ............................. 17

Starting Admin Console .................................................. 18

Hosting databases .......................................................... 20
  Editing accounts and privilege sets .................................. 21
  Uploading database files ............................................. 22
  Uploading database files manually .................................. 24
  Verifying databases are available to FileMaker Pro clients ......... 25

Hosting websites ........................................................... 27
  Hosting PHP websites .................................................. 28
  Starting PHP Site Assistant from Admin Console .................... 30
  Hosting XSLT websites .............................................. 31
  Hosting databases for XML queries ................................. 33
  Using Instant Web Publishing ....................................... 34

Starting and stopping FileMaker Server ............................... 36

Configuring general settings ............................................ 37
  Server information settings ......................................... 38
  Email notification settings ......................................... 40
  Admin Console settings ............................................. 42
  Auto Start settings .................................................. 44

Configuring administrator groups ..................................... 45
  Adding administrator groups ........................................ 47
  External authentication for Admin Console and administrator groups ........................................ 50
  FileMaker Server group folders .................................... 52
  FileMaker Server administrator group privileges .................... 53

Configuring Database Server settings ............................... 55
  FileMaker Pro client settings ........................................ 56
  Using SSL with an LDAP directory service ......................... 59
  Database settings .................................................... 61
  Cache flushing operation ........................................... 63
Database Server security settings ................................................................. 64
  External authentication for database access ......................................... 66
Default folder settings .............................................................................. 67
Logging and statistics settings ................................................................. 69
Server plug-in settings .............................................................................. 71

Configuring web publishing settings ...................................................... 72
  General web publishing settings ............................................................... 73
  PHP web publishing settings .................................................................. 74
  XSLT web publishing settings ................................................................. 76
  Text encoding for XSLT requests ............................................................ 78
  Configuring the interaction between web sessions and database sessions ............................................................................ 79
  XML web publishing settings ................................................................. 80
  Instant Web Publishing settings .............................................................. 81

Administering clients .................................................................................. 82
  Sending messages to FileMaker Pro clients .............................................. 83
  Disconnecting clients .............................................................................. 84

Administering databases .......................................................................... 85
  Sending messages to FileMaker Pro clients of selected databases .......... 87
  Opening hosted files ............................................................................... 88
  Closing hosted files ............................................................................... 89
  Verifying hosted files ........................................................................... 90
  Pausing hosted files .............................................................................. 91
  Resuming hosted files ........................................................................... 92
  Removing hosted files ........................................................................... 93

Using ODBC and JDBC with FileMaker Server ....................................... 95
  Sharing FileMaker databases via ODBC and JDBC ................................ 97
  Enabling sharing via ODBC and JDBC .................................................. 98
  Accessing external ODBC data sources ................................................. 99

Monitoring FileMaker Server .................................................................. 101
  Viewing server statistics ....................................................................... 103
  Viewing client statistics ........................................................................ 105
  Viewing log file entries ......................................................................... 107
    Event log ......................................................................................... 110
    Access log ..................................................................................... 111
    Server statistics log .......................................................................... 112
    Client statistics log .......................................................................... 113
    Web publishing logs .......................................................................... 114
    Web Server Module log ..................................................................... 115

Managing plug-ins .................................................................................. 116
  Enabling server-side plug-ins ............................................................... 117
  Folders for server-side plug-in files ....................................................... 118
  Changing plug-in file permissions (Mac OS) ........................................... 119
  Enabling auto-update for plug-ins ......................................................... 120
About FileMaker Server

FileMaker® Server is a dedicated database server that opens FileMaker Pro files, makes them available to clients on your network, and publishes FileMaker data in web pages or to other applications.

**Note** If you are a group administrator, your server administrator must configure your administrator group to allow you to do database administration tasks. Group administrators are not allowed to configure FileMaker Server or perform other server administration tasks described in many of the topics in this online Help system. A note at the beginning of each major topic indicates which tasks group administrators are allowed to do if the server administrator selects the appropriate privilege for the group. For more information, contact your server administrator.

**FileMaker Server Advanced**

FileMaker Server Advanced has all the features of FileMaker Server plus:

- Sharing data as a SQL data source via ODBC and JDBC. See Sharing FileMaker databases via ODBC and JDBC.
- Administrator groups. See Configuring administrator groups.

To upgrade an existing FileMaker Server deployment to FileMaker Server Advanced, you need a FileMaker Server Advanced license key. You can enter a new license without reinstalling any software. To update your license key, see Server information settings.

**Supported clients**

Supported clients include:

- FileMaker Pro 9, 10, and 11
- Web users accessing data via the FileMaker Server Web Publishing Engine
- FileMaker ODBC (Open Database Connectivity) and JDBC (Java Database Connectivity) clients using the FileMaker client drivers (FileMaker Server Advanced license required)

**Admin Console**

FileMaker Server Admin Console is an application that lets you easily configure and administer FileMaker Server, work with and monitor hosted databases and clients, and track statistical information.

You can run Admin Console on the same machine where FileMaker Server is running or on almost any Windows or Mac OS machine that has network access to FileMaker Server. See Starting Admin Console.

**Related topics**

New features in FileMaker Server 11
New features in FileMaker Server 11

FileMaker Server 11 includes the following new features and improvements:

Delegation of database administration tasks
  • Administrator groups — As the server administrator, you can use administrator groups to delegate database administration tasks to other users. You retain exclusive and complete control of FileMaker Server. Group administrators are not allowed to configure FileMaker Server, and you specify which database administration tasks you want to allow group administrators to do. See Configuring administrator groups.

Security enhancements
  • You can use SSL data encryption to encrypt the user names and passwords that FileMaker Server and FileMaker Pro clients use to log in to LDAP servers. See Specifying directory service settings.
  • You can also use Secure Sockets Layer (SSL) data encryption when FileMaker Server connects to an SMTP email server to send email notifications when errors or warnings are detected or when a scheduled task is completed. See Email notification settings.

Scripts enhancements
  • In the Schedule assistant, you can specify a user account to use to run system-level scripts. See Selecting a system-level script to run.
  • In the Schedule assistant, you can select time limit options for a script schedule. See Adding script options.

Client statistics

Schedules enhancement—clone the backup file
  • In the Schedule assistant, enable Clone the backup file to save your backed up file’s tables, layouts, scripts, page setup options, and field definitions without the data. You can possibly import the data from a damaged database into a clone of the backed up database. See Selecting the backup folder and options.

Transferring schedules and groups to a new installation
  • If you need to reinstall FileMaker Server on the same machine or move the installation to another machine, you can save the settings for your schedules and administrator groups that are configured in the current installation. After you install FileMaker Server, you can then load the settings for your schedules and administrator groups to instantly configure them in the new installation. See Saving and loading schedules and groups.

Other enhancements
  • If Admin Console does not respond, you can restart the Admin Server process by using the RESTART command-line interface command. For more information, see RESTART command.
You can start PHP Site Assistant from Admin Console. See Starting PHP Site Assistant from Admin Console.

Related topics
About FileMaker Server
Deploying FileMaker Server

**Note** The following information is for server administrators.

When you install FileMaker Server, you decide whether to deploy FileMaker Server on a single machine or on multiple machines.

In a multiple-machine deployment, one machine is always the master and the others are workers.

- **The master machine** is always the machine on which the Database Server is deployed.
- **The worker machines** are the machines that run the Web Publishing Engine or the web server.

In a single-machine deployment, all components run on one machine, which can be considered the master machine.

For more information, see [Which deployment type is right for me?](#)

After you install FileMaker Server on the master machine, the Deployment assistant guides you through the process of deploying FileMaker Server components.

The Deployment assistant helps you perform the following tasks:

- Create an administrator account that you use to login to FileMaker Server Admin Console
- Set the name of your FileMaker Server deployment
- Enable sharing via ODBC and JDBC (FileMaker Server Advanced license required)
- Enable web publishing and select the web publishing technologies you want to use
- Select a deployment type, and in a multiple-machine deployment, assign machine roles
- Specify a web server (when web publishing is enabled)

You can also test your deployment after initial setup and change your deployment later as your needs change. See [Changing a FileMaker Server deployment](#).

**Note** If you cancel the Deployment assistant during initial deployment, Admin Console exits and FileMaker Server is not deployed. Any attempt to start Admin Console starts the Deployment assistant for you to finish deploying FileMaker Server.
Which deployment type is right for me?

Note The following information is for server administrators.

The type of deployment you should use depends primarily on the web publishing load, as summarized below. The greater the web publishing load, the more machines you may want to include in your FileMaker Server deployment. You can first deploy on fewer machines and, if the load increases over time, you can change the deployment later to use up to three machines.

<table>
<thead>
<tr>
<th>FileMaker Server use</th>
<th>Deployment type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FileMaker Pro clients only</strong></td>
<td>Single machine. No benefit from a multiple-machine deployment.</td>
</tr>
<tr>
<td>Solution development and testing</td>
<td>Single machine. No benefit from a multiple-machine deployment.</td>
</tr>
<tr>
<td><strong>FileMaker Pro clients and moderate web publishing load</strong></td>
<td>Single machine. Provides good web publishing performance in most environments. You can expand to a multiple-machine deployment later, if web publishing load increases. Two machines (alternative). Available when you need to integrate with an existing web server on a separate machine.</td>
</tr>
<tr>
<td>Moderate to heavy web publishing load</td>
<td>Multiple machines. You can expand from two to three machines as load increases.</td>
</tr>
<tr>
<td><strong>FileMaker Pro clients and heavy web publishing load</strong></td>
<td>Multiple machines. Deploy only the Database Server on the master machine. Deploy the Web Publishing Engine and web server on one or two worker machines. Three machines. Select this only when you:</td>
</tr>
<tr>
<td></td>
<td>• Need to combine the performance improvement of the two-machine deployment with separate web server offered by the two-machine (alternative) deployment type.</td>
</tr>
<tr>
<td></td>
<td>• Expect a high volume of static web traffic in addition to FileMaker Pro and dynamic web publishing traffic.</td>
</tr>
</tbody>
</table>

If you're considering a multiple-machine deployment, three variations give you the flexibility to decide which components are on each machine. For details, see FILEMAKER SERVER GETTING STARTED GUIDE on the Start Page.

Related topics
- Deploying FileMaker Server
- Selecting a deployment type
- Assigning worker machine roles
Testing FileMaker Server

Note The following information is for server administrators and group administrators.

The easiest way to test your FileMaker Server deployment is to use the Technology Tests page. The links on this page access the hosted FMServer_Sample.fp7 database via the technologies listed below. If a test succeeds, then all the FileMaker Server components are working.

To test the FileMaker Server deployment:

1. Open the Technology Tests page.
   There are two ways to view the page:
   • Start Admin Console and click the Open Test Page icon:

   • Type the following in a web browser:
     http://[host or IP address of master]:16000/test

2. Click the link for each test that you want to perform.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test FileMaker Pro</td>
<td>Click Test FileMaker Pro. If FileMaker Pro starts and successfully opens the sample database hosted on FileMaker Server, then the Database Server is working and responding to requests from FileMaker Pro clients. Note You must have FileMaker Pro or FileMaker Pro Advanced installed locally on the machine where you are conducting the test. Tip You can perform the same test another way: start FileMaker Pro from any networked machine, click File menu &gt; Open Remote, select the server you want to test, and select FMServer_Sample.fp7.</td>
</tr>
<tr>
<td>Test Instant Web Publishing</td>
<td>Click Test Instant Web Publishing. If another web browser window or tab opens and displays the sample database, then Instant Web Publishing is working. Note A FileMaker Server Advanced license is required.</td>
</tr>
<tr>
<td>Test PHP Custom Web Publishing</td>
<td>Click Test PHP Custom Web Publishing. If another web browser window or tab opens and displays a table containing data from the sample database, then Custom Web Publishing with PHP is working.</td>
</tr>
<tr>
<td>Test XSLT Custom Web Publishing</td>
<td>Click Test XSLT Custom Web Publishing. If another web browser window or tab opens and displays a table containing data from the sample database, then Custom Web Publishing with XSLT is working.</td>
</tr>
</tbody>
</table>

Related topics
Deploying FileMaker Server
Deploying FileMaker Server

Testing FileMaker Server

Configuring Database Server settings
Configuring web publishing settings
Checking the status of your deployment

Note  The following information is for server administrators and group administrators.

The FileMaker Server Overview pane displays real-time status information about your FileMaker Server deployment updated every few seconds. If you are a group administrator, the name of the group you are currently administering appears at the top of the FileMaker Server Overview pane.

The Server Status Information area shows the overall condition of your FileMaker Server deployment.

The diagram illustrates how many machines are in your deployment along with the IP address of each machine and the status of the Database Server, Web Publishing Engine, and web server. If the indicator next to any component name is red, then that component is not functioning or the master machine cannot communicate with the worker machine the component is running on.

The diagram also shows whether a supported web publishing technology or ODBC/JDBC sharing is enabled (ON/OFF).

The Server Information list provides the following:

<table>
<thead>
<tr>
<th>Server information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileMaker Host Name</td>
<td>The name that is assigned to the FileMaker Server deployment. If you are a server administrator, you can change the name. See Server information settings.</td>
</tr>
<tr>
<td>Server Version</td>
<td>The version of FileMaker Server.</td>
</tr>
<tr>
<td>Server Start Time</td>
<td>The date and time stamp when the server was last started.</td>
</tr>
<tr>
<td>Hosted Files</td>
<td>The number of databases that are currently open.</td>
</tr>
<tr>
<td>FileMaker Pro Clients</td>
<td>The number of clients connected using FileMaker Pro.</td>
</tr>
<tr>
<td>Instant Web Publishing Sessions</td>
<td>The number of web publishing sessions currently used by Instant Web Publishing.</td>
</tr>
<tr>
<td>Custom Web Publishing Sessions</td>
<td>The number of web publishing sessions currently used by Custom Web Publishing.</td>
</tr>
<tr>
<td>ODBC/JDBC Sessions</td>
<td>The number of database sessions currently used by ODBC and JDBC clients.</td>
</tr>
</tbody>
</table>

Note  The sessions count shown on the FileMaker Server Overview pane is an instantaneous count that is updated at the same interval as the statistics log. This data is not subject to the five-second threshold that is required for sessions to appear in the Clients or Databases panes.

Changing the FileMaker Server deployment (server administrators only)

If you are a server administrator, you can change the number and role of machines in your deployment by clicking Edit Server Deployment. For more information, see Changing a FileMaker Server deployment.

To change the maximum number of web publishing sessions, see General web publishing settings.

Information for group administrators

If you are a group administrator, your server administrator must configure your administrator group to allow you to do database administration tasks. Group administrators are not allowed to configure FileMaker Server or perform other server administration tasks described in many of the topics in this
online Help system. A note at the beginning of each major Help topic indicates which tasks group administrators are allowed to do if the server administrator selects the appropriate privilege for the group.

If your account is associated with more than one administrator group, Admin Console displays the Select Administrator Group dialog box when you log in. Select the administrator group you want to administer and click OK. After logging in, you can switch administrator groups by choosing Server menu > Groups and then the group name.

For more information, contact your server administrator.

Notes

• Instant Web Publishing and sharing via ODBC/JDBC require a FileMaker Server Advanced license.

• If you set up a machine as a worker and want to change it to a master, uninstall and then reinstall FileMaker Server. Choose Master in the installer’s Master/Worker Designation dialog box. For more information on moving an existing installation, see the FileMaker Server Getting Started Guide on the Start Page.

Related topics

Troubleshooting
Deploying FileMaker Server
Changing a FileMaker Server deployment

**Note** The following information is for server administrators.

You can first deploy on fewer machines and, if the web publishing load increases over time, you can use the Deployment assistant to change your FileMaker Server deployment to use up to three machines.

**To change a FileMaker Server deployment:**

1. Click FileMaker Server Overview, then click the Edit Server Deployment link.
   - The Deployment assistant starts.
2. Click Next until you see the options you want to change.
   - The Deployment assistant shows the current selections.
3. Change any of the selections in these Deployment assistant steps:
   - Enabling web publishing
   - Enabling technologies for web publishing
   - Selecting a deployment type
   - Assigning worker machine roles
   - Specifying a web server
   
   Except for enabling or disabling specific web publishing technologies, the other steps listed above can be changed only in the Deployment assistant. You can change all other settings in the Admin Console panes under Configuration.
4. In the Deployment Summary step, review your selections and click Finish to confirm your selections.
   - FileMaker Server implements your deployment changes. This may take a few minutes.
   - Click Back to return to the previous step or Cancel to cancel the deployment.

**Notes**

- To change the master machine, you must uninstall FileMaker Server and reinstall it on the new master machine. You should also uninstall and then reinstall the worker machines in a multiple-machine deployment. For more information on upgrading or moving FileMaker Server from an existing installation, see the FILEMAKER SERVER GETTING STARTED GUIDE on the Start Page.
- You can add one more worker machine to a two-machine deployment and you can add up to two worker machines to a single-machine deployment.
- You can also remove worker machines from an existing deployment.

**Related topics**

Deploying FileMaker Server
Starting Admin Console

Note The following information is for server administrators and group administrators.

You can start FileMaker Server Admin Console on a Windows or Mac OS computer that has network access to the master machine in your FileMaker Server deployment. FileMaker Server delivers Admin Console as a lightweight Java client to your remote computer via Java Web Start technology.

Note On Mac OS, your remote computer must have at least version 5 of the Java Runtime Environment installed before you can start Admin Console. On Windows, the 32-bit version of Java 6 Update 16 is required.

To start Admin Console:

1. Open a web browser and enter:
   
   http://<host>:16000
   
   where <host> is the IP address or domain name of the master machine in your FileMaker Server deployment.
   
   The Admin Console Start Page appears.

2. Click Start Admin Console.
   
   The admin_console_webstart.jnlp file downloads to your machine.

3. Before Admin Console starts, you must respond to a security message. The security message is a signed certificate that ensures the authenticity of the product and it must be accepted to start Admin Console. To suppress this message in the future and continue:
   
   • Windows: enable Always trust content from this publisher, then click Run.
   
   • Mac OS: click Show Certificate and open Trust Settings. For When using this certificate, choose Always Trust, then click Trust.

4. In the Create Shortcut dialog box, click Yes to create a shortcut that you can use to start Admin Console again later.
   
   Windows: A shortcut is created on the desktop and in the Start menu under FileMaker Server. Depending on the version of Java installed, the shortcuts are created without prompting you.
   
   Mac OS: After you click Yes, specify a name and location in the Save dialog box where to save the shortcut, and then click Save.
   
   The shortcut is helpful if you are managing several deployments of FileMaker Server from the same machine. The shortcut name starts with “FMS11-” and is followed by the FileMaker Server name that you specified in the Deployment assistant.

5. In the Admin Console Login dialog box, enter the user name and password for the Admin Console account.
   
   Admin Console starts and displays the FileMaker Server Overview pane.

Notes

• Each shortcut starts Admin Console for a specific FileMaker Server deployment. If the IP address of the master machine changes, you must remove the shortcut and start Admin Console from the Admin Console Start Page again.

• Admin Console always displays in the language of the base OS installation on the master machine. The language setting of the machine running Admin Console has no effect.
• Internet Explorer: If the Start Page doesn’t appear, click the Information Bar at the top of the browser window and allow Internet Explorer to run the Java Web Start ActiveX Control add-on.

• If Admin Console doesn’t start, your browser might have downloaded the Java Web Start file but might not have started it. Check your web browser configuration to enable Java or automatically open downloaded files. You can also look for the admin_console_webstart.jnlp file where your browser saves downloaded files. Double-click this file to start Admin Console.

**Related topics**
- [Admin Console problems](#)
- [About FileMaker Server](#)
Hosting databases

Note  The following information is for server administrators and group administrators.
Before you can share FileMaker Pro database files, it’s important to prepare the files for hosting. The steps below provide an overview of the process.

1. Edit the accounts and privileges sets that clients will use for shared access. See Editing accounts and privilege sets.
2. Upload the database files to FileMaker Server. See Uploading database files.
3. Verify the status of your files in the Admin Console Databases pane, and verify that the files are available to FileMaker clients. See Verifying databases are available to FileMaker Pro clients.

Notes

• FileMaker Server 11 supports FileMaker Pro 9, 10, and 11 clients.
• You must convert files created in FileMaker Pro 6 and earlier to the .fp7 file format. See FileMaker Pro Help for information on converting files.
• If a hosted database is designed to access data from an external SQL data source, you must set up the same ODBC data source name (DSN) on the FileMaker Server master machine as was set up on the machine running FileMaker Pro when the database was created. See Accessing external ODBC data sources.
• If a hosted database uses server-side plug-ins or if you want to automatically update client-side plug-ins, then you must place the plug-ins on FileMaker Server also. See Managing plug-ins.
• You cannot use peer-to-peer database hosting in FileMaker Pro on the same computer that FileMaker Server is running on.
• As FileMaker Server opens files that were not closed properly or have not been opened in a FileMaker Pro 8 or later product, FileMaker Server performs a consistency check on each file and logs the result of the check in the event log.
• Up to 125 FileMaker Pro database files can be hosted on FileMaker Server and automatically opened when FileMaker Server starts.
• If you are a group administrator, your server administrator must configure your administrator group to allow you to upload databases to your group folder. For more information, contact your server administrator.

Related topics
Administering databases
Closing hosted files
Administering clients
Viewing server statistics
Sending messages to FileMaker Pro clients
Enabling auto-update for plug-ins
Hosting databases

Editing accounts and privilege sets

Note  The following information is for server administrators and group administrators.

In FileMaker Pro, edit the accounts and privilege sets that clients will use for access to each database. Choose File menu > Manage > Security.

• Enable the appropriate extended privileges for particular privilege sets. Every account assigned to a privilege set with extended privileges will be able to access the database through the protocol associated with an extended privilege (for example, Access via FileMaker Network). For more information on accounts, privilege sets, and extended privileges, see the FileMaker PRO USER’S GUIDE.

• Enable the privilege to Disconnect user from FileMaker Server when idle to disconnect idle users from FileMaker Server for each account (or keep them connected), as necessary. For more information on setting the length of time a user must be idle before being disconnected, see FileMaker Pro client settings.

• If you plan to use external authentication, then you must edit each FileMaker Pro account that clients will use for shared access. In the Edit Account dialog box, for Account is authenticated via, choose External Server. For more information on enabling external authentication for FileMaker Pro accounts, see FileMaker Pro Help. For more information on setting up FileMaker Server to support external authentication, see Database Server security settings.

Related topics

- Uploading database files
- Verifying databases are available to FileMaker Pro clients
- Hosting databases
Uploading database files

Note The following information is for server administrators and group administrators.

Use the Upload Database assistant to transfer database files from your computer’s file system to FileMaker Server, and optionally have FileMaker Server open the files.

To upload database files to FileMaker Server:

1. Ensure that the appropriate accounts and privilege sets are enabled.
   See Editing accounts and privilege sets.

2. If the database files are open, you must close them before you can upload them.

3. Click the Upload Database icon in the toolbar to start the Upload Database assistant:

4. Select the FileMaker Server folder where you want to place the database files. Or click Create Subfolder to create a new subfolder.

FileMaker Server hosts database files in the default database folder and in an optional additional database folder that you can specify as described in Default folder settings. You can also create one level of subfolders in either folder.

5. Click Add Database, select one or more databases to upload to FileMaker Server, then click Select.

   Important Database files must be closed before you can upload them. If you have the databases open in FileMaker Pro, for each file choose File menu > Close.

   See Selecting databases to upload for more information.

6. Click Next.

7. Select Automatically open databases after upload if you want FileMaker Server to open the database immediately after the upload is complete.

   See Specifying an upload option for more information.

8. Click Next.

9. View the upload progress. When completed, click Next.

   See Viewing the database upload status for more information.

10. Confirm the status of the uploaded database files and click Finish.

   See Reviewing the upload summary for more information.

For detailed instructions, click the Help button in the Upload Database assistant.

Notes

• If you are a group administrator, your server administrator must configure your administrator group to allow you to upload databases to your group folder. For more information, contact your server administrator.

• Alternate ways to start the Upload Database assistant are:
  • Choose Server menu > Upload Database.
  • Choose Databases > Actions menu > Upload Database and click Perform Action.
• Move your mouse to the **Databases** pane, then right-click your mouse, and select **Upload Database**.

• After uploading is complete, the **Database Server** checks whether a database has some form of sharing enabled. If no sharing is enabled, the Database Server automatically enables sharing via FileMaker Network (extended privilege `fmapp`) for the Full Access privilege set.

• For information on how to remove databases that are already hosted, see **Removing hosted files**.

• You can upload only files with a filename extension of `.fp7` or of a registered runtime solution. For more information on registered runtime file types, see **Database settings**.

• File names must be unique for the entire server regardless of the folder or subfolder.

• You can also manually copy database files to FileMaker Server. See **Uploading database files manually**.

• In Mac OS, the Upload Database assistant automatically sets the file owner to `fmserver` and the group to `fmsadmin`. Both the owner and group have read and write permission, but others have read-only permission. You must set ownership and permissions yourself if you upload databases manually.

**Related topics**

- Verifying databases are available to FileMaker Pro clients
- Hosting databases
Uploading database files manually

Note The following information is for server administrators and group administrators.

You can manually copy FileMaker Pro database files to FileMaker Server instead of using the Upload Database assistant. However, you must be sure to do the following:

- Place database files in the proper location.
- Change group ownership for files (Mac OS only).

Important If you need to move, copy, or rename a hosted file, be sure to close it first.

Place database files in the proper location

Place the FileMaker Pro database files that you want FileMaker Server to open — or shortcuts (Windows) or aliases (Mac OS) to those files — in the following folders:

- Windows (32-bit): \[drive]\:\Program Files\FileMaker\FileMaker Server\Data\Databases\file_name.fmp11
- Windows (64-bit): \[drive]\:\Program Files (x86)\FileMaker\FileMaker Server\Data\Databases\file_name.fmp11
- Mac OS: /Library/FileMaker Server/Data/Databases/file_name.fmp11

Or you can place the files in an optionally specified additional database folder. See Default folder settings.

Note (Windows only) If FileMaker Server is installed in a non-default location, the beginning portion of the default path shown above, \Program Files\FileMaker\FileMaker Server (Windows 32-bit) or \Program Files (x86)\FileMaker\FileMaker Server (Windows 64-bit), is replaced with the path that was specified during installation. For example: \My_Path\Data\Databases\file_name.fmp11

Change group ownership for files (Mac OS)

For files that will be shared from Mac OS, change the files to belong to the fmsadmin group. To edit databases shared from Mac OS, files should also have group read and write access enabled. For more information, see Users, groups, and permissions (Mac OS).

Note Any Mac OS subfolders containing databases, backups, script files, or plug-ins must also be readable and executable by the fmsadmin group. Database and backup folders need to be writable by the fmsadmin group for backups and uploads. Some plug-ins or scripts that use preferences or folders of additional files may require write permission to those files or folders.

Related topics

Uploading database files
Verifying databases are available to FileMaker Pro clients
Enabling auto-update for plug-ins
Hosting databases

Verifying databases are available to FileMaker Pro clients

Verifying databases are available to FileMaker Pro clients

Note  The following information is for server administrators and group administrators.

When FileMaker Server starts, it automatically opens and hosts all FileMaker Pro databases located in the default database folder and in an additional database folder, if specified. In the Databases pane, the databases are listed as Normal in the Status column.

To verify that databases were opened when FileMaker Server started and that databases are available to FileMaker Pro clients, check the following:

• the status of files listed in the Databases pane is Normal
• the Pro column contains a check mark (the fmapp extended privilege is set for at least one account)
• you can open remote files in FileMaker Pro
• review the Event.log (or the Windows Event Viewer) for FileMaker Server messages about opening the file

To verify the status of files listed in the Databases pane:

2. Click Databases.
   If you manually added files to the default database folder after startup, those files are listed as Closed and you must open them manually.
3. If the status of a database is Closed, select the database. For Actions, select Open.
4. Click Perform Action.
   It may take several minutes to open a large file. As FileMaker Server opens files that were not closed properly or have not been opened in a FileMaker Pro 9 or later product, FileMaker Server performs a consistency check on each file and logs the result of the check in the event log.
   Tip  If a folder containing databases is closed, click the handle next to the folder to open it. If the databases are still not visible, it may be necessary to refresh the Databases pane. Select Databases, then click Refresh List.
5. If the Pro column does not contain a check mark, then no user can open the hosted database with FileMaker Pro. You must close the file on the server and open it with FileMaker Pro and enable the fmapp extended privilege for the desired accounts.

To verify that a database is usable from a FileMaker Pro client machine:

1. Start FileMaker Pro or FileMaker Pro Advanced.
2. Choose File menu > Open Remote.
3. Select Local Hosts from the View menu, and choose your server from the list. The name of the database should appear in the column on the right.
   If the database is not listed, review the steps above and in Hosting databases.

Note  If you are a group administrator, your server administrator must configure your administrator group to allow you to verify databases in your group folder. For more information, contact your server administrator.
Hosting databases

Verifying databases are available to FileMaker Pro clients

Related topics

Editing accounts and privilege sets
Uploading database files
Sharing FileMaker databases via ODBC and JDBC
Hosting XSLT websites
Hosting PHP websites
Closing hosted files
Hosting websites

Note: The following information is for server administrators.

With FileMaker Server you can publish your FileMaker databases on the web in these ways:

<table>
<thead>
<tr>
<th>To</th>
<th>Use</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access FileMaker data using the FileMaker API for PHP in PHP web applications</td>
<td>Custom Web Publishing with PHP</td>
<td>Hosting PHP websites</td>
</tr>
<tr>
<td>Transform, filter, or format XML data in a FileMaker database using XSLT stylesheets for use in a web browser or in other applications</td>
<td>Custom Web Publishing with XSLT</td>
<td>Hosting XSLT websites</td>
</tr>
<tr>
<td>Send HTTP requests along with XML query commands and parameters and retrieve FileMaker data as an XML document</td>
<td>Custom Web Publishing with XML</td>
<td>Hosting databases for XML queries</td>
</tr>
<tr>
<td>Quickly and easily publish FileMaker databases on the web that look and work much like they do in FileMaker Pro (requires a FileMaker Server Advanced license)</td>
<td>Instant Web Publishing</td>
<td>Using Instant Web Publishing</td>
</tr>
</tbody>
</table>

```
Hosting PHP websites

**Note** The following information is for server administrators.

Custom Web Publishing with PHP lets you use the PHP scripting language to integrate data from FileMaker databases with your customized webpage layouts. In your webpages, you call the FileMaker API for PHP, which is a PHP class created by FileMaker that accesses databases hosted by FileMaker Server. This PHP class connects to the Web Publishing Engine and makes data available to your web server’s PHP engine.

For more information on developing a PHP website and preparing a database, see FILEMAKER SERVER CUSTOM WEB PUBLISHING WITH PHP on the Start Page.

For information on starting the PHP Site Assistant, see Starting PHP Site Assistant from Admin Console.

To host a website that uses Custom Web Publishing with PHP:

1. In FileMaker Pro, open the database and edit the privilege set for the account that will access the database. Enable the extended privilege Access via PHP Web Publishing - FMS only.
   
   **Note** If your FileMaker database solution uses more than one FileMaker database file, all of the database files must use this privilege set with the extended privilege Access via PHP Web Publishing - FMS only enabled.

2. In FileMaker Server Admin Console, use the Deployment assistant to enable Custom Web Publishing with PHP and choose whether to install the FileMaker supported PHP engine, if you haven’t already.

   Click Edit Server Deployment on the FileMaker Server Overview pane. In the Deployment assistant, confirm your settings and click Next until you reach the Enable Web Publishing Technologies step. For more information, see Enabling technologies for web publishing.

   
   For more information on configuring Custom Web Publishing with PHP, see PHP web publishing settings.


5. **Upload** the database file to FileMaker Server with the Upload Database assistant. See Hosting databases.

   **Note** If your FileMaker database solution uses more than one FileMaker database file, all of the database files must be on the same computer.

6. Copy your PHP files to the root folder of the web server software on the machine in your FileMaker Server deployment that is running the web server:

   - For IIS (Windows): [drive]:\inetpub\wwwroot
   - For Apache (Mac OS): /Library/WebServer/Documents

   **Note** You can also place the PHP files in an optional folder or folder hierarchy in the web server root folder.

7. Copy or move any referenced container objects to the web server machine.

   If a database container field stores a file reference instead of an actual file, then the referenced container object will be stored in the FileMaker Pro Web folder when the record is created or edited. To host your site on FileMaker Server, you must then copy or move the referenced
Hosting websites Hosting PHP websites

containers to a folder with the same relative location in the root folder of the web server software.

**Note** If the database file is properly hosted and accessible on FileMaker Server, and the container fields store the actual files in the FileMaker database, then you need not relocate the container field contents.

8. To access your PHP website, use the following URL syntax:

<scheme>://<host>[:<port>]/<path>/<filename>

where:

- `<scheme>` is the HTTP or HTTPS protocol.
- `<host>` is the IP address or domain name of the host computer where the web server is installed.
- `<port>` is optional and specifies the port that the web server is listening on. If no port is specified, then the default port for the protocol is assumed (port 80 for HTTP, or port 443 for HTTPS).
- `<path>` is optional and specifies the folder inside the web server root folder where the PHP file is located.
- `<filename>` is the filename of a page in your website.

For example:


**Related topics**

- [PHP web publishing settings](#)
- [Hosting websites](#)
Starting PHP Site Assistant from Admin Console

Note The following information is for server administrators and group administrators.

PHP Site Assistant enables you to create a PHP-based website for accessing, modifying, and displaying data hosted on FileMaker Server. PHP Site Assistant makes it easy to design and configure your site and generate the necessary PHP code and HTML code.

To start PHP Site Assistant from Admin Console:

In Admin Console, click the Launch PHP Site Assistant icon on the toolbar:

For information on using PHP Site Assistant, see PHP Site Assistant Help.

Related topics
Hosting PHP websites
PHP web publishing settings
Hosting XSLT websites

Note The following information is for server administrators.

FileMaker Custom Web Publishing with XSLT provides the ability to transform, filter, or format XML data for use in a web browser or in other applications. You can use an XSLT stylesheet to transform the data between a FileMaker XML grammar and another XML grammar for use in another application or database.

For more information on developing an XSLT website and preparing a database, see FileMaker Server Custom Web Publishing with XML and XSLT on the Start Page.

To host a website that uses Custom Web Publishing with XSLT:

1. In FileMaker Pro, open the database and edit the privilege set for the account that will access the database. Enable the extended privilege Access via XSLT Web Publishing - FMS only.
   
   Note If your FileMaker database solution uses more than one FileMaker database file, all of the database files must use this privilege set with the extended privilege Access via XSLT Web Publishing - FMS only enabled.


4. Upload the database file to FileMaker Server with the Upload Database assistant. See Hosting databases.
   
   Note If your FileMaker database solution uses more than one FileMaker database file, all of the database files must be on the same computer.

5. Copy the XSLT stylesheets to the following directory on the machine that is running the Web Publishing Engine:
   
   • Windows (32-bit): [drive]\Program Files\FileMaker\FileMaker Server\Web Publishing\xslt-template-files
   
   • Windows (64-bit): [drive]\Program Files (x86)\FileMaker\FileMaker Server\Web Publishing\xslt-template-files
   
   • Mac OS: /Library/FileMaker Server/Web Publishing/xslt-template-files
   
   Note You can also place the stylesheets in an optional folder or folder hierarchy in the xslt-template-files folder.

6. Copy any referenced container objects to the web server machine.

   If a database container field stores a file reference instead of an actual file, then the referenced container object will be stored in the FileMaker Pro Web folder when the record is created or edited. To stage your site, you must copy or move the referenced containers to a folder with the same relative location in the root folder of the web server software.
   
   Note If the database file is properly hosted and accessible on FileMaker Server, and the container fields store the actual files in the FileMaker database, then you don’t need to relocate the container field contents.

7. Use the following URL syntax to request and process an XSLT stylesheet, and generate the resulting HTML:
   
   `<scheme>://<host>[:<port>]/fmi/xsl/<path>/<stylesheet>.xsl[?<query string>]`
where:

- `<scheme>` is the HTTP or HTTPS protocol.
- `<host>` is the IP address or domain name of the host computer where the web server is installed.
- `<port>` is optional and specifies the port that the web server is listening on. If no port is specified, then the default port for the protocol is assumed (port 80 for HTTP, or port 443 for HTTPS).
- `<path>` is optional and specifies the folder inside the xslt-template-files folder where the XSLT stylesheet is located.
- `<stylesheet>` is the name of the stylesheet with an .xsl extension.
- `<query string>` can be a combination of one query command and one or more query parameters for Custom Web Publishing with XSLT.

Related topics

XSLT web publishing settings
Hosting websites
Hosting databases for XML queries

Note The following information is for server administrators.

FileMaker Custom Web Publishing with XML enables you to send query requests to FileMaker Server, and display, modify, or manipulate the resulting data as needed. Using an HTTP request along with the appropriate query commands and parameters, you can retrieve FileMaker data as an XML document.

For more information on preparing a database and accessing XML data, see CUSTOM WEB PUBLISHING WITH XML AND XSLT on the Start Page.

To host a database that uses Custom Web Publishing with XML:

1. In FileMaker Pro, open the database and edit the privilege set for the account that will access the database. Enable the extended privilege Access via XML Web Publishing - FMS only.

   Note If your FileMaker database solution uses more than one FileMaker database file, all of the database files must use this privilege set with the extended privilege Access via XML Web Publishing - FMS only enabled.


3. Prepare databases for Custom Web Publishing. For more information, see FILEMAKER SERVER CUSTOM WEB PUBLISHING WITH XML AND XSLT.

4. Upload the database file to FileMaker Server with the Upload Database assistant. See Hosting databases.

   Note If your FileMaker database solution uses more than one FileMaker database file, all of the database files must be on the same computer.

5. Send an HTTP or HTTPS request in the form of a URL that specifies the FileMaker XML grammar, one query command, and one or more FileMaker query parameters to the Web Publishing Engine through an HTML form, an HREF link, or a script in your program or webpage. You can also type the URL in a web browser.

   For more information on specifying a URL for XML data, see FILEMAKER SERVER CUSTOM WEB PUBLISHING WITH XML AND XSLT.

Related topics
XML web publishing settings
Hosting websites
Using Instant Web Publishing

**Note** The following information is for **server administrators**.

You can use Instant Web Publishing to quickly and easily publish your database on the web. You don’t need to modify your database files or install additional software — anyone with compatible web browser software and access to the internet or an intranet can connect to your database to view, edit, sort, or search records, if you give them access privileges.

**Note** Instant Web Publishing is available only if you have a FileMaker Server Advanced license.

For more information on developing a FileMaker Pro database that works well with Instant Web Publishing, see [FILEMAKER INSTANT WEB PUBLISHING GUIDE](#) on the Start Page.

**To host a website using Instant Web Publishing:**

1. In FileMaker Pro, open the database and edit the privilege set for the account that will access the database. Enable the **extended privilege** Access via Instant Web Publishing.

   **Note** If your FileMaker database solution uses more than one FileMaker database file, all of the database files must use this privilege set with the extended privilege Access via Instant Web Publishing enabled.

2. **Upload** the database file to FileMaker Server with the Upload Database assistant. See [Hosting databases](#).  

   **Note** If your FileMaker database solution uses more than one FileMaker database file, all of the database files must be on the same computer.


4. *(Optional)* You can replace the default Database Homepage that web users see when they log out of a session or the session times out.

   Place your custom home page named iwp_home.html in the following location on the machine that is running the [Web Publishing Engine](#):
   - Windows (32-bit): `[drive]:\Program Files\FileMaker\FileMaker Server\Web Publishing\IWP`
   - Windows (64-bit): `[drive]\Program Files (x86)\FileMaker\FileMaker Server\Web Publishing\IWP`
   - Mac OS: `/Library/FileMaker Server/Web Publishing/IWP`

   **Note** *(Windows only)* If FileMaker Server is installed in a non-default location, the beginning portion of the default path shown above, \Program Files\FileMaker\FileMaker Server (Windows 32-bit) or \Program Files (x86)\FileMaker\FileMaker Server (Windows 64-bit), is replaced with the path that was specified during installation. For example: `\My_Path\Web Publishing\IWP`

5. If you’re using static HTML pages, images, or other externally referenced files with your FileMaker database, you need to move those files to the root folder of the [web server](#) software. Make sure the relative path is preserved.
   - For IIS (Windows), move the files to: `[drive]\inetpub\wwwroot`
   - For Apache (Mac OS), move the files to: `/Library/WebServer/Documents`

6. Test that your database is being published with Instant Web Publishing. Enter the following URL in a web browser:

   `http://<address>/fmi/iwp`

   where `<address>` is either the [IP address](#) or host name of the web server.
Related topics
- Instant Web Publishing settings
- Hosting websites
Starting and stopping FileMaker Server

Note  The following information is for server administrators.
Admin Console allows you to start and stop the Database Server and the Web Publishing Engine individually without restarting the machine.

To start or stop the Database Server:
In Admin Console, click one of the toolbar icons:

Start Database Server  Stop Database Server

To start or stop the Web Publishing Engine:
In Admin Console, click one of the toolbar icons:

Start Web Publishing Engine  Stop Web Publishing Engine

Notes
• If FileMaker Pro is already running while the Database Server is starting up on the same machine, the Database Server will start up but then abruptly stop. Stop FileMaker Pro, then start the Database Server. If this problem persists, restart your computer, then start the Database Server before starting FileMaker Pro.
• If you have large files or files with many connected clients, the process of stopping the Database Server may take several minutes. If you encounter problems, disconnect clients. For more information, see Disconnecting clients. Also try closing hosted files. For more information see Closing hosted files.
• When you stop the Database Server, Admin Console functionality is limited to FileMaker Server Overview. To use other functionality, you must start the Database Server again.
• When you stop the Web Publishing Engine, you must start it again before you can configure web publishing settings.
• If you need to start or stop the FileMaker Server service or background processes manually, see Starting or stopping the FileMaker Server service (Windows) or Starting or stopping FileMaker Server background processes (Mac OS).

Related topics
Auto Start settings
Configuring general settings

Note  The following information is for server administrators.

Choose General Settings and select one of the following tabs to specify FileMaker Server settings:

<table>
<thead>
<tr>
<th>Choose</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Information</td>
<td>Specify the FileMaker Server name and description, specify optional server and administrator contact information, and update the FileMaker Server license. See Server information settings.</td>
</tr>
<tr>
<td>Email Notifications</td>
<td>Specify the users that will receive emails whenever errors or warnings occur in FileMaker Server. Sending email notification requires the email server's SMTP information. See Email notification settings.</td>
</tr>
<tr>
<td>Admin Console</td>
<td>Restrict access to Admin Console, change the Admin Console user name and password, allow members of an external authentication group to log in to Admin Console, and enable checking for FileMaker Server updates. See Admin Console settings.</td>
</tr>
<tr>
<td>Auto Start</td>
<td>Start the Database Server or the Web Publishing Engine when the computer starts. See Auto Start settings.</td>
</tr>
</tbody>
</table>

After you change a setting in a tab, you can click Save to save your changes immediately. Or, if you want to make changes in other tabs in this pane, you can click another tab, make changes, then click Save. At any time, you can click Revert to undo all changes you've made in these tabs since the last save.

Related topics
Configuring Database Server settings
Configuring web publishing settings
Enabling sharing via ODBC and JDBC
Server information settings

Note The following information is for server administrators.

The General Settings > Server Information tab specifies the following configuration settings:

• Specify the host name that is displayed in the FileMaker Admin Console and FileMaker Pro, and the server description that is displayed on the Admin Console Start Page.

• Enter FileMaker Server contact information that is published in the directory service and the Start Page.

• View the current FileMaker Server license information and update the license.

To specify server information settings:
1. Choose General Settings > Server Information tab.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify the host name that is displayed in FileMaker Server Admin Console and FileMaker Pro</td>
<td>Enter the <strong>Server Name</strong>. Tip Use names consisting of standard ASCII characters without spaces. The server name appears in these locations: • on the Start Page • in FileMaker Pro, when users invoke the Open Remote File dialog box</td>
</tr>
<tr>
<td>Specify a server description</td>
<td>For <strong>Server Description</strong>, enter a description of the FileMaker Server computer. This description appears on the Start Page.</td>
</tr>
<tr>
<td>Specify the FileMaker Server owner, email address, location, and phone number</td>
<td>For <strong>Administrator Contact Information</strong>, enter the contact information for the person who administers this FileMaker Server deployment. This contact information appears in these locations: • on the Start Page • on a directory service For information on publishing the administrator contact information to a directory service, see FileMaker Pro client settings.</td>
</tr>
</tbody>
</table>
### Configuring general settings

#### Server information settings

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| View or update your FileMaker Server license information | For License Information, click Change License Key.  
   1. Enter the Name and Organization and your new License Key.  
   Your FileMaker Server license information is listed in the Change License Key dialog box. See About the license key.  
   2. Click Update, then click Close.  
You can also update the license key if you are using a trial version or you want to upgrade to FileMaker Server Advanced.  
Upgrading to FileMaker Server Advanced enables Instant Web Publishing and sharing data as an SQL data source via ODBC/JDBC. Because all the necessary files are already installed, no additional installation is necessary to upgrade. |

2. Click Save.

**Related topics**
- Uploading database files
- Database Server security settings
- Admin Console settings
- Configuring general settings
Email notification settings

Note The following information is for server administrators.

You can configure FileMaker Server to send an email notification when errors or warnings are detected or when a scheduled task is completed. You configure email notification by entering the SMTP server configuration settings and then sending a test message to test the connection. Then, enter the email addresses of the users who will receive notification of errors or warnings.

To specify email notification settings:
1. Choose General Settings > Email Notifications tab.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the SMTP configuration information for the email server</td>
<td>For SMTP Information:</td>
</tr>
<tr>
<td></td>
<td>• From Address: Enter the email address of the sender.</td>
</tr>
<tr>
<td></td>
<td>• Reply-to Address: Enter the email address that users can reply to after receiving an error or warning email from FileMaker Server. For example, the email address of the FileMaker Server administrator.</td>
</tr>
<tr>
<td></td>
<td>• SMTP Server Address: Enter an IP address (example: 127.1.1.1) or a host name (example: postoffice.emailserver.com).</td>
</tr>
<tr>
<td></td>
<td>• Port: The port number required to connect to the SMTP server. The default port number is 25.</td>
</tr>
<tr>
<td></td>
<td>• Select SMTP Authentication if required and choose the authentication type:</td>
</tr>
<tr>
<td></td>
<td>• Plain Text: Plain text authentication using LOGIN mechanism</td>
</tr>
<tr>
<td></td>
<td>• CRAM-MD5: Challenge-Response Authentication Mechanism-Message Digest 5 authentication to encrypt the password for the SMTP mail server</td>
</tr>
<tr>
<td></td>
<td>• If you selected SMTP Authentication, select Use Secure Sockets Layer (SSL) if you want to use SSL data encryption when FileMaker Server connects to the SMTP email server. If you select this option, the port number is automatically changed to 465. If the email server requires a STARTTLS command to support SSL connections, select Use Transport Layer Security (TLS).</td>
</tr>
<tr>
<td></td>
<td>Note Contact your email administrator to find out whether authentication is required and what type is used.</td>
</tr>
<tr>
<td></td>
<td>• User: Enter the user name required to log in to the SMTP server.</td>
</tr>
<tr>
<td></td>
<td>• Password: Enter the user’s password.</td>
</tr>
<tr>
<td>Test your SMTP settings</td>
<td>Click Test SMTP Settings. Enter an email address in the dialog box and click OK to send a test message.</td>
</tr>
<tr>
<td></td>
<td>If the test message fails, check your SMTP settings or the email address.</td>
</tr>
</tbody>
</table>
Configuring general settings

To | Do this
---|---
Enable email notifications | For **Notification Settings**:

  • Select **Enable email notifications**.

  **Send Email Notifications to**: Enter the email addresses for users who will be notified.

  Specify email addresses separated by commas.

  • **Severity Level**: Specify whether emails will be sent only when FileMaker Server detects errors or when FileMaker Server detects warnings or errors.

2. Click **Save**.

**Notes**

- Each schedule can be enabled to send email notification when the schedule completes. Each schedule can have its own set of email addresses, but all email notifications use the same SMTP settings. For more information about enabling email notifications in scheduled tasks, see [Enabling email notifications in schedules](#).

- The SMTP configuration settings you specify on the **General Settings > Email Notifications** tab do not affect the SMTP configuration settings you specify in FileMaker Pro for a Send Mail script step in [FileMaker scripts](#).

**Related topics**

- FileMaker Pro client settings
- Creating schedules
- Configuring general settings
Admin Console settings

**Note** The following information is for server administrators.

The **General Settings > Admin Console** tab specifies the following configuration settings:

- Restrict running Admin Console to a specific system or a range of systems identified by IP addresses.

Using FileMaker Server Admin Console, you can remotely control, or administer, FileMaker Server from a different computer than the one on which FileMaker Server is installed and hosting databases.

You can restrict access to Admin Console to the system currently running the console or to systems with specific IP addresses.

- Change the FileMaker Server administrator's user name or password, or allow members of an external authentication group to log in to Admin Console.

- Check for FileMaker Server updates.

**To specify Admin Console settings:**

1. Choose **General Settings > Admin Console** tab.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Restrict Admin Console to specific IP addresses | For **Restrict Access:**  
  - Select **Enable access restrictions**.  
  - Enter one or more IP addresses, separated by commas.  
  
  **Note** Any changes to this setting require restarting FileMaker Server on the **master** machine. See [Starting or stopping the FileMaker Server service (Windows)](https://help.filemaker.com/filemaker-server-linux) or [Starting or stopping FileMaker Server background processes (Mac OS)](https://help.filemaker.com/filemaker-server-mac).  
  
  **Important** You can run FileMaker Server Admin Console on the master machine even if you enable access restrictions. |
| Change the Admin Console account user name and password | For **Authentication:**  
  1. Click **Change User Name/Password** to open the dialog box.  
  2. Enter a **New User Name**.  
  3. Enter the **Current Password**.  
  4. Enter a **New Password**, then enter it again in **Confirm Password**.  
  5. Click **OK**.  
  This change is effective immediately. |
### Configuring general settings

#### Admin Console settings

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Allow members of an external authentication group to log in to Admin Console | Select **Use external group** and enter an optional domain or local machine name followed by the external authentication group name. For example: `groupname`, `domain\groupname`, or `groupname@localmachine`. The external authentication group can be the `fmsadmin` group or another external authentication group that is not associated with an administrator group. See [Adding administrator groups](#). You can limit the number of external authentication groups FileMaker Server Advanced searches when authenticating users by specifying the domain or local machine name in either of the following formats:  
  - `domain\group` or `localmachine\group`
  - `group@domain` or `group@localmachine`

  If you do not specify a domain or local machine name, here is how FileMaker Server Advanced searches for the external authentication group on these platforms:  
  - **Mac OS**: searches the local machine only  
  - **Windows**: searches the domain, if the computer is a member of a domain, then searches the local machine

  To test your external group setting, click **Test External Group**. If the test fails, verify the external group name information.

| Check for FileMaker Server updates | For **Check for Updates**, select **Enable FileMaker Server to check for updates**. You can check for updates by selecting **Help** menu > **Check for Update**. See [Checking for updates](#). |

2. Click **Save**.

---

**Important** To prevent unauthorized users from mistakenly logging in to Admin Console as the server administrator, make sure the Admin Console user name and password do not match any user name and password in any of the external authentication groups associated with Admin Console or any administrator group. Use a unique user name and a strong password that is at least 8 characters and a combination of letters and numbers. Note that the Admin Console user name and administrator group names are not case sensitive, but passwords are. For additional important guidelines for using external authentication groups, see [External authentication for Admin Console and administrator groups](#).

---

**Related topics**

- [Database Server security settings](#)
- [Configuring general settings](#)
Auto Start settings

Note The following information is for server administrators.

You can automatically start the Database Server when the system restarts. You can also automatically start the Web Publishing Engine when the system restarts.

To specify Auto Start settings:

1. Choose General Settings > Auto Start tab.
2. Choose the Auto Start options:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically start the Database Server component on the master</td>
<td>Select Automatically start Database Server.</td>
</tr>
<tr>
<td>machine when the computer restarts</td>
<td></td>
</tr>
<tr>
<td>Automatically start the Web Publishing Engine when the computer</td>
<td>Select Automatically start Web Publishing Engine.</td>
</tr>
<tr>
<td>restarts</td>
<td>Note This option is available only when Automatically start Database Server is selected.</td>
</tr>
</tbody>
</table>

3. Click Save.

Notes

- You can start or stop the Database Server or the Web Publishing Engine without restarting the machine. See Starting and stopping FileMaker Server.
- You can manually start the Database Server and Web Publishing Engine if you don't enable the Auto Start options. When the machine restarts, you can start Admin Console and start the Database Server, the Web Publishing Engine, or both.

Related topics

Uploading database files
Database Server security settings
General web publishing settings
Configuring general settings
Configuring administrator groups

Note  The following information is for server administrators.

As the server administrator, you are responsible for installing and configuring FileMaker Server as well as managing the FileMaker Pro databases hosted on FileMaker Server. If you work in an organization that has a large number of databases, it may take some time for you to respond to all of the user requests for changes to databases, schedules, or scripts. If you are using FileMaker Server Advanced, you can eliminate these delays and reduce your workload by delegating database administration tasks to other users.

For example, suppose your company has several departments such as Sales, Finance, and Marketing. Each department may have users who develop their own FileMaker Pro databases that are hosted on FileMaker Server. You can create an administrator group of the databases for each department and allow certain users called group administrators to manage their group's databases, schedules, and scripts.

Administrator groups enable you to retain exclusive and complete control of FileMaker Server. Group administrators are not allowed to configure FileMaker Server and they cannot view any of the Configuration panes in Admin Console. You specify which of the database administration tasks you want to allow group administrators to do by selecting Filemaker Server administrator group privileges. See FileMaker Server administrator group privileges.

FileMaker Server group administrators can manage the databases in their group folder only, as well as the schedules associated with the databases in their group folder. There can be only one group administrator account for each administrator group, but multiple users can log in to the same group administrator account at the same time with certain restrictions to avoid conflicts (see the following note regarding the restrictions).

You can also allow multiple users in the same external authentication group to log in to the same administrator group. External authentication also lets you take advantage of existing groups in a centrally-managed authentication server such as Open Directory or Active Directory. For example, suppose you specify an external Open Directory authentication group called fmsSales for an administrator group called Sales. If the users named Susan and Tom are members of the fmsSales Open Directory group, they can both use their Open Directory user name and password to log in to Admin Console and perform the tasks authorized in the Sales administration group.

To configure an administrator group, you associate a FileMaker Server group folder that contains the group's database files with the administrator group. The group folder can be associated with only one administrator group. For information about additional rules that apply to the group folder, see FileMaker Server group folders.

Notes

- Administrator groups are available only if you have a FileMaker Server Advanced license.
- Administrator groups are an optional feature.
- If multiple users log in to the same group administrator account at the same time, only one user can do the following tasks at a time:
  - Edit a particular schedule
  - Use the Upload Database assistant to upload a database
  - Whenever the server administrator adds, changes, renames, or removes an administrator group, an event is logged in the Event.log file. See Event log.

Related topics

Adding administrator groups
External authentication for Admin Console and administrator groups
Saving and loading schedules and groups
Adding administrator groups

**Note** The following information is for server administrators.

As the server administrator, you can use administrator groups to delegate database administration tasks to other users. You retain exclusive and complete control of FileMaker Server. Group administrators are not allowed to configure FileMaker Server, and you specify which database administration tasks you want to allow group administrators to do. For more information, see Configuring administrator groups.

**To add an administrator group:**

1. Choose Administrator Groups.
2. Click Add.
3. Enter the configuration information for the administrator group:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Enter the user name and password of the administrator group | For **Identity:**
| | • **Group Name:** Enter a name for the administrator group. The group administrator enters this name when logging in to Admin Console.
| | • **Group Password** and **Confirm Password:** Enter a password for the administrator group. |

**Use an optional external group for authentication**

Select **Use external group** and enter an optional domain or local machine name followed by the external authentication group name. For example: groupname, domain\groupname, or groupname@localmachine. The external group cannot be associated with the Admin Console account. See **Admin Console settings**.

You can limit the number of external groups FileMaker Server Advanced searches when authenticating users by specifying the domain or local machine name in either of the following formats:

- domain\group or localmachine\group
- group@domain or group@localmachine

If you do not specify a domain or local machine name, here is how FileMaker Server Advanced searches for the external group on these platforms:

- Mac OS: searches the local machine only
- Windows: searches the domain, if the computer is a member of a domain, then searches the local machine

To test your external group authentication setting, click **Test External Group**. If the test fails, verify the external group name information.
### To Configure Administrator Groups

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the FileMaker Server group folder</td>
<td>Click <strong>Select Folder</strong>, select the FileMaker Server group folder, then click <strong>OK</strong>. For information about the rules that affect group folders, see <a href="#">FileMaker Server group folders</a>.</td>
</tr>
<tr>
<td>• Folders that are not associated with an administrator group</td>
<td>and therefore available are indicated by the following folder icon in the Select Folder dialog box:</td>
</tr>
<tr>
<td>• Folders that are already associated with an administrator group</td>
<td>and therefore unavailable for other groups are indicated by the following group folder icon:</td>
</tr>
<tr>
<td>You can position your cursor over this group folder icon to display</td>
<td>the name of the administrator group that is already associated with the group folder.</td>
</tr>
<tr>
<td>This icon is also displayed for the parent folder of an existing group</td>
<td>folder to indicate the parent folder is also unavailable.</td>
</tr>
<tr>
<td>Select the FileMaker Server administrator group privileges</td>
<td>Click <strong>Edit Privileges</strong>, select the group privileges, then click <strong>OK</strong>. For more information, see <a href="#">FileMaker Server administrator group privileges</a>.</td>
</tr>
</tbody>
</table>

#### 4. **Click** **Save**.

**Important** To prevent users from mistakenly logging in to Admin Console or the wrong administrator group, make sure the group names and passwords defined in the **Manage Groups** tab do not match any user name and password in any of the external authentication groups associated with Admin Console or another administrator group. Use a unique group name and a strong password that is at least 8 characters and a combination of letters and numbers. Note that the Admin Console user name and administrator group names are not case sensitive, but passwords are. For additional important guidelines for using external authentication groups, see [External authentication for Admin Console and administrator groups](#).

**Notes**

- Make sure you click **Test External Group** to verify the external group name information is correct. Also make sure the group administrator’s account information exists in the external group. If the external group name is incorrect or the group administrator’s user name or password does not exist in the external group, FileMaker Server displays a message to group administrators when they log in stating that the user name and password are incorrect.

- If a group administrator is a member of multiple external groups each of which is associated with an administrator group, Admin Console displays the Select Administrator Group dialog box to allow the group administrator to select an administrator group when logging in. After logging in, the group administrator can switch groups by choosing **Server menu > Groups** and then the group name.
• Users in an associated external authentication group can log in using the group name and password in addition to their external user name and password. If you do not want to allow users to use the group name and password to log in, then do not distribute the group name and password to users.

• The administrator group privileges determine the level of access for group administrators that are members of external authentication groups.

• If you change the properties or privileges for an administrator group while a group administrator is logged in to that group, FileMaker Server displays a message to warn you the properties and privileges will change immediately. The change can possibly confuse the group administrator. For example, if you disable the privilege that allows the group administrator to create schedules, the change takes effect immediately. To avoid confusion, you may want to ask the group administrator to log out of Admin Console before you save any changes to the group properties or privileges.

• Schedules are associated with databases, not with administrator groups. If you change the group folder for an administrator group, the schedules displayed in the Schedules pane will change to the schedules that are associated with the databases in the new group folder. To avoid confusion, you may want to inform the group administrator before you change the group folder or group name.

• If a schedule performs a task on a database that is in an administrator group, the group’s name is listed next to the schedule in the Schedules pane for server administrators only. If you change a group name, the new name appears in the Schedules pane next to any schedules associated with the databases in that group.

• To remove a saved administrator group, select the group name in the Manage Groups tab and then click Remove. The databases in the group folder and all associated schedules are not deleted when you remove a group.

• To change a group folder for a saved administrator group from a subfolder to the default or additional database folder, you must first remove the saved administrator group. Then you can create a new group and select the default or additional database folder in the Select Folder dialog box.

• If a group folder is deleted, renamed, or moved by using file system tools, a group administrator can log in to Admin Console. But the group administrator cannot perform any database administration tasks because the association with the original group folder name has become invalid and consequently there are no databases in the group. You must specify a new valid group folder for the group in the Manage Groups tab.

• The server administrator can create all types of schedules for a particular group except system-level script schedules. Group administrators must create their own system-level script schedules for their groups. After the groups’ system-level script schedules are created, the server administrator can perform all actions on them—including running, editing, and deleting them.
External authentication for Admin Console and administrator groups

Note The following information is for server administrators.

If you are using external groups for authentication of the Admin Console account or administrator groups, follow these important guidelines to prevent incorrect user authentication and conflicts between the Admin Console account and administrator groups:

- To prevent unauthorized users from mistakenly logging in to Admin Console as the server administrator, make sure the Admin Console user name and password do not match any user name and password in any of the external authentication groups associated with Admin Console or any administrator group. Use a unique user name and a strong password that is at least 8 characters and a combination of letters and numbers. Note that the Admin Console user name and administrator group names are not case sensitive, but passwords are. See Admin Console settings.

When a user logs in to Admin Console, FileMaker Server uses the following priority rules to determine the user’s role as either the FileMaker Server administrator or as a group administrator:

1. If the user logs in using a name and password that matches the user name and password defined in the General Settings > Admin Console tab, the user is logged in as the FileMaker Server administrator.

2. If the user logs in using a name and password that matches a user name and password in an external authentication group defined in the General Settings > Admin Console tab, the user is logged in as the FileMaker Server administrator.

3. If the user logs in using a name and password that matches a group name and password defined in the Manage Groups tab, the user is logged in as that group’s administrator.

4. If the user logs in using a name and password that matches a group name and password in an external authentication group associated with an administrator group, the user is logged in as that group’s administrator.

For example, suppose you associate an external authentication group “fmsadmin” with Admin Console. Suppose also that you associate an external authentication group “fmsfinance” with the FileMaker Server administrator group “Finance”. Lastly, suppose a user named Joe is a member of both “fmsadmin” and “fmsfinance” external authentication groups, When Joe logs in to Admin Console, he is logged in as the FileMaker Server administrator according to priority rule 2. In other words, his membership in the external authentication group associated with Admin Console has priority over his membership in the external authentication group associated with an administrator group.

Tip Use the priority rules to troubleshoot incorrect configurations such as a group administrator who is mistakenly allowed to log in to Admin Console as the server administrator. To quickly prevent an unauthorized user from logging in to Admin Console, change the Admin Console user name and password to be unique. You can also change the association with the external group in the Admin Console account, or remove the user from the external group.

- To prevent users from mistakenly logging in to the wrong administrator group, make sure the group names and passwords defined in the Manage Groups tab do not match any user name and password in any of the external authentication groups associated with any other administrator group. Use a unique group name and a strong password.

- You cannot use the same external authentication group for the Admin Console account and an administrator group.

- For more information on setting up external authentication, go to www.filemaker.com/kb and search for articles containing the keywords external and authentication.
Related topics
Configuring administrator groups
Adding administrator groups
FileMaker Server group folders
FileMaker Server administrator group privileges
FileMaker Server group folders

Note The following information is for server administrators.

When configuring an administrator group in the Manage Groups tab, you associate a FileMaker Server group folder that contains the group’s database files with the administrator group.

The following rules apply to group folders:

• Each group folder can be associated with only one administrator group. Subfolders of a group folder are also associated with the same administrator group.

• All group folders must be in the default database folder or the additional database folder.

• You can select the default database folder or the additional database folder as the group folder if you want to allow the group administrator to manage all databases in all subfolders of those two folders. The group administrator will also be able to create subfolders of those two folders. If you do so, you cannot select a subfolder within the default or additional database folder to be a group folder for another administrator group.

• A group folder cannot be a parent of an existing group folder. That is, if you select a subfolder of the default database folder to be a group folder, you cannot select the default database folder to be a group folder for another administrator group.

Related topics
Configuring administrator groups
Adding administrator groups
External authentication for Admin Console and administrator groups
FileMaker Server administrator group privileges
FileMaker Server administrator group privileges

Note The following information is for server administrators.

Whenever you add a group in the Manage Groups tab of Admin Console, the View Databases, Send Messages, and Disconnect Clients group privileges are enabled by default. These minimum group privileges allow all group administrators to do the following tasks for their administrator group:

- View the group’s clients, databases, and schedules in the Clients, Databases, and Schedules panes
- Send text messages to the connected FileMaker Pro clients listed in the Clients pane
- Disconnect the FileMaker Pro clients listed in the Clients pane
- Open the Admin Console Start page and the Technology Tests page
- Launch the PHP Site Assistant
- Open Filemaker Server Help
- Check for Filemaker Server updates

When configuring an administrator group, you can also select any of the following group privileges in the Edit Privileges dialog box to specify the tasks you want to allow the group administrator to do for their administrator group:

<table>
<thead>
<tr>
<th>To allow group administrators to</th>
<th>Select this privilege</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open, close, verify, pause, resume, remove, or upload databases in the</td>
<td>Perform actions on databases</td>
</tr>
<tr>
<td>group folder and send messages in the Databases pane</td>
<td></td>
</tr>
<tr>
<td>View Filemaker Server statistics and logs</td>
<td>View Statistics and Logs</td>
</tr>
<tr>
<td>Perform all actions on the Actions menu in the Schedules pane</td>
<td>Perform actions on schedules</td>
</tr>
<tr>
<td>Perform all actions on Back Up Database schedules</td>
<td>Perform actions on schedules and Back Up Databases</td>
</tr>
<tr>
<td>Perform all actions on Verify Database schedules</td>
<td>Perform actions on schedules and Verify Databases</td>
</tr>
<tr>
<td>Perform all actions on Run Script schedules</td>
<td>Perform actions on schedules and Run Script</td>
</tr>
</tbody>
</table>

Group administrators are not allowed to do any of the following tasks:

- Start or stop the Database Server or the Web Publishing Engine
- View or change the settings in any of the Configuration panes in Admin Console
- Save or load schedules and groups
- Change the number or role of the machines in your Filemaker Server deployment
- Update the Filemaker Server license key
- Register Filemaker Server

Related topics
Configuring administrator groups
Adding administrator groups
External authentication for Admin Console and administrator groups
Configuring administrator groups

Adding administrator groups

FileMaker Server group folders
# Configuring Database Server settings

**Note**  The following information is for server administrators.

Choose **Database Server** and select one of the following tabs to specify FileMaker Server settings:

<table>
<thead>
<tr>
<th>Choose</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FileMaker Pro Clients</strong></td>
<td>Specify the maximum number of simultaneous FileMaker Pro client connections and the maximum idle time before disconnecting clients. You can also configure the FileMaker Server to work with a directory service. See <a href="#">FileMaker Pro client settings</a>.</td>
</tr>
<tr>
<td><strong>Databases</strong></td>
<td>Specify the maximum number of database files that FileMaker Server can host, specify database cache values, and allow FileMaker Server to automatically host runtime solutions. See <a href="#">Database settings</a>.</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td>Select how FileMaker Pro clients are authenticated when connecting to the FileMaker Server and whether to display only databases that each user is allowed to access. You can also choose to encrypt client connections using Secure Sockets Layer (SSL). See <a href="#">Database Server security settings</a>.</td>
</tr>
<tr>
<td><strong>Default Folders</strong></td>
<td>Specify an additional database folder to host database files and a backup folder. See <a href="#">Default folder settings</a>.</td>
</tr>
<tr>
<td><strong>Logging</strong></td>
<td>Select whether to log client access in the Access.log or server usage statistics in the Stats.log. You can also specify the log size and collection interval. See <a href="#">Logging and statistics settings</a>.</td>
</tr>
<tr>
<td><strong>Server Plug-Ins</strong></td>
<td>Select whether to use plug-ins with hosted databases and choose which plug-ins to use. See <a href="#">Server plug-in settings</a>.</td>
</tr>
</tbody>
</table>

After you change a setting in a tab, you can click **Save** to save your changes immediately. Or, if you want to make changes in other tabs in this pane, you can click another tab, make changes, then click **Save** when you are done. At any time, you can click **Revert** to undo all changes you’ve made in these tabs since the last save.

**Related topics**
- Configuring general settings
- Configuring web publishing settings
- Enabling sharing via ODBC and JDBC
FileMaker Pro client settings

**Note** The following information is for server administrators.

The **Database Server > FileMaker Pro Clients** tab specifies the following configuration settings:

- Specify the maximum number of simultaneous FileMaker Pro client connections to FileMaker Server.
- Allow FileMaker Pro users to download updated plug-ins used by hosted databases.
- Specify the maximum idle time before disconnecting FileMaker Pro clients.
- Configure FileMaker Server to work with a directory service.

**To specify FileMaker Pro client settings:**

1. Choose **Database Server > FileMaker Pro Clients** tab.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set the maximum number of simultaneous FileMaker Pro clients that can access databases hosted by FileMaker Server</td>
<td>Select <strong>Limit number of FileMaker Pro connections</strong> and enter a number. If you don’t select <strong>Limit number of FileMaker Pro connections</strong>, the maximum number of client connections is determined by your FileMaker Server license. FileMaker Server allows up to 250 simultaneous client connections. FileMaker Server Advanced allows an unrestricted number of simultaneous client connections. <strong>Note</strong> Although FileMaker Server Advanced allows an unrestricted number of simultaneous client connections, most operating systems impose their own limits on the number of network connections and open files that a process may use. This operating system limit sets the effective limit on the number of simultaneous client connections. <strong>Tip</strong> The memory requirements of FileMaker Server are directly related to the number of connected clients, open files, and the size of database cache. If your server has large numbers of clients or files, you can increase the amount of RAM reserved for the database cache to improve performance. For more information, see Database settings.</td>
</tr>
<tr>
<td>Allow FileMaker Pro clients to download updated plug-ins used by databases hosted by FileMaker Server</td>
<td>Select <strong>Allow FileMaker Pro clients to download updates automatically</strong>.</td>
</tr>
</tbody>
</table>
To | Do this
---|---
Set the maximum idle time for FileMaker clients | Select **Set maximum idle time allowed for FileMaker clients** and enter the time.

You can set the maximum time a FileMaker Pro client can be idle when connected to a database hosted by FileMaker Server. FileMaker Server only notifies FileMaker Pro of this setting. In FileMaker Pro, you should edit privilege sets to enable the option **Disconnect user from FileMaker Server when idle**. Because you can set this option on a privilege set basis, certain users will be disconnected while other users always maintain their connections.

**Note** Because clients who are disconnected have to reopen the files, make sure the idle time is long enough to avoid frequent disconnections.

Configure FileMaker Server to work with a directory service | Use the Directory Service assistant:

1. Click **Configure Directory Service** to open the Directory Service assistant.

2. Enter the directory service settings. See **Specifying directory service settings**. Click **Next**.

3. Select the information you want to publish. See **Publishing directory server settings**.

4. Click **Finish** to update the directory service information in this tab. (Clicking **Save** in this tab is not required.)

If your organization uses a Lightweight Directory Access Protocol (LDAP) compliant directory service, such as Windows **Active Directory**, Netscape Directory, OpenLDAP, or **Open Directory** (Mac OS), you can centrally manage your hosted databases by registering FileMaker Server with your directory service.

When FileMaker Server is registered with a directory service, host names and IP addresses are published to the directory service so that FileMaker Pro clients can use the directory service to find the server in a network. The FileMaker Server administrator's contact information can also be published (see **Server information settings**). This is useful if the directory service administrator needs to contact you (for example, if hosted databases are unavailable for client access).

**Note** If you do not know what your directory service settings are, contact your network administrator.

2. Click **Save**.

**Related topics**
- Using SSL with an LDAP directory service
- Administering clients
- Database Server security settings
Configuring Database Server settings
Using SSL with an LDAP directory service

**Note** The following information is for server administrators.

If your organization uses an LDAP directory service, you can enable **Use Secure Sockets Layer (SSL)** in the Directory Service assistant to encrypt the user names and passwords that FileMaker Server and FileMaker Pro clients use to log in to the LDAP server. See FileMaker Pro client settings.

To use SSL with an LDAP service with FileMaker Server and FileMaker Pro clients, there are several requirements:

- In each FileMaker Pro client, **Use Secure Sockets Layer (SSL)** in the Specify LDAP Directory Service dialog box must be enabled. For more information, see FileMaker Pro Help.
- On Windows, the LDAP server must have Active Directory certificate services (AD CS) installed if using the LDAP server as the (CA). For more information, see the documentation on Active Directory.
- On Mac OS, SSL must be enabled in Open Directory. For more information, see the documentation for Open Directory.
- You cannot use self-signed certificates for a secure SSL connection to an LDAP server. Signed server client certificates issued by a trusted certificate authority (CA) are required. The server certificate must be installed on the machine where the LDAP server is running. The client certificate must be installed on the FileMaker Server master machine and on FileMaker Pro computers that are using SSL to connect to an LDAP service.

To install the client root CA certificate:

- On Windows, you can set a policy on the Domain Controller to automatically install the client certificates on the client computers.
- On each Mac OS computer, perform the steps in the following section to install the client certificate.

**To install the client certificate on a Mac OS computer:**

1. Save the client certificate on the desktop. For example, save the certificate as “name1.name2.local”.
2. Open the Terminal application and type the following command; substitute the filename of your certificate for “name1.name2.local” in the command:
   ```bash
   sudo cp ~/Desktop/name1.name2.local /etc/openldap/name1.name2.local
   ```
3. Open the ldap.conf file in an editor by typing the following command:
   ```bash
   sudo vi /etc/openldap/ldap.conf
   ```
4. Add the following entry to the ldap.conf file; substitute the filename of your certificate for “name1.name2.local” in the command:
   ```bash
   TLS_CACERT /etc/openldap/name1.name2.local
   ```
5. Save the ldap.conf file and then exit the editor.

**Notes**

- On Mac OS, the client certificate must be in Privacy Enhanced Mail (.PEM) format.
- If either FileMaker Server or FileMaker Pro fail to log in to the LDAP server securely using SSL, neither product will attempt to log in without using SSL.
• If FileMaker Server or FileMaker Pro is configured to log in to the LDAP server securely using SSL, only a secure SSL login will be attempted. If the log in fails, an insecure login will not be attempted.

• For information on enabling LDAP over SSL with a third-party external certification authority, see Microsoft’s information on Active Directory.

Related topics
Specifying directory service settings
Database settings

**Note** The following information is for server administrators.

The **Database Server > Databases** tab specifies the following configuration settings:

- Specify the maximum number of files that FileMaker Server can host.
- Select whether FileMaker Server automatically hosts registered runtime solutions.
- Specify the amount of database cache memory.
- Specify how often to flush the database cache.

To specify database settings:

1. Choose **Database Server > Databases** tab.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Specify the maximum number of database files FileMaker Server can open at one time | For **Maximum number of files to host**, enter a number.  
**Note** The memory requirements of FileMaker Server are directly related to the number of clients and open files. If you specify large values, you should also increase the amount of RAM reserved for the database cache. |
| Automatically host runtime solution files | In **Registered Runtime Solutions**, select **Allow FileMaker Server to automatically host registered runtime solutions**.  
- To register a file type for a runtime solution, click **Register** and type the filename extension. Click **OK**.  
- To remove a registered file type, select the file type in the **File Type** list and click **Remove**. Click **Yes** to confirm.  
If you host runtime database solutions created by **FileMaker Pro Advanced**, you can enable FileMaker Server to automatically open runtime solutions when FileMaker Server starts. Runtime solutions must be stored in one of the designated locations. See **Default folder settings**.  
If the runtime solutions do not have .fp7 filename extensions, you must register their filename extensions in FileMaker Server. |
| Specify the RAM reserved for database cache | For **RAM reserved for database cache**, select the amount of memory.  
The maximum setting is dynamically determined based on physical RAM. The maximum setting is (Physical RAM – 128 MB) / 4, with a fixed minimum of 64 MB and a fixed maximum of 800 MB, and Physical RAM is the amount of RAM available in the master machine of your FileMaker Server deployment.  
Increasing the RAM reserved for the database cache can speed up overall performance for a correctly designed database, especially if your server hosts large files or a large number of clients or files. |
2. Click **Save**.

**Important**  The **Database Server** creates temporary files in a temporary directory on the **master** machine to cache data for hosted files. The Database Server creates one temporary file for each open hosted file, and automatically closes and deletes the temporary file when the associated hosted file is closed. Make sure there is enough free disk space on the master machine to store the temporary files. In most cases, the size of the temporary file is 10-20% of the size of the associated hosted file, but the actual percentage depends on the number of clients and server-side scripts and their activity level. The Database Server periodically checks the temporary file size and will shrink a temporary file if it grows too large compared to the amount of free disk space.

**Related topics**
- Uploading database files
- Administering databases
- Configuring Database Server settings
Cache flushing operation

**Note** The following information is for server administrators.

In FileMaker Server, the cache is constantly being flushed. The cache flushing routine scans the cache, looking for pages that have changed. FileMaker Server inspects up to 1/60th of the cache and writes any changed pages it discovers to the disk. The process repeats continuously, writing 1/60 of the cache to disk every second, even during scheduled backups.

For example, in a 64 MB cache FileMaker Server will inspect up to 1/60th of the cache, or a little more than a megabyte, and flush all of the changed records it finds. It will then wait a second and begin again, inspecting up to 1/60th of the cache, looking for changed records. This method of flushing the cache distributes writing to the hard disk over the span of a minute.

By default, the cache flush mechanism will attempt to scan the entire cache in a minute. In most cases this means all cached changes on the server will be no more than one minute old, although database size and hard disk speed can affect these results.

To change this behavior and spread the cache flushing over a longer period of time, increase the value of the **Cache flush distribution interval** (hh:mm). Unsaved changes in FileMaker Server will be no older than the interval you specify. FileMaker Server reduces the amount of data it inspects every second, but never less than 128 KB per second.

Before increasing the cache flushing interval, the administrator should carefully consider the risk of data loss in the event of a computer failure. Locations that require maximum performance and are less concerned about the potential for lost data can use a longer cache flush distribution interval, while locations that want maximum data integrity should use a smaller cache flush distribution interval.

For example, if the value is set to 10 minutes with a 64 MB cache, the engine will inspect 1/600th of the cache each second, or about 110 KB of cache (less than the minimum, so the engine will actually inspect 128 KB of cache), and write only the changed data to disk. However, if this interval is set to 10 minutes with a 500 MB cache, it will only inspect 853 KB as opposed to the default value of 1/60th of the cache, or 8.5 MB. Used this way, the server can distribute its disk writing over time, and therefore allow the server CPU a higher priority to service client requests, as it will take much less time to inspect 853 KB compared to 8.5 MB.

**Related topics**

[Database settings](#)
## Database Server security settings

**Note**  The following information is for server administrators.

The **Database Server > Security** tab lets you configure the following security settings:

- Specify whether clients are authenticated using FileMaker accounts only or also using an external authentication server.
- Limit the list of hosted databases that clients can view.
- Encrypt data passed between the Database Server and clients.

### To specify Database Server security settings:


<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Specify whether to authenticate access to hosted databases using an external server | For **Client Authentication**, select one of the following:  
  - **FileMaker accounts only**: The user name and password are authenticated against the account name and password specified in the FileMaker Pro accounts of hosted databases.  
  - **FileMaker and external server accounts**: The user name and password are authenticated against the account name and password specified in FileMaker Pro accounts or against an external server. The external server returns local and domain group accounts that the user belongs to, which are then authenticated against the group accounts specified in FileMaker Pro External Server accounts.  
  For more information, see [External authentication for database access](./overview).  
  For more information on creating accounts that authenticate via an external server, see FileMaker Pro Help. |
| Specify whether to filter the list of databases in:  
  - Open Remote File dialog box in FileMaker Pro  
  - Instant Web Publishing home page  
  - Custom Web Publishing database list requests | For **File Display Filter**, select one of the following:  
  - **List all databases**: Display all hosted databases.  
  - **List only the databases each user is authorized to access**: Display only the databases for which the user has access privileges in each hosted database. |
2. Click **Save**.

**Related topics**

- Auto Start settings
- Admin Console settings
- Configuring Database Server settings

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encrypt data passed between the Database Server and clients</td>
<td>Select <strong>Secure connections to Database Server</strong>. All Database Server client connections use the Secure Sockets Layer (SSL), except ODBC and JDBC connections. For more information about data security, see <strong>Securing your data</strong>. Secure connections are slower because of data encryption. Data transfer rates are affected by the number of clients and the amount of data transferred. <strong>Note</strong> If you change this setting, you must stop and start the Database Server again for the change to take effect. See <strong>Starting and stopping FileMaker Server</strong>.</td>
</tr>
</tbody>
</table>
External authentication for database access

Note The following information is for server administrators.

FileMaker Server authenticates users with FileMaker accounts defined within a FileMaker Pro database. In addition, FileMaker Server supports authentication with the following externally defined accounts and groups:

- Windows or Mac OS accounts and groups locally defined on the master machine
- Apple Open Directory and Windows Active Directory accounts and groups, which can be on a centrally-managed authentication server

If you’re hosting FileMaker Pro database files with FileMaker Server, you can use your existing authentication server to control access to databases without having to manage an independent list of accounts in each FileMaker Pro database file.

If in the Database Server > Security tab you choose FileMaker and external server accounts, the clients’ access privileges are determined by the accounts defined in the hosted databases and by accounts that are defined on the master machine or on an authentication server. Using FileMaker Pro, you specify in a database whether an account is authenticated via FileMaker or an external authentication server. These are Active Directory accounts (Windows) or Open Directory accounts (Mac OS). Depending on the specific network configuration, an external authentication server on one platform can authenticate users on the other platform. In other words, a Mac OS user might be authenticated by Active Directory or a Windows user might be authenticated by Open Directory in Mac OS X Server.

If you choose FileMaker and external server accounts, records of all login attempts are logged in the Windows Security Log, if the master machine is a Windows machine. For more information about the Security Log, see your Windows documentation.

Important When a database file contains one or more External Server accounts, make sure you use operating system security settings to limit direct access to the file. Otherwise, it might be possible for an unauthorized user to move the file to another system that replicates your authentication server environment and gain access to the file. Group names for accounts authenticated with the external server feature are stored as text strings. If the group name is reproduced on another system, the copied file can be accessed with the privilege set assigned to the members of the group, which might expose data inappropriately.

Notes

- For more information on setting up accounts in FileMaker Pro, see “Creating accounts that authenticate via an external server” in FileMaker Pro Help.
- For more information on setting up external authentication, go to www.filemaker.com/kb and search for articles containing the keywords external and authentication (and optionally cross-platform).

Related topics
Database Server security settings
Securing your data
Default folder settings

**Note** The following information is for server administrators.

Choose the **Database Server > Default Folders** tab to specify the following configuration settings:

- Specify an additional database folder for database files.
- Specify a backup folder for database files.

### Setting up an additional database folder

At startup, FileMaker Server searches the default database folder (and in subfolders one level down) for databases to host. It also searches an optional additional database folder. The databases are backed up to the default backup folder.

The full path for the default database folder is:

- **Windows (32-bit):** `\[drive\]:\Program Files\FileMaker\FileMaker Server\Data\Databases\`
- **Windows (64-bit):** `\[drive\]:\Program Files (x86)\FileMaker\FileMaker Server\Data\Databases\`
- **Mac OS:** `/Library/FileMaker Server/Data/Databases/`

**Note** (Windows only) If FileMaker Server is installed in a non-default location, the beginning portion of the default path shown above, `\Program Files\FileMaker\FileMaker Server (Windows 32-bit)` or `\Program Files (x86)\FileMaker\FileMaker Server (Windows 64-bit)`, is replaced with the path that was specified during installation. For example: `\My_Path\Data\Databases`

1. For **Database Folders**, select **Use additional database folder**.
2. Enter the full path to the location of the additional database folder. The maximum length of the path is 255 characters.
   - **Windows:** The path you enter must start with `filewin:/` and end with a slash (`/`).
     - For example, `filewin:/driveLetter:/folderName/`
   - **Mac OS:** The path you enter must start with `filemac:/` and end with a slash (`/`).
     - For example, `filemac:/volumeName/folderName/`

**Note** Click **Restore** to undo changes made to the path.

3. Click **Validate** to ensure that the path entered is correct.
   
   When the path is found to be valid, the label changes from **Not a valid path** to **Valid path**. If the path is not valid, see **Tips for valid folders**.

4. Click **Save**.

### Setting up a backup database folder

Specify the path to a folder used by FileMaker Server when a Back Up Database scheduled task runs.

**Important** Do not put the default backup folder in the same folder as the databases to be hosted, or in a subfolder within that folder. Any databases in that folder are automatically opened when FileMaker Server starts. The backup folder also cannot be a parent or a subfolder of the default database folder, the additional database folder, or the Scripts folder.

1. For **Backup Folder**, enter the full path to the location of the new default backup folder. The maximum length of the path is 255 characters.
   - **Windows:** The path you enter must start with `filewin:/` and end with a slash (`/`).
For example, filewin:/driveLetter:/folderName/

• Mac OS: The path you enter must start with filemac:/ and end with a slash (/).
  
  For example, filemac:/volumeName/folderName/

  **Note**  Click Restore to undo changes made to the path.

2. Click **Validate** to ensure that the path entered is correct.

   When the path is found to be valid, the label changes from **Not a valid path** to **Valid path**. If the path is not valid, see Tips for valid folders.

3. Click **Save**.

**Notes**

• The additional database folder cannot be a parent or a subfolder of the default database folder, the backup folder, or the Scripts folder.

• After you upload databases to the additional database folder, you cannot disable **Use additional database folder** or change the additional database folder path.

• If you enable **Use additional database folder** and select the additional database folder as the group folder for an administrator group, you cannot disable **Use additional database folder**. If you want to disable **Use additional database folder**, you must first deselect the additional database folder as the group folder for the administrator group. For more information, see Adding administrator groups.

**Related topics**

- Uploading database files
- Configuring Database Server settings
Logging and statistics settings

Note  The following information is for server administrators.

The Database Server > Logging tab lets you configure how the Database Server collects and logs events, client access, and statistical information while FileMaker Server is running. You can enable server usage statistics logging to collect performance information and write to your log at a specified interval.

In this tab you can configure the following settings:

- **Statistics.** Specify how often the Database Server collects statistical information for display and for optional logging.
- **Logging.** Specify whether optional client access is collected while FileMaker Server is running. You can enable server usage statistics logging to collect performance information and write to your log files at a specified interval.

When you enable usage statistics for FileMaker Server, a log file named Stats.log is created in the FileMaker Server/Logs/ folder. Stats.log is a tab-delimited text file. Real-time server statistics are displayed in the Statistics > Server tab. You can also view the Stats.log file in FileMaker Pro, a spreadsheet, or a text editor.

You can specify the maximum size for the Access.log, Event.log, Stats.log files, ClientStats.log, and a collection interval for Stats.log and ClientStats.log so that they don't get too large.

To specify event logging settings:

1. Choose Database Server > Logging tab.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Set the time between collecting statistics                        | For **Collection Interval**, enter the time in minutes and seconds.  
|                                                                   | The collection interval determines how frequently FileMaker Server collects the server statistical information that is displayed in the **Statistics > Server** tab and optionally logged in the Stats.log file.  
|                                                                   | The collection interval also determines how frequently FileMaker Server collects the client statistical information that is displayed in the **Statistics > Clients** tab and optionally logged in the ClientStats.log file. |
| Specify the log size                                              | For **Log Size**, specify the maximum size in MB for the Access.log, Event.log, Stats.log, and ClientStats.log files. |
To | Do this
---|---
Enable logging | Events are always logged in the Event.log file. Event logging cannot be disabled.

Select **Access** to log connections to FileMaker Server in the Access.log file.

Select **Usage statistics** to log server performance measurements displayed in the **Statistics > Server** tab in the Stats.log file.

**Note** Selecting **Usage statistics** does not log the client statistics displayed in the **Statistics > Clients** tab in the ClientStats.log file. For more information, see Viewing client statistics.

2. Click **Save**.

**Related topics**
- General web publishing settings
- Viewing server statistics
- Viewing log file entries
- Configuring Database Server settings
Server plug-in settings

Note The following information is for server administrators.

The Database Server > Server Plug-Ins tab allows you to enable FileMaker Server to use external function plug-ins with hosted FileMaker Pro databases that are designed to use server-side plug-ins.

For more information on plug-ins, see Managing plug-ins.

To allow FileMaker Server to use plug-ins:
1. Select Enable FileMaker Server to use plug-ins.
   The list shows the plug-ins that are in the plug-in folder.
2. Select Enabled for each plug-in that you want to execute on FileMaker Server.
3. Click Save.

Related topics
Enabling server-side plug-ins
Uploading database files
Configuring Database Server settings
Configuring web publishing settings

**Note**  The following information is for server administrators.

Choose Web Publishing and select one of the following tabs to specify FileMaker Server settings:

<table>
<thead>
<tr>
<th>Choose</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Settings</td>
<td>Specify the web publishing error logging level and the maximum number of web publishing sessions. See General web publishing settings.</td>
</tr>
<tr>
<td>PHP</td>
<td>Enable and configure Custom Web Publishing with PHP. See PHP web publishing settings</td>
</tr>
<tr>
<td>XSLT</td>
<td>Enable and configure Custom Web Publishing with XSLT. See XSLT web publishing settings</td>
</tr>
<tr>
<td>XML</td>
<td>Enable and configure Custom Web Publishing with XML. See XML web publishing settings</td>
</tr>
</tbody>
</table>

After you change a setting in a tab, you can click Save to save your changes immediately. Or, if you want to make changes in other tabs in this pane, you can click another tab, make changes, then click Save. At any time, you can click Revert to undo all changes you’ve made in these tabs since the last save.

When you configure web publishing settings, Admin Console prompts you to restart the Web Publishing Engine after you save changes to settings. This makes all web published databases unavailable to web users while the Web Publishing Engine restarts.

**Important**  Change web publishing settings only when the Web Publishing Engine is not being used. Web publishing clients can lose unsaved work when the Web Publishing Engine restarts.

**Related topics**
- Configuring general settings
- Configuring Database Server settings
- Enabling sharing via ODBC and JDBC
General web publishing settings

Note The following information is for server administrators.

You can specify the following web publishing settings on the Web Publishing > General Settings tab:

- Select the logging level for web publishing.
- Set the maximum number of web publishing sessions.

To specify web publishing settings:


<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable access logging</td>
<td>Select Enable access logging, to generate the Web Publishing Core internal access logs. Access logging enables the Web Publishing Core internal access logs, which are called wpc_access_log.txt and pe_internal_access_log.txt.</td>
</tr>
<tr>
<td>Enable error logging</td>
<td>Select Enable error logging, to generate the Web Publishing Engine application log. Error logging enables the Web Publishing Engine application log, which is called pe_application_log.txt.</td>
</tr>
<tr>
<td>Log FileMaker script Errors</td>
<td>Select FileMaker Errors to log errors in the pe_application_log.txt file. Only errors from FileMaker scripts run by Web Publishing Engine requests are logged.</td>
</tr>
<tr>
<td>Log XSLT user errors</td>
<td>Select User (XSLT only) to log messages generated by the XSLT <a href="">xsl:message</a> element in XSLT stylesheets in the pe_application_log.txt file.</td>
</tr>
<tr>
<td>Set the maximum number of web publishing sessions</td>
<td>Specify the Maximum number of web publishing sessions. The number specified is the maximum number of simultaneous client sessions allowed for all web technologies enabled on FileMaker Server.</td>
</tr>
</tbody>
</table>

2. Click Save.

For more information on web publishing log files, see Web publishing logs.

Related topics
- Administering databases
- Administering clients
- Logging and statistics settings
- Configuring web publishing settings
PHP web publishing settings

**Note** The following information is for server administrators.

Custom Web Publishing with PHP enables PHP web applications to access data using the FileMaker API for PHP. You can configure how the Web Publishing Engine responds to the API.

You can specify the following PHP Publishing settings on the **Web Publishing > PHP** tab:

- Enable PHP publishing.
- Enable pre-validation of record data.
- Select the default character encoding.
- Select the language used with PHP publishing.

**Note** Changing any of these settings requires restarting the Web Publishing Engine.

For more information about hosting a PHP website, see Hosting PHP websites. For more information about creating a PHP website and using the FileMaker API for PHP, see FILEMAKER SERVER CUSTOM WEB PUBLISHING WITH PHP on the Start Page.

For information on starting the PHP Site Assistant, see Starting PHP Site Assistant from Admin Console.

**To specify PHP Publishing settings:**


<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Custom Web Publishing with PHP</td>
<td>Select <strong>Enable PHP publishing</strong>. This setting must be enabled to configure the other settings in this tab.</td>
</tr>
<tr>
<td>Enable pre-validation of record data on the web server</td>
<td>Select <strong>Enable record data pre-validation</strong>. Enables the FileMaker API for PHP to validate record data before committing a record to the Database Server. To use this feature, your PHP code must call the <code>validate()</code> method where necessary and respond to validation errors.</td>
</tr>
<tr>
<td>Select the default character encoding</td>
<td>For <strong>Default Character Encoding</strong>, choose an encoding. The encoding you choose should match the encoding you use in the <code>&lt;head&gt;</code> section of your PHP files. The PHP default language is Latin-1. The FileMaker Server default is Unicode. Use UTF-8 if your data contains non-Latin characters.</td>
</tr>
<tr>
<td>Select the PHP publishing error message language</td>
<td>For <strong>Language</strong>, choose a language for error messages returned by the FileMaker API for PHP.</td>
</tr>
</tbody>
</table>

2. Click **Save**.

**Note** The FileMaker API for PHP and a supported PHP engine must be installed on the web server for Custom Web Publishing with PHP to work. For more information, see Enabling technologies for web publishing.
Related topics
Administering databases
Administering clients
General web publishing settings
Configuring web publishing settings
XSLT web publishing settings

**Note** The following information is for server administrators.

You can specify the following XSLT Publishing settings on the Web Publishing > XSLT tab:

- Enable XSLT Publishing.
- Enable database sessions.
- Set the session timeout value.
- Configure SMTP information to send email messages in an XSLT stylesheet.
- Select the default character encoding.

**Note** Changing any of these settings requires restarting the Web Publishing Engine.

For more information about XSLT web publishing, see FileMaker Server Custom Web Publishing with XML and XSLT on the Start Page.

To enable XSLT Publishing:


<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable XSLT Publishing</td>
<td>Select Enable XSLT publishing. This setting must be enabled to configure the other settings in this tab.</td>
</tr>
<tr>
<td>Choose how errors are generated</td>
<td>Select one of these modes:</td>
</tr>
<tr>
<td></td>
<td>• Development mode: Generate a specific error page when an error occurs in the Web Publishing Engine. Use this mode when you are developing and testing XSLT stylesheets. You cannot enable server-side stylesheet caching in Development mode.</td>
</tr>
<tr>
<td></td>
<td>• Production mode: Generate a default general text message in the error page when an error occurs in the Web Publishing Engine. Use this mode to use the Web Publishing Engine to host XSLT stylesheets.</td>
</tr>
<tr>
<td>Enable server-side stylesheet caching</td>
<td>If Production mode is selected, select Enable stylesheet caching and choose a value for Cache Size. Server-side caching stores frequently-used XSLT stylesheets in memory, which increases Web Publishing Engine performance. The Web Publishing Engine uses caching only when it is in Production mode.</td>
</tr>
<tr>
<td>Enable XSLT database sessions</td>
<td>Select Enable database sessions. Sessions are optional in Custom Web Publishing with XSLT. For more information, see Configuring the interaction between web sessions and database sessions.</td>
</tr>
</tbody>
</table>
To set the default session timeout value, for **Session Timeout,** set the default session time-out for Custom Web Publishing with XSLT.

Sessions are optional in Custom Web Publishing with XSLT and you create them by using the `fmxslt:create_session()` extension function. You can override the default setting by using the `fmxslt:invalidate_session()` and `fmxslt:set_session_timeout()` extension functions. See [FILEMAKER SERVER CUSTOM WEB PUBLISHING WITH XML AND XSLT](#).

### Specify SMTP information for email messages sent in an XSLT stylesheet

Specify the following:

- **SMTP Server Address:** Enter an [IP address](#) (example: 127.1.1.1) or a host name (example: postoffice.emailserver.com).
- **Port:** The port number required to connect to the SMTP server. The default port number is 25.
- **SMTP Authentication:** If required and choose the authentication type:
  - **Plain Text:** Plain text authentication using LOGIN mechanism
  - **CRAM-MD5:** Challenge-Response Authentication Mechanism-Message Digest 5 authentication to encrypt the password for the SMTP mail server

**Note** Contact your email administrator to find out whether authentication is required and what type is used.

- **User:** Enter the user name required to log in to the SMTP server.
- **Password:** Enter the user’s password.

### Select the default character encoding

For **Default Character Encoding**, select the **Page Encoding** and the **Email Encoding**. See [Text encoding for XSLT requests](#).

- **Page Encoding:**
- **Email Encoding:**

2. Click **Save.**

**Related topics**
- [Administering databases](#)
- [Administering clients](#)
- [General web publishing settings](#)
- [Email notification settings](#)
- [Configuring web publishing settings](#)
Text encoding for XSLT requests

**Note** The following information is for server administrators.

When the Web Publishing Engine is installed, the initial default text encoding for XSLT requests is UTF-8. For email messages, the default is ISO-8859-1. You can change these default text encoding settings. For more information about overriding default settings for individual requests, see the FILEMAKER SERVER CUSTOM WEB PUBLISHING WITH XML AND XSLT on the Start Page.

<table>
<thead>
<tr>
<th>Encoding</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>US-ASCII</td>
<td>Basic ASCII character set typically used for plain text English email</td>
</tr>
<tr>
<td>ISO-8859-1</td>
<td>Latin-1 character set typically used for Roman character-based webpages and email messages</td>
</tr>
<tr>
<td>ISO-8859-15</td>
<td>Latin-9 character set, which is almost the same as the Latin-1 character set. Includes the Euro € symbol.</td>
</tr>
<tr>
<td>Shift_JIS</td>
<td>Japanese encoding typically used for Japanese web pages</td>
</tr>
<tr>
<td>UTF-8</td>
<td>Eight-bit encoding of Unicode. Because UTF-8 supports the full range of Unicode characters, it can handle pages for any language.</td>
</tr>
</tbody>
</table>

**Related topics**

[XSLT web publishing settings](#)
Configuring the interaction between web sessions and database sessions

**Note**  The following information is for server administrators.

Sessions allow you to store data or maintain states between requests. Custom Web Publishing with XSLT supports two types of sessions:

- **Database sessions**: FileMaker Server creates a database session whenever it retrieves data for a request. The maximum number of concurrent database sessions is determined by your FileMaker Server license.

- **Web sessions**: The [Web Publishing Engine](https://www.filemaker.com/products/server) creates a web session whenever you use the `fmxslt:create_session()` extension function in an XSLT stylesheet. For information on the `fmxslt:create_session()` extension function, see [FILEMAKER SERVER CUSTOM WEB PUBLISHING WITH XML AND XSLT](https://www.filemaker.com/products/server) on the Start Page. The maximum number of web sessions is limited only by the amount of memory on the Web Publishing Engine machine.

In Admin Console, you can use the **Enable database sessions** option to configure the interaction between these two types of sessions. If you enable this option, the Web Publishing Engine uses a database session for each web session. Otherwise, the Web Publishing Engine uses a database session for each request. This option is disabled by default.

If you enable the database sessions:

- Global values are stored between requests.
- If a [FileMaker script](https://www.filemaker.com/products/server) modifies a state, that state is maintained between requests. For example, privileges that are modified by the Re-Login script step to switch accounts persist between requests.
- The total number of web sessions is limited to the maximum number of concurrent web database sessions on FileMaker Server. This limit applies to [Instant Web Publishing](https://www.filemaker.com/products/server) sessions and XSLT sessions.

If you disable the database sessions:

- Global values are not stored between requests.
- If a script modifies a state, that state is not maintained between requests.
- The number of XSLT web sessions is not limited to the maximum number of web database sessions on FileMaker Server, which allows greater scalability to Custom Web Publishing. However, Instant Web Publishing sessions are still subject to the limit.

If your stylesheets do not use global values or scripts that require a state to be maintained between requests, you should disable database sessions. The setting for the **Enable database sessions** option applies to all stylesheets deployed on the Web Publishing Engine.

**Related topics**

[XSLT web publishing settings](https://www.filemaker.com/products/server)
XML web publishing settings

**Note** The following information is for server administrators.

On the **Web Publishing > XML** tab, you can enable or disable Custom Web Publishing with XML. Select **Enable XML publishing** to allow FileMaker Server to generate XML data from hosted databases based on query commands and parameters.

**Note** Disabling XML does not affect your ability to use XSLT or the FileMaker API for PHP, but could affect the connectivity of other third-party web technologies.

**Related topics**
- Administering databases
- Administering clients
- General web publishing settings
- Configuring web publishing settings
Instant Web Publishing settings

**Note**  The following information is for server administrators.

You can specify the following Instant Web Publishing settings on the Web Publishing > Instant Web Publishing tab:

- Enable Instant Web Publishing.
- Set the Instant Web Publishing session timeout value.
- Select the language for the Instant Web Publishing status area.

**Notes**

- Changing any of these settings requires restarting the Web Publishing Engine.
- Instant Web Publishing requires a FileMaker Server Advanced license.

**To specify Instant Web Publishing settings:**


<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Instant Web Publishing</td>
<td>Select Enable Instant Web Publishing.</td>
</tr>
<tr>
<td></td>
<td>This setting must be enabled to configure the other settings in this tab.</td>
</tr>
<tr>
<td>Set the database session timeout</td>
<td>Set a value for Session Timeout.</td>
</tr>
<tr>
<td>value</td>
<td>The Web Publishing Engine disconnects users who have been inactive for the specified timeout period.</td>
</tr>
<tr>
<td></td>
<td>Instant Web Publishing solutions automatically use database sessions and you cannot disable them.</td>
</tr>
<tr>
<td>Select the status area label</td>
<td>For Status Area Language, select the language for the labels displayed in the status area of the Instant Web Publishing page.</td>
</tr>
<tr>
<td>language</td>
<td>This setting changes the language for all text in the Instant Web Publishing user interface — for example, the status area, Instant Web Publishing homepage, forms-based authentication, dialog boxes, and error messages.</td>
</tr>
<tr>
<td></td>
<td>The status area language setting does not change the language of data stored in databases.</td>
</tr>
</tbody>
</table>

2. Click Save.

For more information, see FileMaker Instant Web Publishing Guide on the Start Page.

**Related topics**

Administering databases
Administering clients
General web publishing settings
Server information settings
Configuring web publishing settings
Administering clients

Note The following information is for server administrators and group administrators.

The Clients pane lists the users, including FileMaker Pro and Web Publishing clients, currently connected to databases hosted by FileMaker Server. You can view details about each user, send messages to users, and disconnect users.

If you are a server administrator, you can manage client connections for all hosted databases. If you are a group administrator, you can manage only the client connections associated with the hosted databases in your administrator group. The Clients pane lists the client connections you are allowed to manage.

Viewing client details

Select a User Name to view client details below the Connected Clients list. Click the Databases Open tab to view the list of databases that the user is currently using (see About databases open details). Or, choose the User Details tab to view details about the user’s system (see About user details).

Managing client connections

Select one or more clients, choose one of the following Actions, and then click Perform Action:

<table>
<thead>
<tr>
<th>For Actions, choose</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send Message</td>
<td>Send a text message to the FileMaker Pro clients selected in the Connected Clients list. See Sending messages to FileMaker Pro clients.</td>
</tr>
<tr>
<td>Send Message to All Clients</td>
<td>Send a text message to all FileMaker Pro clients in the Connected Clients list. See Sending messages to FileMaker Pro clients.</td>
</tr>
<tr>
<td>Disconnect</td>
<td>Disconnect clients selected in the Connected Clients list. See Disconnecting clients.</td>
</tr>
<tr>
<td>Disconnect All Clients</td>
<td>Disconnect all clients in the Connected Clients list. See Disconnecting clients.</td>
</tr>
</tbody>
</table>

Notes

- If you are a group administrator, your server administrator must create your administrator group to allow you to manage the client connections for the databases in your group folder. For more information, contact your server administrator.
- To sort clients in the list in ascending or descending order, click a column heading.
- To resize the width of a column, select the column heading border and drag it horizontally.
- To put the columns in a different order, click a column heading, drag it, and drop it at the desired location.

Related topics

FileMaker Pro client settings
General web publishing settings
Enabling sharing via ODBC and JDBC
Sending messages to FileMaker Pro clients

**Note** The following information is for server administrators and group administrators.

You can send a message to FileMaker Pro clients connected to databases hosted by FileMaker Server. You can send a message to selected or all FileMaker Pro clients in the **Connected Clients** list.

**To send a message to one or more clients:**

1. Choose **Clients**, then select a client in the **Connected Clients** list.
2. For **Actions**, select **Send Message** or **Send Message to All Clients**.
   - If you select **Send Message**, the message is sent to the clients selected in the **Connected Clients** list.
   - If you select **Send Message to All Clients**, the message is sent to all clients in the **Connected Clients** list.
3. Click **Perform Action** to open the Send Message dialog box.
4. Type a message, then click **Send Message**.
   - FileMaker Server sends the message to the selected clients.

**Notes**

- You cannot send messages to clients connected via Instant Web Publishing or Custom Web Publishing.
- You can also send a message to FileMaker Pro clients by scheduling a Send Message task.

**Related topics**

- Sending messages to FileMaker Pro clients of selected databases
- Disconnecting clients
- Sending scheduled messages to clients of hosted databases
- Administering clients
Disconnecting clients

Note The following information is for server administrators and group administrators.

To disconnect a selected client or all clients from FileMaker Server:

1. Choose Clients, then select a client in the Connected Clients list.
2. For Actions, select Disconnect or Disconnect All Clients.
3. Click Perform Action.
   The Disconnecting Clients dialog box opens.
4. For Message, type the message to send to clients before they are disconnected.
5. For Delay time, enter the number of minutes between when the notification is sent and when clients are disconnected.
6. Click Send Message.
   Clients see a notification dialog box with your message requesting they close their connection to a file.
   If the client hasn’t already disconnected, FileMaker Server disconnects the client when the delay time elapses.

Notes
• If you are a server administrator, you can disconnect all clients from FileMaker Server. If you are a group administrator, you can disconnect only clients who are currently connected to the databases in your administrator group.

Related topics
Sending messages to FileMaker Pro clients
Closing hosted files
Administering clients
Administering databases

Note  The following information is for server administrators and group administrators.

The Databases pane lists the databases hosted by FileMaker Server that you are allowed to manage. If you are a server administrator, the Databases pane lists all hosted databases. If you are a group administrator, the Databases pane lists the hosted databases in your administrator group folder.

The database files are grouped in the default Databases folder, the additional database folder, and any subfolders.

Folders that are not associated with an administrator group are indicated by the following folder icon in the Databases pane:

Folders that are associated with an administrator group or are parent folders of a group folder are indicated by the following group folder icon:

You can position your cursor over the group folder icon to display the name of the administrator group that is already associated with the group folder.

About hosted databases

When FileMaker Server starts, it automatically opens, or hosts, all files in the FileMaker Server Databases folder and the optional additional database folder as well as files in subfolders one level down. See Hosting databases.

Viewing database details

You can view the Status of each database, the extended privileges enabled by FileMaker Pro, and the Details for clients currently connected to the database.

Managing hosted databases

To manage hosted databases, select one or more databases, choose what you want to do from Actions, then click Perform Action:

<table>
<thead>
<tr>
<th>For Actions, choose</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send Message</td>
<td>Send a text message to all FileMaker Pro clients connected to the selected databases. See Sending messages to FileMaker Pro clients of selected databases.</td>
</tr>
<tr>
<td>Send Message to all</td>
<td>Send a text message to all FileMaker Pro clients connected to any database listed in the Databases pane. See Sending messages to FileMaker Pro clients of selected databases.</td>
</tr>
<tr>
<td>Open</td>
<td>Open selected databases with the Status: Closed or Checking. See Opening hosted files.</td>
</tr>
<tr>
<td>Open all</td>
<td>Open all databases listed in the Databases pane with the Status: Closed or Checking. See Opening hosted files.</td>
</tr>
<tr>
<td>Close</td>
<td>Close selected databases with the Status: Normal, Paused, Opening, or Checking. See Closing hosted files.</td>
</tr>
</tbody>
</table>
## Administering databases

### Notes

- If you are a group administrator, your server administrator must configure your administrator group to allow you to manage the databases in your group folder. For more information, contact your server administrator.

- You can use the shortcut menu in the Databases list to perform the commands listed in **Actions**. Right-click selected databases and choose an action.

- To resize the width of a column, select the column heading border and drag it horizontally.

- To put the columns in a different order, click a column heading, drag it, and drop it at the desired location.

### Related topics

- [Hosting databases](#)
- [Database Server security settings](#)
- [Scheduling database backups](#)
Sending messages to FileMaker Pro clients of selected databases

**Note** The following information is for server administrators and group administrators.

You can send a message to FileMaker Pro clients connected to selected or all hosted databases listed in the Databases pane.

**To send a message:**

1. Choose **Databases**.
2. Open the Databases folder, the additional database folder, or the FileMaker Server group folder, if required.
3. If you are sending a message to clients of selected databases, select one or more databases.
4. For **Actions**, select **Send Message** or **Send Message to all**.
   - If you select **Send Message**, the message is sent to all FileMaker Pro clients connected to the selected databases.
   - If you select **Send Message to all**, the message is sent to all FileMaker Pro clients connected to any hosted database listed in the Databases pane.
5. Click **Perform Action** to open the Send Message dialog box.
6. Type a message, then click **Send Message**.
   - FileMaker Server sends the message to clients connected to the selected databases.

**Notes**

- If you are a group administrator, your server administrator must configure your administrator group to allow you to send messages to clients connected to the hosted databases in your group folder. For more information, contact your server administrator.
- You cannot send messages to clients connected via Instant Web Publishing or Custom Web Publishing.

**Related topics**

- Sending messages to FileMaker Pro clients
- Sending scheduled messages to clients of hosted databases
- Administering databases
Opening hosted files

*Note* The following information is for server administrators and group administrators. Open one or more database files with a *Closed* status.

**To open hosted databases:**
1. Choose *Databases*.
2. Open the *Databases* folder, the additional database folder, or the group folder, if required.
3. If you are opening selected databases, select one or more *Closed* databases.
4. For *Actions*, select *Open* or *Open all*.
5. Click *Perform Action*.

**Notes**
- If you are a group administrator, your server administrator must configure your administrator group to allow you to open hosted databases in your group folder. For more information, contact your server administrator.
- If you select a folder in the Databases list, FileMaker Server opens all of the files in that folder.
- If the status changes to *Checking*, FileMaker Server is checking the file’s structure before opening it. Checking a large file may take several minutes.
- If the database does not open and you need to access data in the damaged file prior to restoring from a backup or recovering the database, you can open a database with the *Checking* status to skip the consistency check. You should do this only if the database does not open.

**Related topics**
- Closing hosted files
-Disconnecting clients
- Administering databases
Closing hosted files

Note The following information is for server administrators and group administrators.

Close one or more hosted databases with Normal or Paused status.

To close databases and disconnect clients:
1. Choose Databases.
2. Open the Databases folder, the additional database folder, or the group folder, if required.
3. If you are closing selected databases, select one or more Normal or Paused databases.
4. For Actions, select Close or Close all.
5. Click Perform Action.
6. If you see the Close Databases dialog box, do the following:
   • For Message, type the message to send to clients before they are disconnected.
   • For Delay time, enter the number of minutes between when the notification is sent and when clients are disconnected.
   • Click Send Message.

Clients see a notification dialog box with your message requesting they close their connection to a file.

When the delay time elapses, FileMaker Server disconnects any remaining clients and closes the file or files in the folder. The status of the affected files changes to Closed.

The Status of the files being closed changes to Closing to indicate that FileMaker Server has begun closing files.

Completing the process of closing many database files, a large database file, or a file with many connected clients may take several minutes.

Notes
• If you are a group administrator, your server administrator must configure your administrator group to allow you to close hosted databases in your group folder. For more information, contact your server administrator.
• Close can be performed on a database with the Opening or Checking status, canceling the consistency check performed when the file is opened.

Related topics
Disconnecting clients
Viewing server statistics
Sending messages to FileMaker Pro clients
Administrating databases
Verifying hosted files

**Note** The following information is for server administrators and group administrators.
Verify the integrity of one or more hosted databases with Normal status.

**To verify databases:**

1. Choose Databases.
2. Open the Databases folder, the additional database folder, or the group folder, if required.
3. If you are verifying selected databases, select one or more Normal databases.
4. For Actions, select Verify or Verify all.
5. Click Perform Action.
6. If a client is connected to one of the selected databases, do the following in the Verify Databases dialog box that appears:
   - For Delay time, enter the number of minutes between when the notification is sent and when clients are disconnected.
   - In the text box, type the message to send to clients before they are disconnected.
   - Click Send Message.

Clients see a notification dialog box with your message requesting they close their connection to a file.

When the delay time elapses, FileMaker Server disconnects any remaining clients, closes the selected databases, verifies them, and then reopens the databases that were successfully verified. If a database fails the consistency check, you must use FileMaker Pro to recover the file. For information on recovering damaged files, see FileMaker Pro Help.

FileMaker Server logs a message in Event.log indicating the success or failure of the consistency check.

**Notes**

- If you are a group administrator, your server administrator must configure your administrator group to allow you to verify hosted databases in your group folder. For more information, contact your server administrator.
- To indicate that FileMaker Server is performing the consistency check, the Status of the databases being verified changes from Normal to Closing, then to Closed, then to Opening, then to Checking and then to Normal (if the consistency check passes) or to Closed (if the consistency check fails). For a small database, some of the status messages may occur too quickly for you to see.
- It may take several minutes to verify many database files, a large database file, or a database with many connected clients.

**Related topics**

Sending messages to FileMaker Pro clients
Administering databases
Pausing hosted files

Note The following information is for server administrators and group administrators.
Temporarily stop access to one or more open databases with Normal status. Connected clients can read data from the database while it is paused, but cannot modify the database until the database is resumed. For example, you can pause a database and safely use the operating system to make a copy of the file.

To pause one or more hosted databases:
1. Choose Databases.
2. Open the Databases folder, the additional database folder, or the group folder, if required.
3. If you are pausing selected databases, select one or more Normal databases.
4. For Actions, select Pause or Pause all.
5. Click Perform Action.

Note If you are a group administrator, your server administrator must configure your administrator group to allow you to pause hosted databases in your group folder. For more information, contact your server administrator.

Related topics
Resuming hosted files
Opening hosted files
Closing hosted files
Administrating databases
Resuming hosted files

Note The following information is for server administrators and group administrators.
Make available one or more databases that have been paused.

To resume one or more hosted databases:
1. Choose Databases.
2. Open the Databases folder, the additional database folder, or the group folder, if required.
3. If you are resuming selected databases, select one or more Paused databases.
4. For Actions, select Resume or Resume all.
5. Click Perform Action.

Note If you are a group administrator, your server administrator must configure your administrator group to allow you to resume hosted databases in your group folder. For more information, contact your server administrator.

Related topics
Pausing hosted files
Opening hosted files
Closing hosted files
Administering databases
Removing hosted files

**Note** The following information is for *server administrators* and *group administrators*.

You can remove one or more selected databases with **Closed** status or delete empty subfolders. The selected databases are moved to the folder **Removed_by_FMS/Removed**. The **Removed_by_FMS/Removed** folder is created inside either the default **Databases folder** or the additional database folder depending on which folder the selected databases are in.

The following table shows examples of where hosted databases are moved to after they are removed:

<table>
<thead>
<tr>
<th>Location before remove</th>
<th>Location after remove</th>
</tr>
</thead>
<tbody>
<tr>
<td>Databases\ABC.fp7</td>
<td>Databases\Removed_By_FMS\Removed\ABC.fp7</td>
</tr>
<tr>
<td>Databases[Subfolder]\ABCsub.fp7</td>
<td>Databases\Removed_By_FMS\Removed[Subfolder]\ABCsub.fp7</td>
</tr>
<tr>
<td>[Additional]/ABCadd.fp7</td>
<td>[Additional]/Removed_By_FMS/Removed/ABCadd.fp7</td>
</tr>
<tr>
<td>[Additional]/[Subfolder]/ABCsub.fp7</td>
<td>[Additional]/Removed_By_FMS/Removed/[Subfolder]/ABCsub.fp7</td>
</tr>
</tbody>
</table>

**To remove one or more databases:**

1. Choose **Databases**.
2. Open the **Databases** folder, the additional database folder, or the group folder, if required.
3. Select one or more **Closed** databases.
4. For **Actions**, select **Remove**.
5. Click **Perform Action**.
6. Click **Yes** to remove the selected databases.

**To delete empty subfolders:**

1. Choose **Databases**.
2. Select one or more empty subfolders in the list.
   You must remove all files from a subfolder before you can delete it.
3. For **Actions**, select **Remove**.
4. Click **Perform Action**.
5. Click **Yes** to remove the empty folder.
   The selected empty folders are deleted, not moved as when a database is removed.

**Notes**

- If you are a group administrator, your server administrator must configure your administrator group to allow you to removed hosted databases from your group folder. For more information, contact your server administrator.
- If you remove a hosted file, upload a file with the same filename, and remove the second file, then FileMaker Server overwrites the first removed file with the second removed file.
Related topics
Closing hosted files
Hosting databases
Administering databases
Using ODBC and JDBC with FileMaker Server

Note: The following information is for server administrators.

You can use FileMaker Server as:

• a data source, if you have a FileMaker Server Advanced license. You can share hosted FileMaker Pro database files with other applications on the same computer or over a network using ODBC (Open Database Connectivity) and JDBC (Java Database Connectivity). For example, you can create charts, analyze numbers, and generate reports using FileMaker Pro data in other applications.

• an ODBC client application. Hosted FileMaker Pro databases can interact with data sources on the same computer or over a network. For example, hosted FileMaker Pro databases can work with an Oracle data source interactively as defined in the FileMaker Pro relationships graph and in layouts.

FileMaker Server Advanced as a data source

FileMaker Server Advanced includes the software you need to share databases as data sources via ODBC and JDBC, including the FileMaker client drivers you use to access your databases from other ODBC- or JDBC-compliant applications. See Sharing FileMaker databases via ODBC and JDBC for information about enabling a database file for sharing.

For details about supported SQL statements, expressions, Catalog functions, and client drivers, see the FILEMAKER ODBC AND JDBC GUIDE on the Start Page.

FileMaker Server as an ODBC client application

When you use FileMaker Server or FileMaker Server Advanced as a client application, you must install and configure drivers for the ODBC data sources to access and set up the data source names (DSNs) that hosted FileMaker Pro databases are designed to use. For example, to access data from an Oracle database using ODBC, you must install and configure an Oracle ODBC client driver and set up exactly the same DSNs that the FileMaker Pro database was designed to use. FileMaker Server supports several third-party drivers. For more information, see Accessing external ODBC data sources.

See FileMaker Pro Help for information about:

• working with ODBC data sources interactively, in real-time, in the relationships graph and in layouts.

• importing ODBC data in batch operations with SQL queries.

What you need to work with ODBC in FileMaker Server

<table>
<thead>
<tr>
<th>What do you want to do?</th>
<th>See</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host a FileMaker Pro database as a data source</td>
<td><a href="#">Sharing FileMaker databases via ODBC and JDBC</a></td>
<td>FileMaker Server Advanced license required</td>
</tr>
<tr>
<td></td>
<td><a href="#">FILEMAKER ODBC AND JDBC GUIDE on the Start Page</a></td>
<td></td>
</tr>
<tr>
<td>Host a FileMaker Pro database that accesses an external ODBC data source</td>
<td><a href="#">Accessing external ODBC data sources</a></td>
<td>FileMaker Server or FileMaker Server Advanced</td>
</tr>
</tbody>
</table>
Related topics

Server information settings
Sharing FileMaker databases via ODBC and JDBC

Note The following information is for server administrators.

You can use FileMaker Server Advanced to host a FileMaker database file as a data source, sharing your data with other applications using ODBC and JDBC. FileMaker Server allows up to 50 connections and supports local access (same computer) and remote access (both for middleware such as web servers, and for remote client access from desktop productivity applications).

To share a hosted FileMaker Pro database via ODBC and JDBC:

1. In FileMaker Pro, open the database and edit the privilege set for the accounts that will access the database. Enable the extended privilege Access via ODBC/JDBC. For more information, see FileMaker Pro Help.
   Note If your FileMaker database solution uses more than one FileMaker database file, all of the database files must use this privilege set with the extended privilege Access via ODBC/JDBC enabled.

2. In FileMaker Server Admin Console, click ODBC/JDBC and select Enable ODBC/JDBC.

   Note If your FileMaker database solution uses more than one FileMaker database file, all of the database files must be hosted on the same FileMaker Server deployment.

4. On each client computer that needs to access the hosted database, install and configure the FileMaker ODBC or JDBC client driver.
   For details on installing and configuring a client driver to access your FileMaker data source, see the FILEMAKER ODBC AND JDBC GUIDE on the Start Page.

Related topics
Using ODBC and JDBC with FileMaker Server
Enabling sharing via ODBC and JDBC

Note The following information is for server administrators.

FileMaker Server Advanced can host data via ODBC/JDBC for other applications (like spreadsheets, word processors, and reporting tools). Users can view, analyze, and modify data in hosted FileMaker databases. To host data, you must enable this feature in FileMaker Server Admin Console and use FileMaker Pro to enable sharing via ODBC/JDBC in each database that you want to share.

For more information, see Sharing FileMaker databases via ODBC and JDBC.

Note Sharing via ODBC/JDBC requires a FileMaker Server Advanced license.

To enable sharing via ODBC/JDBC:
1. Choose ODBC/JDBC.
2. Select Enable ODBC/JDBC.
3. Click Save.

Notes
• Enabling this feature allows clients to use FileMaker Server as a data source via ODBC and JDBC. You do not need to enable this OBDC/JDBC data source feature to host FileMaker Pro databases that access an external SQL data source via ODBC. See Accessing external ODBC data sources.
• For other applications to access FileMaker data hosted on FileMaker Server, ODBC and JDBC client drivers must be installed on the machines running the other applications. Installers for the client drivers are provided on the FileMaker Server CD or you can download them.
• You must use FileMaker Pro to enable ODBC/JDBC sharing in each database you want to share. For details about sharing via ODBC/JDBC, see FileMaker Pro Help.
• For more information on installing the client drivers and for details on the SQL statements supported by FileMaker Server Advanced, see the FILEMAKER ODBC AND JDBC GUIDE on the Start Page.

Related topics
Uploading database files
Email notification settings
Database Server security settings
Server information settings
Accessing external ODBC data sources

**Note** The following information is for server administrators.

If you want to host a FileMaker Pro database that works with data in an external ODBC data source, you must configure an ODBC client driver for the ODBC data source that the FileMaker Pro database accesses. For example, if the database accesses records from an Oracle database, you must configure an Oracle client driver.

**Note** The ODBC client driver must be installed and configured on the master machine in your FileMaker Server deployment.

When a FileMaker Pro or web publishing client connects to the hosted FileMaker Pro database, FileMaker Server accesses data in the external ODBC data source on behalf of the client. Therefore, the client connected to FileMaker Server does not directly interact with the external data source, and does not need to install and configure an ODBC client driver. Only the master machine in the FileMaker Server deployment requires the ODBC client driver.

For detailed information on designing a FileMaker Pro database that accesses external data sources, see FileMaker Pro Help.

**To configure an ODBC client driver and set up a DSN on FileMaker Server:**

The way you interact with the data source, provide a password, and perform and display query results varies with each application’s client driver. Additionally, data source configuration can vary from one ODBC client driver manufacturer to another.

For a list of supported data sources and ODBC client drivers, see FileMaker Pro Help.

Use the following procedure as a general guideline for configuring data sources (refer to the documentation that accompanies each data source application for details).

1. (Windows) In the Windows Control Panel, choose **Administrative Tools > Data Sources (ODBC)**. In Windows 7, **Administrative Tools** appear in the **System and Security** category.
   (Mac OS) Start the ODBC data source administrator. The ODBC Administrator utility is available with Mac OS X (in the Applications/Utilities folder).

2. Click the **System DSN** tab.
   If your data source appears in the list, the driver is already configured. You can skip the remaining steps and begin accessing ODBC data, or choose your data source and click **Configure** to modify how you’ll interact with the data source.

   A System DSN (Data Source Name) is available to all users who log in to your computer. A User DSN is available only when you log in.

   **Important** Only System DSNs are supported for FileMaker Pro databases that work with ODBC tables in the FileMaker Pro relationships graph.

3. Click **Add** to configure a driver for your data source.
   A list displays all ODBC client drivers installed on your computer.
   FileMaker Server supports several third-party drivers. For more information on supported drivers, see [www.filemaker.com/support/technologies](http://www.filemaker.com/support/technologies).
   To install a new driver, use the driver’s installation program.

4. Choose the driver for the data source that the hosted FileMaker Pro database is designed to access, then click **Finish**.
A setup dialog box appears.

5. In **Data Source Name**, enter the identical Data Source Name that the FileMaker Pro database is designed to connect to.

**Important** The Data Source Name you enter here must be exactly the same as the Data Source Name that the database was designed to use in FileMaker Pro. So for each Data Source Name used by each database you host, you must configure a matching Data Source Name on the FileMaker Server master machine.

Many drivers also offer options to customize how you access a data source, such as identifying a particular data source file.

6. Click **OK**.

**Related topics**

*Using ODBC and JDBC with FileMaker Server*
Monitoring FileMaker Server

**Note** The following information is for server administrators and group administrators.

You can view usage statistics and track the activity of FileMaker Server and individual clients. Admin Console displays usage statistics and detailed client statistics that let you monitor server performance and diagnose the causes of performance problems.

To help you monitor your FileMaker Server deployment and troubleshoot problems, FileMaker Server lets you perform the following tasks:

- View server statistics in the **Statistics > Server** tab. See [Viewing server statistics](#).
- View client statistics in the **Statistics > Client** tab. See [Viewing client statistics](#).
- View log file entries in the **Log Viewer** pane. See [Viewing log file entries](#).

The following table summarizes where you can find the information that FileMaker Server tracks for you.

<table>
<thead>
<tr>
<th>To monitor</th>
<th>See</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server statistics</td>
<td><strong>Statistics &gt; Server</strong> tab</td>
<td>FileMaker Server performance and number of clients logged in.</td>
</tr>
<tr>
<td></td>
<td>Stats.log (master machine)</td>
<td></td>
</tr>
<tr>
<td>Client statistics</td>
<td><strong>Statistics &gt; Client</strong> tab</td>
<td>Detailed client statistics.</td>
</tr>
<tr>
<td></td>
<td>ClientStats.log (master machine)</td>
<td></td>
</tr>
<tr>
<td>Events</td>
<td><strong>Log Viewer</strong> pane</td>
<td>Database Server start and stop events, consistency checks, error conditions in FileMaker Server configuration.</td>
</tr>
<tr>
<td></td>
<td>Event.log (master machine)</td>
<td>(See <a href="#">Viewing activities in the Event Viewer (Windows)</a> for instructions.)</td>
</tr>
<tr>
<td></td>
<td>Windows: Event Viewer (master machine)</td>
<td></td>
</tr>
<tr>
<td><strong>Client</strong> accesses to the Database Server</td>
<td><strong>Log Viewer</strong> pane</td>
<td>Client connect/disconnect and database open/close operations.</td>
</tr>
<tr>
<td></td>
<td>Access.log (master machine)</td>
<td></td>
</tr>
<tr>
<td>Web Publishing Core internal access</td>
<td><strong>Log Viewer</strong> pane</td>
<td>End-user requests to generate XML and to use FileMaker Server Instant Web Publishing including requests from the FileMaker API for PHP.</td>
</tr>
<tr>
<td></td>
<td>wpc_access_log.txt (Web Publishing Engine machine)</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Log Viewer</strong> pane</td>
<td>Internal XML requests that the XSLT-CWP software component of the Web Publishing Engine makes while processing XSLT requests.</td>
</tr>
<tr>
<td></td>
<td>pe_internal_access_log.txt (Web Publishing Engine machine)</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Log Viewer</strong> pane</td>
<td>Web Publishing Engine start and stop events, error, script, and user log information.</td>
</tr>
<tr>
<td></td>
<td>pe_application_log.txt (Web Publishing Engine machine)</td>
<td></td>
</tr>
<tr>
<td>Web Server Module</td>
<td><strong>Log Viewer</strong> pane</td>
<td>Communication errors between the web server and with Web Publishing Engine</td>
</tr>
<tr>
<td></td>
<td>web_server_module_log.txt (web server machine)</td>
<td></td>
</tr>
</tbody>
</table>
Monitoring FileMaker Server

Notes

• All log files are located in the Logs folder:
  • Windows (32-bit): [drive]:\Program Files\FileMaker\FileMaker Server\Logs
  • Windows (64-bit): [drive]:\Program Files (x86)\FileMaker\FileMaker Server\Logs
  • Mac OS: /Library/FileMaker Server/Logs

In a multiple machine deployment, the log files are on the machines indicated in the table above.

(Windows only) If FileMaker Server is installed in a non-default location, the beginning portion of the default path shown above, \Program Files\FileMaker\FileMaker Server (Windows 32-bit) or \Program Files (x86)\FileMaker\FileMaker Server (Windows 64-bit), is replaced with the path that was specified during installation. For example: \My_Path\Logs

• If you are a group administrator, your server administrator must configure your administrator group to allow you to view statistics and log file entries. For more information, contact your server administrator.
Viewing server statistics

Note  The following information is for server administrators and group administrators.

To view a summary of Connection Statistics and Database Statistics attributes for FileMaker Server, choose Statistics > Server if you are a server administrator. If you are a group administrator, choose Statistics.

Connection Statistics

The attributes collected for each statistic Type include the number of Current, Average, Low, and Peak client connections.

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Web Publishing (PHP, XML, XSLT)</td>
<td>Number of connected Custom Web Publishing clients. Use this information to configure the maximum number of Custom Web Publishing clients.</td>
</tr>
<tr>
<td>FileMaker Pro Clients</td>
<td>Number of connected FileMaker Pro clients. Use this information to configure the maximum number of FileMaker Pro clients.</td>
</tr>
<tr>
<td>Instant Web Publishing</td>
<td>Number of connected Instant Web Publishing clients.</td>
</tr>
<tr>
<td>ODBC/JDBC</td>
<td>Number of connected ODBC/JDBC clients.</td>
</tr>
</tbody>
</table>

Database Statistics

The attributes collected for each statistic Type include the Current, Average, Low, and Peak value.

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cache Hit %</td>
<td>Percentage of times FileMaker Server retrieved data from the cache (RAM) rather than the hard disk. Reading data from RAM is much more efficient than rereading it from the hard disk, so this value should be a high number, like 90 or 95. If it isn't, you can allocate more memory to FileMaker Server database cache.</td>
</tr>
<tr>
<td>Cache Unsaved %</td>
<td>Percentage of cache that is currently unsaved. This should be a low number, such as 0 or 5, so you won't lose data if you experience a system crash. If the number is consistently high, decrease the cache flush interval.</td>
</tr>
<tr>
<td>Disk KB/sec Read</td>
<td>Amount of data being read from disk. Data is measured in KB.</td>
</tr>
<tr>
<td>Disk KB/sec Written</td>
<td>Amount of data being written to disk. Data is measured in KB.</td>
</tr>
<tr>
<td>Elapsed Time/Call</td>
<td>Time (in microseconds) to process a remote call. For example, a value of 1 million means an average of 1 second per call. If the average Elapsed Time/Call is high, but the average Wait Time/Call is low, ask clients whether the operations they are performing on the Server have changed. Adding indexes for more fields or other solution changes may be required.</td>
</tr>
<tr>
<td>I/O Time/Call</td>
<td>Time (in microseconds) a remote call waits for disk reads or writes. For example, a value of 1 million means an average of 1 second per call. If the average I/O Time/Call is high and the average Cache Hit % is low, you can increase the Database Cache Size. If the average I/O Time/Call is high and the average Cache Hit % is high, you can use additional hard drives or a RAID system on your computer.</td>
</tr>
</tbody>
</table>
Notes

• If you are a group administrator, your server administrator must configure your administrator group to allow you to view server statistics. For more information, contact your server administrator.

• FileMaker Server updates the server statistics list at the time interval you specify. To reduce the overhead required to calculate statistics, you can increase the interval between each time FileMaker Server collects statistics. However, the server statistics then become approximations of how FileMaker Server is actually using system resources. For information on configuring the statistics collection interval, see Logging and statistics settings.

• FileMaker Server can also store server statistics in a log file. See Server statistics log.

• To sort items in the list in ascending or descending order, click a column heading.

• To resize the width of a column, select the column heading border and drag it horizontally.

• To put the columns in a different order, click a column heading, drag it, and drop it at the desired location.

Related topics

Administering clients
Administering databases
Logging and statistics settings
Monitoring FileMaker Server

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network KB/sec In</td>
<td>Amount of data being transferred across the network into FileMaker Server, measured in KB.</td>
</tr>
<tr>
<td>Network KB/sec Out</td>
<td>Amount of data being transferred across the network out of FileMaker Server, measured in KB.</td>
</tr>
<tr>
<td>Open Databases</td>
<td>Number of open databases. Use this information to configure the Maximum number of files to host option.</td>
</tr>
<tr>
<td>Remote Calls/sec</td>
<td>Number of separate remote calls received from all clients, divided by the statistics sampling interval. Note that there can be multiple remote calls to perform a single operation from the client's perspective.</td>
</tr>
<tr>
<td>Remote Calls In Progress</td>
<td>Number of separate remote calls received from all clients that were pending completion at the moment in time when statistics were last sampled.</td>
</tr>
<tr>
<td>Wait Time/Call</td>
<td>Time (in microseconds) a remote call waits for other processes. For example, a value of 1 million means an average of 1 second per call.</td>
</tr>
</tbody>
</table>
Viewing client statistics

**Note** The following information is for server administrators.

Use the Statistics > Clients tab to monitor server performance and diagnose the causes of FileMaker Server performance problems. Admin Console displays client statistics collected during remote calls made by each FileMaker Pro client, all Web Publishing Engine (WPC) clients, and all ODBC and JDBC clients to FileMaker Server.

The client statistics are collected and logged only while the Statistics > Clients tab is displayed. If you choose a different tab or pane or stop Admin Console, FileMaker Server automatically stops collecting and logging client statistics.

**Note** If you use the Statistics > Clients tab in larger deployments, FileMaker Server performance may be adversely affected. Use the Statistics > Clients tab only when needed to troubleshoot FileMaker Server performance problems.

**To view client statistics:**

3. To log the client statistics, select Log client statistics while the Clients tab is selected. See Logging client statistics.

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client</td>
<td>For a FileMaker Pro client, the user login name is displayed. For all Web Publishing clients, WPC is displayed. For all ODBC and JDBC clients, XDBC is displayed. Position your cursor over the name in the Client column to display the machine name and IP address of the client.</td>
</tr>
<tr>
<td>Remote Calls</td>
<td>Number of remote calls completed. Note that there can be multiple remote calls to perform a single operation from the client's perspective.</td>
</tr>
<tr>
<td>In Progress</td>
<td>Number of remote calls which are pending completion. The start of the remote call can be during the current collection interval or the previous interval.</td>
</tr>
<tr>
<td>Elapsed Time</td>
<td>Elapsed time (in microseconds) of a completed remote call or an in-progress remote call.</td>
</tr>
<tr>
<td>I/O Time</td>
<td>Time (in microseconds) spent by the client’s thread waiting for input and output to complete.</td>
</tr>
<tr>
<td>Wait Time</td>
<td>Time (in microseconds) spent by the client’s thread waiting for other threads or resources.</td>
</tr>
<tr>
<td>Net Bytes In</td>
<td>Number of bytes received from the client to FileMaker Server (data requests).</td>
</tr>
<tr>
<td>Net Bytes Out</td>
<td>Number of bytes sent to the client from FileMaker Server (notifications).</td>
</tr>
</tbody>
</table>
Pausing and resuming update of client statistics

FileMaker Server continuously updates the client statistics in the Statistics > Clients tab at the time interval specified for the statistics collection interval. The default setting is 15 seconds. You can click Pause to pause the update of the statistics in the Statistics > Clients tab so that you can inspect the data. Click Resume to display the latest client statistics and continue updating.

To reduce the overhead required to calculate statistics, you can increase the interval between each time FileMaker Server collects statistics. However, the client statistics then become approximations of how FileMaker Server is actually using system resources. For information on configuring the statistics collection interval, see Logging and statistics settings.

Logging client statistics

If you select Log client statistics while the Clients tab is selected, a log file named ClientStats.log is created in the FileMaker Server/Logs/ folder for as long as the Statistics > Clients tab is displayed. If you choose a different tab or pane or stop Admin Console, FileMaker Server automatically deselects Log client statistics while the Clients tab is selected.

ClientStats.log is a tab-delimited text file. You can view the ClientStats.log file in FileMaker Pro, a spreadsheet, or a text editor. See Client statistics log.

Notes

- Each row of the Statistics > Clients tab displays the statistics for an individual FileMaker Pro client or the total statistics for all Web Publishing clients and all ODBC and JDBC clients. Web Publishing clients includes Instant Web Publishing sessions and Custom Web Publishing (PHP, XML, XSLT) sessions.
- If a client is disconnected anytime during the statistics collection interval, the statistics for that client are not displayed in the Statistics > Clients tab.
- The following types of information are not included in the Statistics > Clients tab:
  - Operations that occur only on the client, such as sorting data that has already been downloaded to the client.
  - Local operations that occur on the machine hosting FileMaker Server, such as backups, server-side scripting, or schedules.
- To sort items in the Clients tab in ascending or descending order, click a column heading.
- To resize the width of a column, select the column heading border and drag it horizontally.
- To put the columns in a different order, click a column heading, drag it, and drop it at the desired location.
Viewing log file entries

**Note** The following information is for server administrators and group administrators.

FileMaker Server tracks activity, client access, and other information as it operates and stores this information in log files. Use the Log Viewer pane in Admin Console to view, sort, filter, and export a snapshot of the log file entries.

**To view log file entries in the log viewer:**

1. Choose Log Viewer.
2. Select a date range on the calendars next to **Start** and **End**. See Selecting a date range.
3. Select one or more log file modules for **Modules**. See Selecting the log file modules.
4. To filter the log file entries displayed in the Log Viewer pane, select a level of message (All, Error, Warning, or Information) for **Type**. See Filtering and sorting the log file entries.
5. To view the most recently logged events, click **Refresh**. See Refreshing the log viewer.

**Selecting a date range**

To display events logged during a specific time period, click the calendars next to **Start** and **End** and select the start and end dates of the date range. All dates begin at 12:00 AM and end at 11:59 PM. If you select a start date and end date that are the same day, the date range is for a single 24 hour period. You can view log file events in the Log Viewer pane that were logged anytime in the past 90 days. After you select a log file module, Admin Console displays a new snapshot of the log files whenever you change the date range.

**Selecting the log file modules**

To display entries from one or more specific log files, click **Modules**, select one or more of the following log file modules, and then click **OK**:

<table>
<thead>
<tr>
<th>For Modules, select</th>
<th>To display entries from these log files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Events</td>
<td>Event.log and Event-old.log. See Event log.</td>
</tr>
<tr>
<td>Publishing Engine</td>
<td>pe_application_log.txt. See Web publishing logs.</td>
</tr>
<tr>
<td>Publishing Engine Access</td>
<td>pe_internal_access_log.txt. See Web publishing logs.</td>
</tr>
<tr>
<td>Web Server</td>
<td>web_server_module_log.txt. See Web Server Module log.</td>
</tr>
<tr>
<td>Web Publishing Core</td>
<td>wpc_access_log.txt. See Web publishing logs.</td>
</tr>
</tbody>
</table>

Whenever you select log file modules, the log viewer displays a table of the logged events in the selected date range from the associated log files that are stored on the master machine. Each row of the table represents an individual logged event.

**Filtering and sorting the log file entries**

To specify the level of message to display, select **All**, **Error**, **Warning**, or **Information** for **Type**. Your selection applies to the log file entries currently displayed in the Log Viewer pane. To sort the entries in ascending or descending order, click a column heading.
**Refreshing the log viewer**

The **Log Viewer** pane displays a snapshot of log entries from the selected log file modules. The log entries are not dynamically updated as FileMaker Server logs new events in the log files. Click **Refresh** to update the **Log Viewer** pane with the most recently logged events. After you click **Refresh**, the end date is set to the current day.

**Viewing log entry details**

When you select a row in the table of log entries, the date, event ID, and description of the event is displayed in the **Details for** section of the **Log Viewer** pane. You can select the description and copy and paste it into other applications. Ctrl+click (Windows) or ⌘-click (Mac OS) the selected entry to deselect that entry and close the **Details for** section.

**Exporting the log file entries**

You can export the currently displayed table of entries in the **Log Viewer** pane to a tab-delimited text file (.tab). The exported file lists the events in the sort order specified in the **Log Viewer** pane. Click **Export**, type a name, and choose a location for the file.

**Notes**

- If you are a group administrator, your server administrator must configure your administrator group to allow you to view log file entries. For more information, contact your server administrator.
- You can use the **Log Viewer** pane when the Database Server is running or stopped.
- To sort items in the list in ascending or descending order, click a column heading.
- To resize the width of a column, select the column heading border and drag it horizontally.
- To put the columns in a different order, click a column heading, drag it, and drop it at the desired location.
- If the table in the **Log Viewer** pane is empty or you do not see the log file entries you expect, here are some possible causes:
  - Modules — No log file module is currently selected for **Modules**, or a log file required by a selected module is currently empty or not available.
  - Date range — No log file information exists for the selected date range based on the selected log file modules and level of message for **Type**.
  - Type — The level of message selected for **Type** does not exist based on the selected log file modules and date range.
- In a multiple-machine deployment, the log files are on the same machine as the FileMaker Server component that generates the log. Log entries from master and worker machines are consolidated on the master machine so that Admin Console can open all of the Log entries in the **Log Viewer** pane.
- To view log file events older than 90 days, open the log file using any application capable of opening plain text files or the Mac OS Console application. You can open the log file in the Mac OS Console application while FileMaker Server is running. Events are logged continuously, with the most recent log entry at the bottom of the Console application window. All log files are located in the Logs folder:
  - Windows (32-bit): [drive]:\Program Files\FileMaker\FileMaker Server\Logs
  - Windows (64-bit): [drive]:\Program Files (x86)\FileMaker\FileMaker Server\Logs
• Mac OS: /Library/FileMaker Server/Logs

(Windows only) If FileMaker Server is installed in a non-default location, the beginning portion of the default path shown above, \Program Files\FileMaker\FileMaker Server (Windows 32-bit) or \Program Files (x86)\FileMaker\FileMaker Server (Windows 64-bit), is replaced with the path that was specified during installation. For example: \My_Path\Logs

Related topics
Monitoring FileMaker Server
Logging and statistics settings
Viewing server statistics
General web publishing settings
Event log

Note The following information is for server administrators and group administrators.

Events that occur while the Database Server is running are logged and timestamped. Typical events that are logged include:

- Database Server starting and stopping
- database files opened and closed by the Database Server
- consistency checks performed on files that were not closed properly or have not been opened in a FileMaker product
- new, completed, upcoming, and currently running schedules
- administrator groups added, changed, renamed, or removed
- pre-defined errors and conditions that the Database Server detects in your configuration
- current properties settings when the Database Server starts up, as well as settings that are changed during a Database Server session

Events are logged in the tab-delimited Event.log file that is created in the FileMaker Server/Data/Logs/ folder.

Use the Log Viewer pane to view information in the Event.log file. See Viewing log file entries.

You can also view the Event.log file in any application that can read tab-delimited data (FileMaker Pro or a text editor) or the Console application (Mac OS).

Notes

- When the Event.log file reaches the Log Size specified on the Database Server > Logging tab, it is renamed Event-old.log and a new Event.log file is created. To configure the size of the Event.log file, see Logging and statistics settings.
- In Windows, events are also logged in the Windows Application Log accessed with the Event Viewer. For more information, see Viewing activities in the Event Viewer (Windows).
- For more information about the error conditions reported in the event log, see FileMaker Server event log messages.

Related topics
Monitoring FileMaker Server
Changing the language of the Event log
**Access log**

**Note** The following information is for server administrators and group administrators.

The Database Server logs accesses to databases in a separate log file called Access.log. Typical events that are logged include:

- clients that connect to and disconnect from the Database Server
- databases that clients access with a unique account and with the built-in Guest account

Accesses are logged in the tab-delimited Access.log file that is created in the FileMaker Server/Data/Logs/ folder.

Use the Log Viewer pane to view information in the Access.log file. See Viewing log file entries.

You can also view the Access.log file in any application that can read tab-delimited data (FileMaker Pro or a text editor) or the Console application (Mac OS).

**Notes**

- When the Access.log file reaches Log Size specified on the Database Server > Logging tab, it is renamed Access-old.log and a new Access.log file is created.
- To configure access logging, see Logging and statistics settings.
- The Access.log file contains information-level messages only. All warning and error-level messages are logged in the Event.log.

**Related topics**

Monitoring FileMaker Server
Server statistics log

**Note**  The following information is for server administrators and group administrators.

When you enable server statistical logging for the Database Server, a log file is created in the FileMaker Server/Data/Logs/ folder. All of the values that you see in the Statistics > Server tab in Admin Console are timestamped and written to a file. See Viewing server statistics.

You can view these server statistics by opening the Stats.log file in any application that can read tab-delimited data (FileMaker Pro or a text editor) or the Console application (Mac OS).

When the Stats.log file reaches Log Size specified on the Database Server > Logging tab, it is renamed Stats-old.log and a new Stats.log file is created.

To configure statistics logging, see Logging and statistics settings.

**Related topics**

Monitoring FileMaker Server
Viewing log file entries
Client statistics log

**Note** The following information is for server administrators and group administrators.

When you enable client statistical logging for the Database Server, a log file is created in the FileMaker Server/Data/Logs/ folder. All of the values that you see in the Statistics > Clients tab in Admin Console are timestamped and written to a file. See Viewing client statistics.

You can view these client statistics by opening the ClientStats.log file in any application that can read tab-delimited data (FileMaker Pro or a text editor) or the Console application (Mac OS).

When the ClientStats.log file reaches Log Size specified on the Database Server > Logging tab, it is renamed ClientStats-old.log and a new ClientStats.log file is created.

To configure the collection interval and log size for the ClientStats.log file, see Logging and statistics settings.

**Related topics**
- Monitoring FileMaker Server
- Viewing log file entries
Web publishing logs

**Note** The following information is for server administrators and group administrators.

The Web Publishing Engine generates the following log files:

- The wpc_access_log.txt access log is a record of all end-user requests to generate XML and to use FileMaker Server Instant Web Publishing. These requests are routed from the web server directly to the Web Publishing Core component of the Web Publishing Engine.

- The pe_internal_access_log.txt access log is a record of all internal XML requests that the XSLT-CWP software component of the Web Publishing Engine makes while processing XSLT requests. These requests are routed internally within the Web Publishing Engine from the XSLT-CWP software component to the Web Publishing Core software component.

- The pe_application_log.txt application log file is a record of Web Publishing Engine error, FileMaker script, and user log information.
  - The error log information describes any unusual Web Publishing Engine errors that have occurred. Common errors reported to the web user, such as "Database not open," are not recorded.
  - The script log information describes any errors generated when web users execute scripts. For example, it lists script steps that are skipped if they’re not web-compatible.
  - The user log messages contains messages generated by the XSLT `<xsl:message>` element in XSLT stylesheets. Whenever web users access your XSLT stylesheet, information you’ve included within a `<xsl:message>` element is recorded in the application log file.

Use the Log Viewer pane to view information in the web publishing log files. See Viewing log file entries.

To configure logging for web publishing, see General web publishing settings.

**Note** For more information on web publishing logs, see FILEMAKER SERVER CUSTOM WEB PUBLISHING WITH XML AND XSLT and FILEMAKER SERVER CUSTOM WEB PUBLISHING WITH PHP on the Start Page.

Related topics
- Monitoring FileMaker Server
Web Server Module log

**Note** The following information is for server administrators and group administrators.

If the web server is unable to connect to the Web Publishing Engine, the Web Server Module generates a log file that is a record of any errors with its operation. This file is called web_server_module_log.txt and is located in the FileMaker Server/Logs/ folder on the machine running the web server.

Use the Log Viewer pane to view information in the web_server_module_log.txt file. See Viewing log file entries.

**Related topics**
Monitoring FileMaker Server
Managing plug-ins

**Note** The following information is for server administrators.

FileMaker Server can use external function plug-ins with hosted FileMaker Pro databases that are designed to use server-side plug-ins. When hosted databases use plug-ins enabled on FileMaker Server, the machine running FileMaker Server can execute plug-in functions rather than client machines.

Alternatively, FileMaker Server can automatically install or update required or outdated client-side plug-ins on FileMaker Pro clients.

**Notes**

- For information on solving calculations on a host machine, see FileMaker Pro Help.
- For information about developing third-party FileMaker plug-ins, see the FILEMAKER PRO ADVANCED DEVELOPMENT GUIDE available at www.filemaker.com/documentation.

**Related topics**

- Enabling server-side plug-ins
- Enabling auto-update for plug-ins
Enabling server-side plug-ins

Note The following information is for server administrators.

Server-side plug-ins can provide external functions used in the following:

• stored calculations or server-side queries

• FileMaker scripts that are scheduled to run on FileMaker Server (see Running FileMaker scripts)

To enable plug-ins on FileMaker Server:

1. Place plug-ins in the proper folders so that FileMaker Server can use them.
   For details, see Folders for server-side plug-in files.

2. In Admin Console, click the Database Server > Server Plug-Ins tab.

   The list shows the plug-ins that are in the plug-in folder.

4. Select Enabled for each plug-in that you want to execute on FileMaker Server.

5. Click Save.

Notes

• Some plug-ins (and the libraries they reference) load only when the process is executed by a user who is logged in to the system; FileMaker Server executes as a service (Windows) or as several background processes (Mac OS), not as a user process. Consequently, developers need to write plug-ins differently to work with FileMaker Server. Users will need to see their operating system documentation to find which libraries are typically available.

• If a web publishing solution uses a plug-in, you must place a copy of the same plug-in in a folder on the machine running the Web Publishing Engine (even if the Web Publishing Engine is running on the same machine as the Database Server).

Related topics
Managing plug-ins
Folders for server-side plug-in files

**Note**  The following information is for server administrators.

To enable the **Database Server** to use plug-ins, you must place them in the proper folder on the master machine in your FileMaker Server deployment.

- **Windows (32-bit):** `\[drive]\Program Files\FileMaker\FileMaker Server\Database Server\Extensions\`
- **Windows (64-bit):** `\[drive]\Program Files (x86)\FileMaker\FileMaker Server\Database Server\Extensions\`
- **Mac OS:** `/Library/FileMaker Server/Database Server/Extensions/`

If a web publishing solution uses a plug-in, you must place a copy of the same plug-in in a folder on the machine running the **Web Publishing Engine** (even if the Web Publishing Engine is running on the same machine as the database server).

- **Windows (32-bit):** `\[drive]\Program Files\FileMaker\FileMaker Server\Web Publishing\publishing-engine\wpc\Plugins\`
- **Windows (64-bit):** `\[drive]\Program Files (x86)\FileMaker\FileMaker Server\Web Publishing\publishing-engine\wpc\Plugins\`
- **Mac OS:** `/Library/FileMaker Server/Web Publishing/publishing-engine/wpc/Plugins/`

**Notes**

- (Windows only) If FileMaker Server is installed in a non-default location, the beginning portion of the default path shown above, `\Program Files\FileMaker\FileMaker Server` (Windows 32-bit) or `\Program Files (x86)\FileMaker\FileMaker Server` (Windows 64-bit), is replaced with the path that was specified during installation. For example: `\My_Path\Database Server\Extensions\`
- For FileMaker Server on Mac OS, you must set the correct file permissions for plug-ins. See [Changing plug-in file permissions (Mac OS)](changing-plug-in-file-permissions-mac-os).
- You must install the plug-ins for the Web Publishing Engine in addition to any plug-ins you may have installed for FileMaker Server or FileMaker Pro, even if they are the same plug-ins.
- If the Plugins folder does not exist, you must create it. Plug-in files placed in this folder or subfolders must be owned by the `fmsadmin` group and be group readable and executable.

**Related topics**

[Enabling server-side plug-ins](enabling-server-side-plug-ins)
Changing plug-in file permissions (Mac OS)

Note The following information is for server administrators.

To change plug-in file permissions:
1. Start the Terminal application and use the `cd` command to set your path as needed.
2. Enter the following at the command line:
   
   ```
   chmod g+rx <filepath>
   
   or
   chmod g+wrx <filepath>
   ```

   The `g+rx` is necessary because plug-ins and system-level scripts must have the group read and executable bits enabled. Use the `g+wrx` form to permit write permission as well. Some plug-ins or scripts that use preferences or folders of additional files may require write permission to those files or folders.

Related topics
- Folders for server-side plug-in files
- Enabling auto-update for plug-ins
- Enabling server-side plug-ins
Enabling auto-update for plug-ins

Note  The following information is for server administrators.

If database files hosted on FileMaker Server use plug-ins that are designed to execute on the client, you can enable the Auto Update plug-in feature in both FileMaker Server and FileMaker Pro clients. This feature enables FileMaker Server to automatically install or update required or outdated plug-ins or support files on FileMaker Pro clients.

To automatically update a plug-in:

1. Copy the plug-in or support file to the master machine in your FileMaker Server deployment.
   - Windows (32-bit): [drive]\Program Files\FileMaker\FileMaker Server\Data\Databases\AutoUpdate\*
   - Windows (64-bit): [drive]\Program Files (x86)\FileMaker\FileMaker Server\Data\Databases\AutoUpdate\*
   - Mac OS: /Library/FileMaker Server/Data/Databases/AutoUpdate/
   
   Note  (Windows only) If FileMaker Server is installed in a non-default location, the beginning portion of the default path shown above, \Program Files\FileMaker\FileMaker Server (Windows 32-bit) or \Program Files (x86)\FileMaker\FileMaker Server (Windows 64-bit), is replaced with the path that was specified during installation. For example:
   - \My_Path\Data\Databases\AutoUpdate\*

2. (Mac OS) Plug-ins installed on FileMaker Server for Mac OS must also be owned by the group fmsadmin and have group read permission.
   
   Note  Convert plug-ins to .tar file format to be placed on FileMaker Server for Mac OS. See Preparing Mac OS plug-in files for conversion to .tar format.

3. In Admin Console, click the Database Server > FileMaker Pro Clients tab, then select Allow FileMaker Pro clients to download updates automatically.

4. In FileMaker Pro, users must enable the Auto Update feature in the Plug-Ins tab in the Preferences dialog box.

   For more information on updating plug-ins, see FileMaker Pro Help.

For more information on preparing a plug-in and a database for the Auto Update feature, see the FILEMAKER SERVER GUIDE TO UPDATING PLUG-INS on the Start Page.

Related topics
Changing plug-in file permissions (Mac OS)
Managing plug-ins
Preparing Mac OS plug-in files for conversion to .tar format

Note  The following information is for server administrators.
FileMaker Server on Mac OS temporarily converts an uncompressed Mac OS plug-in to the .tar format for downloading to clients. However, this automatic conversion deletes any resource forks, which may make a plug-in that contained a resource fork unusable by the client.

Mac OS plug-in files that contain a resource fork require special actions to work properly with Auto Update:

• The plug-in must be manually compressed before being placed on FileMaker Server.
• Any Mac OS FileMaker Pro client using Auto Update with this plug-in must have StuffIt Expander installed to automatically decompress the plug-in.

To manually compress a plug-in containing a resource fork:

1. Use a third-party utility like StuffIt Standard to manually compress the entire Mac OS plug-in into a single file such as a .sitx archive. You can use any utility that compresses files with resource forks, as long as the output file can be automatically decompressed by StuffIt Expander.
2. Rename the compressed file with the .sitx or other extension to end with .tar. For example, if the plug-in is named test.fmplugin, and the compressed file is named test.fmplugin.sitx, that compressed file must be renamed to test.fmplugin.tar.
3. Place the compressed plug-in on the server computer in the appropriate folder. See Folders for server-side plug-in files.

Important  StuffIt Expander must be installed on the Mac OS client computer to expand the specially compressed plug-in. Auto Update automatically calls StuffIt Expander after downloading the plug-in.

Related topics
Enabling auto-update for plug-ins
Securing your data

Note The following information is for server administrators.

You can take advantage of several FileMaker Server features that make your data more secure for both FileMaker Pro and web clients:

- Encrypt the connection between the Database Server and FileMaker Pro clients and between the Database Server and the Web Publishing Engine. Both user account information and the data are secured using Secure Sockets Layer (SSL) encryption. Click Database Server > Security tab and enable Secure connections to Database Server. See Database Server security settings.

- If you’re publishing databases to web-based clients, enable SSL encryption on the web server to encrypt data that is passed from the web server to guest computers on the web. If you enable SSL on the web server, then you must use the Deployment assistant to configure FileMaker Server to use the HTTPS protocol to communicate with the web server. The Deployment assistant tries to detect your web server using the HTTP protocol, so if your web server uses HTTPS, the Deployment assistant fails to detect the web server and prompts you for more information. In the Deployment assistant’s Web Server Test Failed step, select HTTPS and continue. See Changing a FileMaker Server deployment.

For information on enabling and configuring SSL on your web server, review the web server documentation.

- You can enable and disable specific extended privileges, such as PHP, XML, XSLT, and Instant Web Publishing for the Web Publishing Engine. For example, if you know that all files on one server will be shared with Custom Web Publishing with PHP, you can disable all other types of web publishing. Even if a file includes extended privileges that allow access to XML data, access to XML data is not available while the file is hosted with that FileMaker Server deployment. To enable or disable any web publishing technology for all files on FileMaker Server, click Web Publishing, then click either the PHP, XSLT, XML, or Instant Web Publishing tab. On each of these tabs, you can enable or disable web publishing for all hosted databases even if they have the corresponding extended privilege enabled. See Configuring web publishing settings.

- You can enable FileMaker Server to authenticate users via an external authentication server such as Apple Open Directory or Windows Active Directory. For more information, see External authentication for database access.

- If your organization uses an LDAP directory service, you can enable Use Secure Sockets Layer (SSL) in the Directory Service assistant to encrypt the user names and passwords that FileMaker Server and FileMaker Pro clients use to log in to the LDAP server. See FileMaker Pro client settings and Specifying directory service settings.

- Enable FileMaker Server log files to monitor accesses to databases. See Viewing log file entries.

Note See “Creating accounts that authenticate via an external server” in FileMaker Pro Help and www.filemaker.com/support/security for more information.
Scheduling administrative tasks

Note The following information is for server administrators and group administrators.

The Schedules pane lists the scheduled tasks performed on databases hosted by FileMaker Server that you are allowed to manage. If you are a server administrator, the Schedules pane lists all scheduled tasks for all hosted databases. If you are a group administrator, the Schedules pane lists only the scheduled tasks associated with the hosted databases in your administrator group.

Scheduled tasks run automatically if Allow Enabled Schedules to Run is selected and the selected schedule is enabled. See Enabling and disabling schedules.

Viewing scheduled tasks details

The list displays a summary of each defined schedule, including the task it performs, the last time it ran, and the next time it will run. If a schedule performs a task on a database that is in an administrator group, the list also displays the group’s name if you are a server administrator.

You can view selected schedule details in Details for.

Managing scheduled tasks

Select a schedule, choose one of the following Actions, then click Perform Action:

<table>
<thead>
<tr>
<th>For Actions, choose</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a Schedule</td>
<td>Run the Schedule assistant to create one of the following scheduled tasks:</td>
</tr>
<tr>
<td></td>
<td>• Back Up Databases: back up all hosted databases, databases in selected folders, or selected databases. See Scheduling database backups.</td>
</tr>
<tr>
<td></td>
<td>• Verify Databases: Verify the integrity of all hosted databases, databases in selected folders, or selected databases. See Verifying the integrity of databases.</td>
</tr>
<tr>
<td></td>
<td>• Run Script: Run FileMaker scripts (see Running FileMaker scripts), run system-level script files (see Running system-level script files), or create a script sequence (see Creating Script Sequence tasks).</td>
</tr>
<tr>
<td></td>
<td>• Send Message: Send messages to clients of hosted databases. See Sending scheduled messages to clients of hosted databases.</td>
</tr>
<tr>
<td>Edit a Schedule</td>
<td>Run the Schedule assistant to change scheduled tasks. See Editing schedules.</td>
</tr>
<tr>
<td>Duplicate a Schedule</td>
<td>Duplicate an existing schedule. See Duplicating a schedule.</td>
</tr>
<tr>
<td>Delete Selected Schedules</td>
<td>Delete the selected schedules. See Deleting a schedule.</td>
</tr>
<tr>
<td>Run a Schedule now</td>
<td>Run the selected schedule immediately. See Running a schedule manually</td>
</tr>
<tr>
<td>Enable Selected Schedules</td>
<td>Enable selected schedules. See Enabling and disabling schedules.</td>
</tr>
<tr>
<td>Disable Selected Schedules</td>
<td>Disable selected schedules. See Enabling and disabling schedules</td>
</tr>
</tbody>
</table>
You create or edit schedules with the Schedule assistant. The Schedule assistant guides you through the steps to specify the scheduled task details, set the frequency, and send an email notification when the scheduled task is completed. For information about creating and editing scheduled tasks, click the Help button in the Schedule assistant.

**Notes**

- If you are a group administrator, your server administrator must configure your administrator group to allow you to enable, disable, create, run, edit, or view the details of the scheduled tasks associated with the databases in your group folder. For more information, contact your server administrator.
- A new scheduled task is enabled by default, which means the task will automatically run at its scheduled time. For more information about enabling and disabling scheduled tasks, see [Enabling and disabling schedules](#).
- To sort scheduled tasks in a list in ascending or descending order, click a column heading.
- To resize the width of a column, select the column heading border and drag it horizontally.
- You can define up to 50 schedules in FileMaker Server.
- When a scheduled task completes, FileMaker Server can send an email notification, if you enable this feature for a specific schedule. See [Enabling email notifications in schedules](#).
- FileMaker Server adds entries in the Event.log file when a scheduled task runs. See [Viewing log file entries](#).
- FileMaker Server puts tasks and file-related commands from Admin Console and the command line interface into the following separate queues:
  - Back up Database, Verify Database, and file-related commands (for example, Open, Close, Pause, and Resume). Only one task or command runs at one time from this queue. The remaining tasks or commands are delayed until the current one is complete.
  - Send Message and Run Script tasks (FileMaker scripts and system-level script files). Multiple tasks can run at the same time from this queue.

FileMaker Server runs tasks from both queues at the same time. For example, the first queue has a Back Up Database task and a Pause command. The second queue has a Run Script task and a Send Message task. FileMaker Server runs the Back Up Database, Run Script, and Send Message tasks at the same time. The Pause command is not executed until the Back Up Database task completes.

**Related topics**

- [Email notification settings](#)
- [Default folder settings](#)
Scheduling database backups

Note The following information is for server administrators and group administrators.

If you are a server administrator, you can back up all hosted databases, databases in selected folders, or a selected database. If you are a group administrator, you can back up only hosted databases that are in your administrator group.

Database backups are saved in the default backup folder or in a folder that you specify. You can set the path in the Schedule assistant.

During backups, FileMaker Server copies the database while it is active. Users can continue to make modifications. When the copy is complete, the database pauses to synchronize backup files with the current database and then the database resumes. In the Schedule assistant, you can also specify the maximum number of database backups to keep, whether to perform a consistency check on the backup file, and whether to receive email notifications when backups are complete.

The destination disk that stores your hosted files and backups must have plenty of free space. If the hard disk runs out of space while a file is being modified or if a database file reaches the 8 terabytes size limit, the file will be compressed. Compression may take some time to complete.

If the hard disk runs completely out of space during a backup, the backup stops, the backup file is deleted, and FileMaker Server logs an error in Event.log. You should check the Schedules list for error conditions, which are reported in the Last Run Status. To avoid running out of disk space when backing up files, choose a different hard disk as your backup destination, or move completed backups to offline storage.

Note If you are a group administrator, your server administrator must configure your administrator group to allow you to back up the databases in your group folder. For more information, contact your server administrator.

Related topics
Creating schedules
Viewing log file entries
Default folder settings
Scheduling administrative tasks
Tips for database backups

**Note** The following information is for server administrators and group administrators.

Develop plans for restoring data, including alternate sites and systems to run business-critical information services. A current backup can help you recover from a situation where someone loses the administrator account information for a file, or where user error (and sometimes bad database design) causes data to be deleted or modified inappropriately.

Keep the following in mind:

- Host databases with FileMaker Server and create regularly-scheduled, automated backups.
  
  Don't use third-party backup software on hosted FileMaker Pro databases. First, use FileMaker Server to make a backup copy of your database, then run your third-party backup software on the copy. Backup software can damage open, hosted databases.

  For example, make local backups of files at 6:00 AM, 9:00 AM, 12:00 noon, 3:00 PM, 6:00 PM, and 11:30 PM weekdays. At midnight, make an incremental backup of the entire system (excluding active hosted databases) to the enterprise backup system. Finally, Friday night at midnight, perform a full system backup, excluding active hosted databases or stop the Database Server during the backup.

  Copy and store the backup media at a remote location. This way, if the server goes down for some reason other than catastrophic failure of multiple drives, the more recent backup of the data files can be used, meaning a maximum of 3 hours of lost data. If there is a catastrophic drive failure, then you can use the previous evening's backup media, minimizing the loss to one day's data.

- In the Schedule assistant, you can enable **Verify backup integrity**. After a backup is complete, FileMaker Server performs a consistency check, confirming whether the backup file is the same as the hosted file. Enabling this check can detect errors in the backup file and send you email notification when the check is complete. However, backup operations that have this option enabled can take much longer to complete and may slow other activities on the master machine.

- In the Schedule assistant, you can enable **Clone the backup file** to save your backed up file's tables, layouts, scripts, page setup options, and field definitions without the data. You can possibly import the data from a damaged database into a clone of the backed up database.

- Make sure backup copies aren't damaged or inaccessible. Verify that they are functioning properly before you need them. Run diagnostic tools on your hard drive and your backup files regularly.

- Ensure that you can restore an entire set of files from backup copies.

- Regularly export the data to protect against file corruption.

- Protect the backup media. Store backups in a separate fire-proof location.

- Assign backup administrators who can retrieve files, in case the network administrator is unavailable.

- Enable the default Daily, Hourly, and Weekly backup schedules on the Schedules pane to use the **Maximum number of backups to keep** option and keep 7, 8, and 4 backup copies respectively. See [About keeping multiple backups of a scheduled backup](#).

**Important** In the event of a server failure, such as an unexpected loss of power, hard drive failure, or software failure, use the backup files. Any system failure causing FileMaker Server to shut down inappropriately can result in corrupted files if cached data was not written to disk and the files were not closed properly. Even if the files re-open and go through a consistency check or recovery,
corruption might be buried in the file. File recovery cannot guarantee that problems have been fixed. For information on recovering damaged files, see FileMaker Pro Help.

Related topics
- Restoring a database file from a backup
- Examples of repeating schedules
- Scheduling database backups
About keeping multiple backups of a scheduled backup

Note The following information is for server administrators and group administrators.

In the Schedule assistant, use the Maximum number of backups to keep option to select how many backups of the selected databases you want to keep for a scheduled backup.

For example, create a scheduled backup that runs once a day at 6:00 PM and keep a maximum of seven backups, which is a daily backup for one week. On the eighth day of the scheduled backup, FileMaker Server automatically deletes the oldest backup, which was done on the first day of the previous week, and replaces it with a new backup on the first day of the current week.

Each time a scheduled backup runs, FileMaker Server creates a new subfolder within the Backup Folder that you specified in the scheduled backup. The name of the new subfolder is a combination of the schedule name and the local server date and time when the scheduled backup runs (for example, DailyBackup_2008-07-25_1800). When the total number of backups reaches the maximum number you specify, FileMaker Server automatically deletes the oldest backup subfolder in the Backup Folder.

Notes

- If there is insufficient disk space on the destination disk for a new backup, FileMaker Server deletes one or more of the oldest backup subfolders to create the required free disk space for the newest backup.
- If you change the name of a scheduled backup, FileMaker Server renames all existing backup subfolders to match the new name.
- If you change the Backup Folder of a scheduled backup, FileMaker Server cannot automatically move the existing backup subfolders. You must manually move them to the new Backup Folder if you want FileMaker Server to count them towards the maximum number of backups to keep.
- If you decrease the Maximum number of backups to keep, FileMaker Server deletes the extra backup subfolders, starting with the oldest.
- If you remove a database from a scheduled backup or if the database is no longer hosted, FileMaker Server eventually deletes that database from all of the backup subfolders as the scheduled backup runs over time and the maximum number of backups is reached.
- The default Daily, Hourly, and Weekly backup schedules on the Schedules pane have the Maximum number of backups to keep option enabled and keep 7, 8, and 4 backup copies respectively.

Related topics

- Scheduling database backups
- Tips for database backups
- Restoring a database file from a backup
- Selecting the backup folder and options
### Restoring a database file from a backup

**Note** The following information is for server administrators and group administrators.

Restore a database from a backup by using your operating system tools to copy the database from the backup folder to the folder where FileMaker Server hosts database files.

**To restore a database file from a backup:**

1. If the hosted database file you want to restore is currently open, use the FileMaker Server Admin Console to close it.
   
   See [Closing hosted files](#).
2. Use the FileMaker Server Admin Console to remove the hosted database.
   
   See [Removing hosted files](#).
3. Use your operating system tools to copy the database file from the backup folder to the database folder where you uploaded the hosted database file.
   
   See [Selecting the backup folder and options](#) and [Uploading database files](#).
4. Use the FileMaker Server Admin Console to open the restored database.
   
   See [Opening hosted files](#).

**Notes**

- To avoid possibly damaging the only backup of your database, make sure that you copy the database file you want to restore and leave the original backup file unchanged in the backup folder. Do not move the database file out of the backup folder, and do not use FileMaker Pro to open the database file that is stored in the backup folder.
- To restore multiple database files in a solution at once, perform the preceding procedure on the set of files if all of the files were backed up together at the same time. If some of the files in the solution were backed up at different times, you must decide whether it is necessary to restore from an older backup folder in which all of the files were backed up at the same time and consequently are all in sync.

**Related topics**

- [About keeping multiple backups of a scheduled backup](#)
- [Scheduling database backups](#)
- [Tips for database backups](#)
- [Selecting the backup folder and options](#)
Verifying the integrity of databases

Note  The following information is for server administrators and group administrators.

If you suspect a database is damaged, verify its integrity by performing a consistency check:

- Create a Verify Database scheduled task in the Schedule assistant to verify all hosted databases, databases in selected folders, or a selected database. See Creating schedules.
- Verify databases at any time in the Databases pane. See Administering databases.

Before starting the verification process, FileMaker Server sends a notification message to the FileMaker Pro clients informing users that FileMaker Server must close the selected databases. When the delay time elapses, FileMaker Server disconnects any remaining clients and closes the selected databases, verifies them, and then reopens the databases that were successfully verified. If a database fails the consistency check, you must use FileMaker Pro to recover the file. For information on recovering damaged files, see FileMaker Pro Help.

FileMaker Server logs a message in Event.log indicating the success or failure of the consistency check.

Note  If you are a group administrator, your server administrator must configure your administrator group to allow you to verify the integrity of the databases in your group folder. For more information, contact your server administrator.

Related topics
Viewing log file entries
Scheduling administrative tasks
Running server-side scripts

**Note** The following information is for [server administrators](#) and [group administrators](#).

FileMaker Server can run two types of scripts to automate administrative tasks:

- [FileMaker scripts](#) defined in hosted databases. See [Running FileMaker scripts](#).
- System-level script files. See [Running system-level script files](#).

Both types of scripts execute on the [master](#) machine in your FileMaker Server [deployment](#).

To run a script, create a scheduled task on FileMaker Server. Specify the script, and when and how often to run the script. As with any schedule, you can run the scheduled task manually at any time.

You can also create a [Script Sequence](#) scheduled task that runs optional [pre-processing](#) and [post-processing](#) system-level scripts before and after a FileMaker script. See [Creating Script Sequence tasks](#).

**Note** If you are a group administrator, your server administrator must configure your administrator group to allow you to run scripts associated with the databases in your group folder. For more information, contact your server administrator.

**Related topics**

[Running administrative tasks](#)
Running FileMaker scripts

**Note**  The following information is for server administrators and group administrators.

FileMaker Server can run FileMaker scripts that are created in hosted databases. You create a Run Script scheduled task, specify the database and the FileMaker account to use to run the script, choose a script created in the database, and when to run the script. FileMaker scripts that run on FileMaker Server can do simple or complex tasks such as:

- perform a field recalculation across all records
- process and archive new transactions nightly
- remove duplicate records before a scheduled backup

You use the Manage Scripts feature (formerly ScriptMaker) in FileMaker Pro to build scripts by selecting from a list of FileMaker Pro commands, called script steps, and specifying options. To run a FileMaker script on FileMaker Server:

- The script should include script steps that are supported either in web publishing or in a FileMaker Server scheduled script.
- The script must be defined in a database file that is hosted on FileMaker Server. See Hosting databases.

For information about creating FileMaker scripts with web-compatible script steps, see FileMaker Pro Help.

You can also create a Script Sequence scheduled task that runs optional pre-processing and post-processing system-level scripts before and after a FileMaker script. See Creating Script Sequence tasks.

**Notes**

- You can select **Abort schedule if time limit reached or server stopped** in the Schedule assistant to abort the FileMaker script schedule if the script takes longer to run than the specified **Time limit**, or if the Database Server stops. (See **Adding script options**.) If you do not select **Abort schedule if time limit reached or server stopped** and a FileMaker script hangs, look in the Event.log file for the process ID of the hung script to terminate. (See **Event log**.)
- If scripts contain steps that are unsupported in web publishing or in a FileMaker Server scheduled script, use the Allow User Abort script step to determine how subsequent steps are handled.
  - If the Allow User Abort script step option is enabled (On), unsupported script steps will stop the script from continuing.
  - If the Allow User Abort script step option is disabled (Off), unsupported script steps are skipped over and the script continues to execute.
  - If this script step is not included, scripts are executed as if the feature is enabled, so unsupported script steps will stop scripts.

Some script steps have options that are skipped, such as an option to show a dialog box. The Event.log file contains detailed information about errors or script steps that are skipped when FileMaker Server runs FileMaker scripts. See Viewing log file entries.

- Server-side FileMaker scripts run in separate sessions on the **Database Server**, behaving like they do for **Custom Web Publishing**. Each session has its own copy of global fields and variables. Calculation functions return the same values as when scripts run under Custom Web Publishing, with the following exceptions:
• Get(AccountName) initially returns the account name that the script was run under (specified in the Schedule assistant when the schedule is created).

• Get(UserName) returns the schedule name.

• Get(ApplicationVersion) returns the Database Server version string.

• Functions related to hardware, such as Get(SystemIPAddress), return information from the Database Server.

• Whenever a session starts for a server-side FileMaker script, a unique temporary subfolder is created for that session in the temp folder on the FileMaker Server computer. The temporary subfolder name begins with the letter “S”, followed by a number representing the session. You can use the Get(TemporaryPath) function to return the path to the temporary subfolder. When the session is terminated, the temporary subfolder and any files placed in it are deleted.

• When running on FileMaker Server, the Get(DocumentsPath) function returns the path to the Documents folder, which is in the same folder as the server’s Backups, Databases, and Scripts folder. You can use the Documents folder as a shared location for passing import and export files between pre-processing scripts, FileMaker scripts, and post-processing scripts in Script Sequence tasks.

• Use the Get(DocumentsPathListing) function with the Import Records and Export Records script steps to determine if a file exists before using the Open File script step to open the file, and to ensure that multiple scripts can safely read and write to the same FileMaker Pro database.

• FileMaker Server evaluates relative file paths in import and export script steps in relation to the Get(TemporaryPath) unique subfolder. Script steps that use relative paths containing “..” return an access error when performed. Script steps can use absolute paths if they point to the Documents folder or any of its subdirectories. That is, the beginning of the absolute path must be the same as the path returned by the Get(DocumentsPath) function. For example, any Mac OS path that starts with /Library/FileMaker Server/Data/Documents is acceptable.

• A server-side FileMaker script that is running on one FileMaker server cannot open a database that is hosted on a different FileMaker server.

Related topics
Creating schedules
Running server-side scripts
Scheduling administrative tasks
Running system-level script files

**Note** The following information is for server administrators and group administrators. FileMaker Server can run system-level script files, such as a Windows batch command, VBScript, or Mac OS shell script (bash, Perl, Python). You create a Run Script scheduled task, specify the script file and optional script parameters, the user account to use to run the script, and when to run the script. Use system-level scripts to perform tasks outside of FileMaker Server.

To run a script as a scheduled task, you must place the system-level script file in the FileMaker Server Scripts folder:

- Windows (32-bit): `[drive]\Program Files\FileMaker\FileMaker Server\Data\Scripts\`
- Windows (64-bit): `[drive]\Program Files (x86)\FileMaker\FileMaker Server\Data\Scripts\`
- Mac OS: `/Library/FileMaker Server/Data/Scripts/`

**Note** (Windows only) If FileMaker Server is installed in a non-default location, the beginning portion of the default path shown above, `\Program Files\FileMaker\FileMaker Server` (Windows 32-bit) or `\Program Files (x86)\FileMaker\FileMaker Server` (Windows 64-bit), is replaced with the path that was specified during installation. For example: `\My_Path\Data\Scripts/`

For information about creating system-level scripts, see the documentation for the scripting language you want to use.

You can also create a Script Sequence scheduled task that runs optional pre-processing and post-processing system-level scripts before and after a FileMaker script. See Creating Script Sequence tasks.

**Notes**

- You must include error-handling and branching logic in your system-level scripts. Make sure that the script syntax is correct and does not hang due to infinite loops or the availability of external resources. You can select **Abort schedule if time limit reached or server stopped** in the Schedule assistant to abort the System-level Script schedule if the script takes longer to run than the specified **Time limit**, or if the Database Server stops. (See Adding script options.) If you do not select **Abort schedule if time limit reached or server stopped** and a system-level script hangs, look in the Event.log file for the process ID of the hung script to terminate. (See **Event log**.)
- In the System-level Script schedule, you must specify an account that has the correct privileges to run the system-level script. (See Selecting a system-level script to run.)
- Enable some form of logging in your script so that you can troubleshoot possible permissions issues. Refer to the Apple website for information on creating log files in Mac OS.
- Do not use system-level scripts that invoke a user interface.

**Related topics**

- Users, groups, and permissions (Mac OS)
- Creating schedules
- Running server-side scripts
- Scheduling administrative tasks
Creating Script Sequence tasks

**Note** The following information is for server administrators and group administrators.

Create a Script Sequence scheduled task to run an optional pre-processing system-level script, next run a FileMaker script, and then run an optional post-processing system-level script.

A script sequence can perform pre-processing on files before importing them into FileMaker Pro database, run a FileMaker script to perform processing on the database and export files, and then perform post-processing on the exported files. For example, create a script sequence that first runs a pre-processing system-level script that validates and reformats a text file exported from another database. Next, the script sequence runs a FileMaker script that imports the text file, combines it with data stored in a FileMaker Pro database, and generates multiple personalized reports in Excel format. Lastly, the script sequence runs a post-processing system-level script that creates a zip file of the reports and places them into a download directory for users.

When creating system-level scripts and FileMaker scripts for a script sequence, keep the following in mind:

- The pre-processing script (if one is specified) must return a value of 0 (zero) in order for the script sequence to proceed to the FileMaker script.
- The FileMaker script must return a value of 0 (zero) in order for the script sequence to proceed to the post-processing script (if one is specified).
- The post-processing script (if one is specified) must return a value of 0 (zero) in order for the schedule to complete successfully.
- You must include error-handling and branching logic in your system-level scripts. Make sure that the script syntax is correct and does not hang due to infinite loops or the availability of external resources. You can select *Abort schedule if time limit reached or server stopped* in the Schedule assistant to abort the Script Sequence schedule if the sequence of scripts takes longer to run than the specified **Time limit**, or if the Database Server stops. (See Adding script options.) If you do not select *Abort schedule if time limit reached or server stopped* and a system-level script hangs, look in the Event.log file for the process ID of the hung script to terminate. (See Event log.)
- If you select a FileMaker script only and no pre-processing and post-processing scripts, the Script Sequence scheduled task is the same as a FileMaker Script scheduled task.

For information about FileMaker script steps and functions, see FileMaker Pro Help.

**Note** Enable email notifications in the Script Sequence scheduled task to receive a message for error or warning conditions, or confirmation of a successful completion.

**Related topics**
- Running FileMaker scripts
- Running system-level script files
- Creating schedules
- Scheduling administrative tasks
Sending scheduled messages to clients of hosted databases

**Note** The following information is for server administrators and group administrators.

You can create a message and set up a schedule to deliver the message to FileMaker users. Messages can notify users about important events such as server shutdowns, database upgrades, or deadline reminders.

You can send messages to:
- All FileMaker Pro users currently connected to hosted databases
- FileMaker Pro users connected to databases in a selected folder
- FileMaker Pro users connected to a selected database

**Note** If you are a group administrator, your server administrator must configure your administrator group to allow you to send scheduled messages to clients of the databases in your group folder. For more information, contact your server administrator.

**Related topics**
- Creating schedules
- Scheduling administrative tasks
- Sending messages to FileMaker Pro clients of selected databases
Creating schedules

**Note** The following information is for server administrators and group administrators.

The following are general steps for creating a scheduled task. For detailed instructions and procedures, click the Schedule assistant help button.

**To create a scheduled task:**

1. Choose Schedules.
2. For Actions, select Create a Schedule.
3. Click **Perform Action** to open the Schedule assistant.
4. Specify schedule details. Click **Finish** in the Schedule assistant to save changes to the schedule.
   
   For more information, click the Help button in the Schedule assistant.
5. Select **Enabled** next to the schedule to enable it to run.

**Note** If you are a group administrator, your server administrator must configure your administrator group to allow you to create schedules for the databases in your group folder. For more information, contact your server administrator.

**Related topics**

- Running a schedule manually
- Scheduling administrative tasks
Examples of repeating schedules

**Note** The following information is for server administrators and group administrators.

The following examples show how schedules work when they run more than once. For a schedule created and enabled at 4:30 PM today, assuming today is Friday:

<table>
<thead>
<tr>
<th>A schedule defined this way</th>
<th>Runs at these times</th>
</tr>
</thead>
</table>
| **A Daily** schedule that runs **once per day** at 5:00 PM, with an end date of 12/31/2010 | The first time is at 5:00 PM today, Friday.  
The next time is at 5:00 PM tomorrow, Saturday.  
The schedule continues to run once daily at 5:00 PM, with its final run at 5:00 PM on 12/31/2010. |
| **A Daily** schedule that runs **every hour** with a start time of 9:00 AM and end time of 5:00 PM, with no end date specified | The first time is today, Friday, at 5:00 PM.  
The next times are at 9 AM, 10 AM, 11 AM, 12 PM, 1 PM, 2 PM, 3 PM, 4 PM and 5 PM tomorrow, Saturday.  
The schedule continues to run daily, every hour starting at 9 AM and ending at 5 PM, inclusive. |
| **A Weekly** schedule that runs **once per day** at 5:00 PM, every Friday, with an end date of 12/31/2010 | The first time is today, Friday, at 5:00 PM.  
The next time is next Friday at 5:00 PM.  
The schedule continues to run once every Friday at 5:00 PM, with its final time at 5:00 PM on 12/26/2010 (the last Friday before the end date). |
| **An Every n days** schedule that runs **every three days, every hour**, with a start time of 9:00 AM and end time of 5:00 PM, with no end date specified | The first time is today, Friday, at 5:00 PM.  
The next time is next Monday at 9:00 AM, and every hour that day until 5:00 PM, inclusive.  
The schedule continues to run every three days every hour starting at 9 AM and ending at 5 PM, inclusive. |

**Notes**

- Start/end dates and start/end times are inclusive. The last time a schedule can run is at the scheduled end time on the scheduled end date.
- The start time and end time of a schedule must fall within the same day. If you want a schedule to run repeatedly overnight, create two schedules. For example, to back up databases hourly between 9:00 PM and 5:00 AM starting every Friday night and running overnight, create one schedule that backs up every Friday, every hour, starting at 9:00 PM and ending at 11:00 PM, and another schedule that backs up every Saturday, starting at 12:00 AM and ending at 5:00 AM.
- A schedule starts running at the specified time but it may have to wait for other schedules to complete before it can proceed. If the other schedules take too long, the schedule may not complete before you expected it to run a second time. If this happens, that second run time is skipped.

**Related topics**

- Selecting the schedule frequency
- Creating schedules
Scheduling administrative tasks

Editing schedules
Scheduling administrative tasks
Editing schedules

**Note** The following information is for server administrators and group administrators.

The following are general steps for editing a scheduled task. For detailed instructions and procedures, click the Schedule assistant help button.

**To edit a schedule:**

1. Choose Schedules, then select a schedule from the list.
2. For Actions, select Edit a Schedule.
3. Click Perform Action to open the Schedule assistant.
4. Make changes to the schedule. Click Finish in the Schedule assistant to save changes to the schedule.
   - For more information, click the Help button in the Schedule assistant.
5. If necessary, select Enabled next to the schedule to enable it to run.

**Notes**

- If you are a group administrator, your server administrator must configure your administrator group to allow you to edit schedules for the databases in your group folder. For more information, contact your server administrator.
- You can also double-click a schedule from the list on the Schedules pane to edit it in the Schedule assistant.

**Related topics**

- Enabling and disabling schedules
- Examples of repeating schedules
- Running a schedule manually
- Scheduling administrative tasks
Duplicating a schedule

**Note** The following information is for server administrators and group administrators. Sometimes it is easier to duplicate and edit an existing schedule rather than define a new schedule.

**To duplicate an existing schedule:**

1. Choose Schedules, then select a schedule from the list.
2. For Actions, select Duplicate a Schedule.
3. Click Perform Action.

   The selected schedule is copied with the name `<schedule name> Copy`.

   **Tip** You can rename the schedule in the Schedule assistant. For Actions, select Edit a Schedule to open the Schedule assistant and change the schedule name.

**Note** If you are a group administrator, your server administrator must configure your administrator group to allow you to duplicate schedules for the databases in your group folder. For more information, contact your server administrator.

**Related topics**

- Editing schedules
- Deleting a schedule
- Scheduling administrative tasks
Deleting a schedule

Note The following information is for server administrators and group administrators.

To delete a schedule:
1. Choose Schedules.
2. Select one or more schedules from the list.
3. For Actions, select Delete Selected Schedules.
4. Click Perform Action.
   Click Yes to confirm that you want to delete the selected schedules.

Note If you are a group administrator, your server administrator must configure your administrator group to allow you to delete schedules for the databases in your group folder. For more information, contact your server administrator.

Related topics
Editing schedules
Duplicating a schedule
Scheduling administrative tasks
Running a schedule manually

**Note** The following information is for server administrators and group administrators.

You can run a schedule manually even in cases where it will not run automatically or it is disabled. For example, you can run a schedule manually when:

- You have disabled a given schedule by clearing Enabled
- You have disabled all schedules by clearing Allow enabled schedules to run
- A schedule is disabled because its final scheduled run has already occurred. The Last Completed column is updated with the last time the schedule successfully completed. The Next Run column will remain Disabled.

To run a schedule manually:

1. Select Schedules, then select a schedule from the list.
2. For Actions, select Run a Schedule now.
3. Click Perform Action.

   The Last Completed column displays the current date and time of the computer FileMaker Server is running on.

**Note** If you are a group administrator, your server administrator must configure your administrator group to allow you to run schedules for the databases in your group folder. For more information, contact your server administrator.

**Related topics**

- Enabling and disabling schedules
- Scheduling administrative tasks
Enabling and disabling schedules

**Note** The following information is for server administrators and group administrators.

You can enable or disable specific schedules or you can disable all schedules at once.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable a schedule when creating or editing it</td>
<td>If you use the Schedule assistant to create a schedule, the scheduled task is enabled by default.</td>
</tr>
<tr>
<td>Enable a schedule that was disabled</td>
<td>In the Schedules pane, select the empty checkbox to the left of the schedule name.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>If the schedule’s final run time has already occurred, you must edit the run time before it can be enabled again.</td>
</tr>
<tr>
<td>Disable a selected schedule</td>
<td>In the Schedules pane, clear the checkbox to the left of the schedule name.</td>
</tr>
<tr>
<td>Prevent all schedules from running</td>
<td>In the Schedules pane, clear <em>Allow enabled schedules to run.</em></td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>This option is convenient for performing administrative tasks on the server computer.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>This setting overrides any individual schedule settings you have enabled.</td>
</tr>
<tr>
<td>Allow enabled schedules to run</td>
<td>In the Schedules pane, select <em>Allow enabled schedules to run.</em></td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>A checkmark indicates that all scheduled tasks that are individually checked in the scheduled task list are enabled.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Scheduled tasks that were individually disabled are not re-enabled until you enable them individually.</td>
</tr>
</tbody>
</table>

**Note** If you are a group administrator, your server administrator must configure your administrator group to allow you to enable or disable the schedules for the databases in your group folder. For more information, contact your server administrator.

**Related topics**
- Running a schedule manually
- Scheduling administrative tasks
Saving and loading schedules and groups

**Note** The following information is for server administrators.

If you need to reinstall FileMaker Server on the same machine or move the installation to another machine, you can save the settings for your schedules and administrator groups that are configured in the current installation. After you install FileMaker Server, you can then load the settings for your schedules and administrator groups to instantly configure them in the new installation. The steps below provide an overview of the process.

1. In your current installation of FileMaker Server (called the source server), save the settings for your existing schedules and administrator groups in a **Schedules and Groups settings file**. You will use this file to create your schedules and administrator groups in the new FileMaker Server installation. See Saving schedules and groups settings.

2. Install FileMaker Server. Keep the following in mind:
   - If you are moving the installation to another computer, create a folder structure on the new computer that is identical to the folder structure on the source computer.
   - Copy or move the contents of the default database folder and additional database folder from the source computer to the new computer, including your databases, system-level scripts, external files for script sequences, and plug-ins.
   - Register runtime solutions in the new FileMaker Server installation. See Database settings.

   **Tip** An easy way to recreate the folder structure and copy the databases and other files is to create an archive of the files and folders on the source computer and extract the archive on the new computer.

   **Note** Any Mac OS subfolders containing databases, backups, script files, or plug-ins must also be readable and executable by the fmsadmin group. Database and backup folders need to be writable by the fmsadmin group for backups and uploads. Some plug-ins or scripts that use preferences or folders of additional files may require write permission to those files or folders.

   For more details on moving an existing installation of FileMaker Server 11 to another machine, see FILEMAKER SERVER GETTING STARTED GUIDE on the Start Page.

3. In the new FileMaker Server installation, load the Schedules and Groups settings file. See Loading schedules and groups settings.

**Notes**

- The Schedules and Groups settings file contains settings for schedules and administrator groups only. For schedules, the settings file contains all of the information you entered in the Schedule assistant. For administrator groups, the settings file contains group names, account details, privileges, and group home folders.
- All passwords in the Schedules and Groups settings file are encrypted.
- Do not edit the Schedules and Groups settings file; if you do, the settings will not load.
- When you save a Schedules and Groups settings file, it is saved in the language of the base OS installation on the master machine. When you load a Schedules and Groups settings file, the language of the settings file must match the language setting on the master machine. Because of differences in locale content, you cannot load a Schedules and Groups settings file that was saved in a language different from the language setting on the master machine.
Saving and loading schedules and groups

Related topics
Saving schedules and groups settings
Loading schedules and groups settings
Uploading database files
Saving schedules and groups settings

Note The following information is for server administrators.

To save schedules and groups settings:

1. In Admin Console for the FileMaker Server 11 source server, choose Server menu > Save Schedules and Groups.
2. Click Browse, navigate to the folder where you want to save the Schedules and Groups settings file, and click Open.
3. Click Save to save the Schedules and Groups settings file, then click OK in the Save Successful dialog box.

Note The default name of the Schedules and Groups settings file is fms11_settings.xml. You cannot specify a different name when you save the file in Admin Console. If you prefer, you can change the filename using your operating system tools after you save the file.

Related topics
Saving and loading schedules and groups
Loading schedules and groups settings
Loading schedules and groups settings

Note The following information is for server administrators.

Important Whenever you load a Schedules and Groups settings file, all existing schedules and administrator groups settings in the new FileMaker Server installation are deleted and replaced by the settings in the Schedules and Groups settings file. You cannot merge the schedules and administrator groups settings from multiple FileMaker Servers.

To load schedules and groups settings:

Important Before loading the Schedules and Groups settings file, make sure you have created a folder structure in the new FileMaker Server installation that is identical to the source server installation. Copy the databases, scripts, and other solution files from the source installation to the new FileMaker Server installation, and set the appropriate permissions on Mac OS. Copy the Schedules and Groups settings file to the new installation if you are installing on a different machine. (The default filename is fms11_settings.xml.) For more information, see Saving and loading schedules and groups.

1. In Admin Console for the new FileMaker Server installation, choose Server menu > Load Schedules and Groups.
2. Click Browse and navigate to the folder where you saved the Schedules and Groups settings file. The default filename is fms11_settings.xml, unless you changed the filename using your operating system tools.
3. Select the Schedules and Groups settings file and click Open.
4. Click Load to load the Schedules and Groups settings file into FileMaker Server.
5. Click Yes to replace all of the existing schedules and administrator groups in the new FileMaker Server installation with the schedules and administrator groups from the source installation.
6. Do one of the following:
   • If the Load Successful dialog box appears, no errors occurred and you can click OK.
   • If the Load Schedules and Groups Results dialog box appears, note the errors that occurred so that you can make the necessary corrections, and then click OK.

Notes

• When you load the Schedules and Groups settings file in the new FileMaker Server installation, FileMaker Server automatically updates the relative paths in the schedules and administrator groups that refer to folders, databases, and scripts located within the default database folder structure. If you moved the folders, databases, and scripts to different folders in the new installation, use the Schedule assistant to change the paths in all schedules or administrator groups to refer to those folders, databases, and scripts in their new folders. See Editing schedules for configuration instructions.
• If necessary, upload any missing databases and move any missing folders, script files, external files for script sequences, or plug-ins to the correct folders in the new FileMaker Server installation.
• If you enabled email notifications for any schedules, you must manually configure the SMTP server settings in the new FileMaker Server installation. See Email notification settings for configuration instructions.

• If necessary, change the administrator group settings on the Administrator Groups > Manage Groups tab to enable the groups to work properly in the new installation. See Configuring administrator groups for configuration instructions.

Related topics
Saving schedules and groups settings
Uploading database files
Troubleshooting

Note The following information is for server administrators.

Problems with FileMaker Server typically occur in the following areas:

- Deployment problems
- Admin Console problems
- General problems
- Network problems
- Problems on client computers
- FileMaker Server event log messages
- Command line error messages
- Improving performance

Note If FileMaker Pro is already running while the Database Server is starting up on the same machine, the Database Server will start up but then stop. Stop FileMaker Pro, then start the Database Server. If this problem persists, restart your computer, then start the Database Server before starting FileMaker Pro.
Deployment problems

Note The following information is for server administrators.

The Deployment assistant reports that the web server test failed
If the Deployment assistant cannot communicate with the web server that you specified, you can provide more information and try again.

To detect the web server:
1. Click Edit Server Deployment.
2. In the Deployment assistant, click Next until you reach the Web Server Test Failed step.
3. Follow the instructions in Web Server Test Failed.

The Mac OS web server fails during startup
When you install the FileMaker Server supported version of PHP, it does not appear in the Mac OS X Server Admin tool; it is not supposed to be listed. If you use the Mac OS X Server Admin tool to turn on PHP, the Server Admin tool adds a second PHP engine to the web server's configuration files. As a result, the web server may fail during startup when it attempts to load the second PHP engine.

Refer to the FileMaker Knowledge Base for more information. See Customer support and Knowledge Base.

Related topics
Troubleshooting
Admin Console problems

Note The following information is for server administrators.

Admin Console Start Page says to install Java when it’s already installed

Internet Explorer may be configured to prevent add-ons from running. Click the Information Bar at the top of the browser window and allow Internet Explorer to run the Java Web Start ActiveX Control add-on. Java Web Start technology uses this add-on to determine whether the required version of Java is installed. After you allow this add-on to run, click Start Admin Console.

Admin Console does not respond

If Admin Console does not respond when you click tabs, commands, or options in the Admin Console window, the Admin Server process might have stopped. You can restart the Admin Server process by using the fmsadmin RESTART ADMINSERVER command. For more information, see RESTART command.

Admin Console restarts frequently

The FileMaker Server service (Windows) or the fmserver_helperd daemon (Mac OS) starts and monitors the Admin Server process. By default, FileMaker Server will automatically restart the Admin Server process whenever it has stopped or is no longer responding for more than approximately one minute. If Admin Console restarts frequently, the cause may be that the time limit for Admin Console to respond is being exceeded in your deployment. You can prevent this behavior by turning off automatic monitoring with the fmsadmin AUTORESTART ADMINSERVER command. For more information, see AUTORESTART command.

Cannot start Admin Console from a remote machine

• If the master machine has a firewall enabled, then you must open the ports required by FileMaker Server to communicate with users and administrators. See Ports used by FileMaker Server.

• If you double-click an Admin Console shortcut and Admin Console doesn’t open, check whether the IP address of the master machine has changed. Each shortcut starts Admin Console for a specific FileMaker Server deployment. If the IP address of the master machine changes, you must remove the shortcut and start Admin Console from the FileMaker Server Admin Console Start Page again. See Starting Admin Console.

• If Admin Console is unable to connect to FileMaker Server, it is possible that the Admin Server process has stopped or FileMaker Server has only partially started. To check whether the Admin Server process has stopped, try using the fmsadmin LIST FILES command (see LIST command). If LIST FILES works, the Admin Server process has stopped and you can use the fmsadmin RESTART ADMINSERVER command to restart it. If LIST FILES does not work, use the Services control panel (Windows) or the launchctl command (Mac) to stop and restart FileMaker Server. For more information, see Starting or stopping the FileMaker Server service (Windows) or Starting or stopping FileMaker Server background processes (Mac OS).

Related topics

Troubleshooting
General problems

Note The following information is for server administrators.

FileMaker Server is sending too many email messages
You have many, frequently-run scheduled tasks with email notifications enabled. Try disabling email notifications or remove email addresses for some scheduled tasks. Also, see Receiving email notifications only when a schedule fails.

None of the scheduled tasks are running
FileMaker Server has been configured not to allow any schedules to run. To allow FileMaker Server to run enabled schedules, click Schedules and select Allow schedules to run.

The path for my additional database folder or backup database folder is not valid
Check the ownership and permissions of the folder. When you click Validate in the Database Server > Default Folders tab or the Schedule assistant, Admin Console may fail to validate a folder path because the folder does not have the correct permissions. Check that the folder is owned by the user fmserver (or in the group fmsadmin) and has read and write permissions. The backup folder cannot be a parent or a subfolder of the default database folder, the additional database folder, or the Scripts folder. The additional database folder cannot be a parent or a subfolder of the default database folder, the backup folder, or the Scripts folder. See Default folder settings and Tips for valid folders.

Related topics
Troubleshooting
Network problems

**Note** The following information is for server administrators.

### A FileMaker Pro client using TCP/IP can't find FileMaker Server databases on the network

Verify that TCP/IP networking software is properly configured on the host and client computers. Verify that the simultaneous client limit you specified has not been reached.

FileMaker Pro databases shared via TCP/IP can be opened remotely using the list of local hosts, the IP address of the host machine, or the DNS name of the host machine if one has been defined. For example, a database hosted from a computer with an IP address of 192.168.10.0, and a DNS name of host.domain.com can be opened by entering either the IP address or the DNS name in the File menu > Open Remote > Network File Path field, using the format fmnet:192.168.10.0/<filename>. (Note that fmnet:/ uses a single slash.)

**Note** FileMaker Pro also supports IPv6 addresses in the form of eight four-digit number groups, separated by colons and surrounded by square brackets. For example, fmnet:[2001:0DB8:85A3:08D3:1319:8A2E:0370:7334]/<filename>

If no client computers can see FileMaker Server in the Open Remote File dialog box, check the server network connection, and make sure the FileMaker Server ports are open on any firewall.

### Cannot start Admin Console from a remote machine

If the master machine has a firewall enabled, then you must open the ports required by FileMaker Server to communicate with users and administrators. See Ports used by FileMaker Server.

Each shortcut starts Admin Console for a specific FileMaker Server deployment. If the IP address of the master machine has changed, you must remove the shortcut and start Admin Console from the FileMaker Server Admin Console page again. See Starting Admin Console.

### Clients cannot see databases hosted by FileMaker Server

The firewall settings on the master machine may be blocking the display of databases to clients. See Ports used by FileMaker Server for more information on which ports need to be unblocked in firewalls.

**Related topics**

- FileMaker Server event log messages
- Troubleshooting
Troubleshooting Problems on client computers

Note The following information is for server administrators.

Admin Console Start Page says to install Java when it’s already installed
Internet Explorer may be configured to prevent add-ons from running. Click the Information Bar at the top of the browser window and allow Internet Explorer to run the Java Web Start ActiveX Control add-on. FileMaker Server uses this add-on to detect whether the required version of Java is installed. After you allow this add-on to run, click Start Admin Console.

The FileMaker Server name does not appear in the FileMaker Pro Open Remote File dialog box

- Windows: Verify that the FileMaker Server service is started in the Services (Local) node.
- You may need to specify the host IP address of the computer running FileMaker Server. In the Open Remote File dialog box, type: fmnet://[IP address].

Clients cannot see databases hosted by FileMaker Server
The firewall settings on the FileMaker Server machine may be blocking the display of databases to clients. See Ports used by FileMaker Server for more information on which ports need to be unblocked in firewalls.

Clients receive “Communication with the host was interrupted and could not be re-established” message on client computer
FileMaker Server disconnected a client from a database because the client didn't comply with a request from FileMaker Server to close a database. Communication between the host and client may have been disrupted because of a hardware failure (lost network connection) or a software connection time-out (no response from client for a given period of time). The latter could be caused by a screen saver or processor-intensive operation.

Clients receive “servername is no longer available or the host capacity has been exceeded” message on client computer
FileMaker Server has shut down or you reached the maximum allowable connections or clients on FileMaker Server. Verify that FileMaker Server is running or increase the number of clients allowed in the Database Server > FileMaker Pro Clients tab.

Clients receive “Host capacity exceeded” message on client computer
You reached the maximum allowable connections or clients on FileMaker Server. Increase the number of clients allowed in the Database Server > FileMaker Pro Clients tab.

Clients receive “This action cannot be performed because the file is not modifiable” message on client computer (FileMaker Pro databases hosted by FileMaker Server on Mac OS)
Clients can't modify the database file because the database file permissions are incorrectly set. The operating-system-level group fmsadmin must own the database file and have read and write access permissions. The Event.log will report “Opened database [filename] read only”. (If the database file is not owned by the group fmsadmin, FileMaker Server will not recognize the database file and there will be no entry in the Event.log.)
Related topics
FileMaker Server event log messages
Configuring Database Server settings
Improving performance
Users, groups, and permissions (Mac OS)
Troubleshooting
FileMaker Server event log messages

Note The following information is for server administrators.

The following is an alphabetical list and explanation of some of the log file messages you might see in the Event.log or in the Windows Event Viewer. Variables returned by FileMaker Server or the operating system, such as the name of the destination or file, are in [brackets].

Another copy of FileMaker Server ([servername]) is already running with this license key. This copy of FileMaker Server will not open any databases, but will allow updating the license key in the Admin Console.

Two FileMaker Servers cannot use the same license key. Enter a unique license key on the General Settings > Server Information tab.

Bonjour service is either not installed or not running. FileMaker Server will not be visible to FileMaker Pro clients.

This message can occur on Windows only. The Bonjour service is not installed or not running when FileMaker Server starts. The result is that FileMaker Server does not appear in the Local Hosts list in the Open Remote dialog box of FileMaker Pro clients. However, users can still connect to FileMaker Server by specifying an IP address or hostname in the Open Remote dialog box.

To fix this problem, start Bonjour from the Services control panel before starting FileMaker Server.

Client [client name 1] denied access because the license key is already in use by client [client name 2].

Two clients cannot use the same license key. [Client name 2] must enter a unique license key in FileMaker Pro.

Client [client name] no longer responding; connection closed. ([error number])

A connected client's computer has stopped communicating with FileMaker Server due to a network disruption or a software error.

Closing database [filename] due to serious error. ([error number])

The specified file is being closed by FileMaker Server due to an error condition. The file may need to be recovered in an earlier version of FileMaker Pro. See FileMaker Pro Help for information about recovering damaged files.

Database cache size: [x] MB.

The specified amount (x) of memory is usable for the database cache. This message is logged when FileMaker Server starts. You can adjust application memory by changing the RAM reserved for database cache in the Database Server > Databases tab. The new cache size takes effect immediately.
**Database [filename] consistency check skipped by administrator, database opened. Use of this database could result in data corruption.**

Administrator omitted the file consistency check via the Open a database action in the Databases pane. See Opening hosted files.

**Database [filename] could not be opened. Database may be damaged; use the Recover command in FileMaker Pro 11.**

The specified file failed the consistency check. Try opening the file in FileMaker Pro: start the FileMaker Pro application, open the file, and follow any instructions on your screen. (See FileMaker Pro Help for more information about recovering files.) Then try opening the file with FileMaker Server.

**Database [filename] could not be opened in its current state: open it in FileMaker Pro first.**

The database might be in an older format (databases need to be in FileMaker Pro 7 (.fp7) format before you can host them using FileMaker Server 11). For information about converting files, see FileMaker Pro Help.

**Database [filename] is being opened for the first time in FileMaker 11, performing consistency check.**

Since the specified file was created in FileMaker Pro 7 and has not been previously opened in a FileMaker 8 or later product, FileMaker Server performs a file consistency check.

**Database or temporary file [filename] is damaged and has been closed. ([error number])**

The database or its associated temporary file is damaged. Try opening the file in FileMaker Pro: start the FileMaker Pro application, open the file, and follow any instructions on your screen. (See FileMaker Pro Help for more information about recovering files.) Then try opening the file with FileMaker Server.

**Database [filename] was not closed properly, performing consistency check.**

The specified file was in use when FileMaker Pro or FileMaker Server shut down abnormally; therefore, FileMaker Server performs a file consistency check to examine the file's blocks.

**Database or temporary file [filename] low disk space, only [number] KB free! Searched temporary files and freed [number] KB.**

The disk containing the hosted database or the temporary files is getting low on free space. FileMaker Server attempted to increase space by deleting temporary files. Use your operating system tools to increase the free space on the disk so the database files can expand. If the free space gets too low, FileMaker Server reports an error and does not allow changes to the databases.

**Deleted backup folder [foldername].**

The specified maximum number of backups to keep was exceeded and the Database Server deleted the oldest backup folder.
Deleting backup folder(s) to free [x] KB of disk space needed for new backup.
The Database Server detected that there is not enough free disk space to make a complete
copy of the databases that are part of the backup. If the Database Server can free up enough
space to make a new backup by deleting old backups, it logs this message.

Email notification to administrators failed: [reason]
Email notification to administrators failed because of the specified reason.

Error occurred while deleting backup folder [foldername], some files or
folders could not be deleted. ([error number])
Some other process is using files in the specified backup folder or using the backup folder or
subfolders. For example, another program is copying the backups to offline storage, or you
opened a command line window on Windows, changed the path to the backup folder, and left
the window open.

Error occurred while renaming backup folder [foldername], some files or
folders could not be renamed. ([error number])
Some other process is using files in the specified backup folder or using the backup folder or
subfolders. For example, you opened a command line window on Windows, changed the path
to the backup folder, and left the window open.

FileMaker Server is going to sleep. The entire cache will be flushed. All
schedules will be suspended.
If the server computer is configured to sleep during periods of inactivity, before doing so the
operating system prompts each open service or application to find out if the service or
application can accommodate energy-saving mode. If any clients are currently connected to a
hosted database, FileMaker Server denies the sleep request and the server computer does not
sleep. If no clients are connected, FileMaker Server writes any unsaved changes to disk
flushes the cache) and allows the server computer to sleep. During sleep, all scheduled tasks
are suspended and do not run again until the next scheduled time when the server computer is
awake.

FileMaker Server is now awake. All schedules will now be resumed.
This message is sent to the log by FileMaker Server when the server computer wakes up from
sleep mode. During sleep, all scheduled tasks are suspended and do not run until the next
scheduled time when the server computer is awake.

FileMaker Server license information is invalid or missing. FileMaker Server
will not open any databases, but will allow updating the license key in the
Admin Console.
Enter a valid license key on the General Settings > Server Information tab.

FileMaker Server quitting! An unrecoverable error occurred. ([error number])
FileMaker Server detects a severe error during network use, due to a network failure or other
causes. Check network installation, settings, and the system error log.
FileMaker Server trial license has expired. This copy of FileMaker Server will not open any databases, but will allow updating the license key in the Admin Console.

Enter a valid license key on the General Settings > Server Information tab.

Opening database [filename] with consistency check...

FileMaker Server is opening a database and performing a consistency check because a Verify Database schedule is running or you manually ran the Verify or Verify All command.

Registration with directory service failed. ([error number])

Registration with the directory service failed because the error number reported is an LDAP error from the LDAP server.

Renamed backup folder [foldername] to [foldername].

You renamed a backup schedule in Admin Console and the Database Server renamed the existing backup folders for that schedule.

Schedule [schedule name] aborted; [destination] could not be found.

The specified destination could not be found. If the destination is a removable medium, make sure it is inserted in its drive. If the destination is an external or network drive, connect the drive or network. Try again after the destination volume drive is correctly set up.

Schedule [schedule name] aborted; no open databases to operate on.

The schedule specifies a folder in which FileMaker Server currently has no databases open. Therefore, the scheduled task can’t proceed. Make sure that the schedule specifies the correct folder to operate on and that all databases have been opened correctly.

Schedule [schedule name] aborted; the destination [destination] is not writable.

The specified destination is not accessible, and the schedule is now disabled. If the destination is a removable medium, you might need to remove it from the drive, make it writable, and reinsert it. Try again after the destination is correctly set up.

Schedule [schedule name] aborted; system script [script name] returned non-zero status [integer].

The specified schedule aborted because the system script returned the specified non-zero status.

Schedule [schedule name] has exceeded its time limit.

The specified schedule has exceeded its time limit.

Schedule [schedule name] aborted; time limit exceeded.

The specified schedule aborted because the script sequence exceeded its time limit.
Schedule [schedule name] has started FileMaker script [script name].
   The specified schedule has started to run the specified FileMaker script.

Schedule [schedule name] has started system script [script name] with process ID [ID number].
   The specified schedule has started the specified system script with the specified process ID number.

Related topics
Network problems
Problems on client computers
Viewing activities in the Event Viewer (Windows)
Troubleshooting
Command line error messages

Note The following information is for server administrators.

The following is a list of the error codes you might see when working with the command line interface, and a brief description of each code. For additional information, consult the Event log or see Troubleshooting.

10001 Invalid parameter
10502 Host was unreachable
    Make sure the server is available.
10504 Cannot disconnect administrator
    The client you’re trying to disconnect is an administrator, which must always remain connected.
10600 Schedule is missing
10604 Cannot enable schedule
10606 Invalid backup destination for schedule
10801 Locale was not found
10900 Engine is offline
10901 Too many files are open
10902 File is not open
10903 File by the same name is already open
10904 File for this operation was not found
11000 User specified an invalid command
11001 User specified invalid options
11002 Command is invalid as formatted
11005 Client does not exist
20302 Unknown Universal Path Type
20400 File operation canceled
20401 End of file
20402 No permission
20404 File is not open
20405 File not found
20406 File exists
20407 File already open
20500 Directory not found
20600 Network initialization error

For other error codes, see Customer support and Knowledge Base.

Related topics
Command line reference
Improving performance

**Note** The following information is for server administrators.

For best performance, FileMaker Server should be run on a dedicated machine reserved for use as a database server. When FileMaker Server is hosting many clients or a large number of database files, it uses a high level of processor, hard disk, and network capacity. Other processor-intensive software or heavy network traffic on the same machine will cause FileMaker Server to run more slowly and degrade the performance of FileMaker Pro on client machines.

- Avoid installing FileMaker Server on a machine that is a user’s primary workstation or network file server.
- You cannot run two different versions of FileMaker Server on the same machine at the same time.
- Avoid using the machine running FileMaker Server as an email, print, or file server.
- Do not use system backup software to back up databases hosted by FileMaker Server. Instead use the FileMaker Server Admin Console to schedule backups of databases.
- Do not use anti-virus software to scan the folders that contain hosted database files.
- Disable screen savers and sleep (or hibernate and standby) mode on the server. These OS features reduce performance or suspend access to hosted databases.
- Use a fast hard disk, multiple-disk RAID system, or reliable Storage Area Network (SAN) for the hosted databases.
- The Database Server creates temporary files in a temporary directory on the master machine to cache data for hosted files. The Database Server creates one temporary file for each open hosted file, and automatically closes and deletes the temporary file when the associated hosted file is closed. Make sure there is enough free disk space on the master machine to store the temporary files. In most cases, the size of the temporary file is 10-20% of the size of the associated hosted file, but the actual percentage depends on the number of clients and server-side scripts and their activity level. The Database Server periodically checks the temporary file size and will shrink a temporary file if it grows too large compared to the amount of free disk space.
- Turn off file indexing (on Windows, Indexing Service; on Mac OS, Spotlight; or on any other third party file indexing software). This feature reduces performance.
- If you have a large number of FileMaker Pro and Web Publishing clients, consider switching to a multiple-machine deployment.

**Note** Because some DHCP servers cycle IP addresses, FileMaker recommends using a static IP address.

**Related topics**

Troubleshooting
Checking for updates

*Note* The following information is for server administrators and group administrators.

From the Start Page, you can check for updates to FileMaker Server software. In the Software Update section, click *Check Now*. If an update is available, you can click a link to download the update.

For information on enabling or disabling this feature, see Admin Console settings.
About the license key

**Note** The following information is for [server administrators](#).

FileMaker software comes with a unique, 35-character license key. Do not lose this license key. We recommend that you keep the license key in a safe place in case the software ever needs to be reinstalled.

You can find your license key(s) on the back of the CD sleeve. If you paid for your software electronically, you received an email with a link to a PDF file with your license key.

The license key ensures adherence to the single user license agreement, which generally allows for use of one (1) copy of the Software on a single machine or a single multi-machine [deployment](#) at a time (refer to your Software License). If the license key is invalid or if another copy of the software installed with that same license key is running on the network, the FileMaker Server software displays an error message and does not start.

You can choose to deploy FileMaker Server components across multiple machines that work together to form a single FileMaker Server deployment. You must have a unique license key for each multiple-machine deployment, or obtain a volume license for more than one deployment. You must license one copy of FileMaker Server for each deployment.

**Changing the FileMaker Server license**

If you want to upgrade your license from a trial version of FileMaker Server 11 or from FileMaker Server 11 to FileMaker Server 11 Advanced on the same machine, you must change your FileMaker Server license key.

To change the FileMaker Server license of an existing deployment, see [Server information settings](#).

To move your FileMaker Server 11 deployment to a new machine or to upgrade from an earlier version of FileMaker Server, see [FILEMAKER SERVER GETTING STARTED GUIDE](#) on the [Start Page](#).
Command line reference

Note The following information is for server administrators.
FileMaker provides the tool fmsadmin for administering FileMaker Server via the command line interface (CLI). You must be logged on to the computer running FileMaker Server to use the CLI.

Note The CLI is available via the command prompt (Windows) and the Terminal application (Mac OS).

Command Line Interface files

The CLI executable fmsadmin is located in the folder:

- Windows (32-bit): \[drive\]:\Program Files\FileMaker\FileMaker Server\Database Server\fmsadmin.exe
- Windows (64-bit): \[drive\]:\Program Files (x86)\FileMaker\FileMaker Server\Database Server\fmsadmin.exe
- Mac OS: /Library/FileMaker Server/Database Server/bin/fmsadmin

Notes

- On Mac OS, the following symbolic link to fmsadmin is also installed: /usr/bin/fmsadmin
- (Windows only) If FileMaker Server is installed in a non-default location, the beginning portion of the default path shown above, \Program Files\FileMaker\FileMaker Server (Windows 32-bit) or \Program Files (x86)\FileMaker\FileMaker Server (Windows 64-bit), is replaced with the path that was specified during installation. For example: \\
- My_Path\Database Server\

Commands

The general format for fmsadmin commands is:

fmsadmin command [options]

The following example authenticates with Admin Console user name admin and the password pword and closes all open databases without prompting you to confirm:

fmsadmin close -y -u admin -p pword

Important CLI commands can include the Admin Console name and password. If a command is used interactively, the user name is visible but the password is not. If a command in a script or batch file must include a name and password, be sure that only the password owner can view the script or batch file.

In the CLI, use the fmsadmin help command to see Help pages on other commands. For FileMaker Server online Help on specific commands, see fmsadmin commands.

Options

Options pass switches and parameters to fmsadmin. Type fmsadmin help options to see the list. You can specify options in a short or a long format, for example: -h or --help. You can use the following options with all commands.
Options for specific commands

<table>
<thead>
<tr>
<th>Use</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-d path, --dest path</code></td>
<td>Specify a destination path.</td>
</tr>
<tr>
<td><code>-f</code> <code>--force</code></td>
<td>Force close a database or shut down the server.</td>
</tr>
<tr>
<td><code>-m message, --message message</code></td>
<td>Specify a text message to be sent to clients.</td>
</tr>
<tr>
<td><code>-n</code>, <code>--clone</code></td>
<td>Clone backup file</td>
</tr>
<tr>
<td><code>-o</code>, <code>--offline</code></td>
<td>Perform an offline backup.</td>
</tr>
<tr>
<td><code>-s</code>, <code>--stats</code></td>
<td>Return file or client statistics.</td>
</tr>
<tr>
<td><code>-t seconds, --gracetime seconds</code></td>
<td>Specify time in seconds before client is forced to quit.</td>
</tr>
<tr>
<td><code>-x</code>, <code>--verify</code></td>
<td>Verify integrity of backup file</td>
</tr>
</tbody>
</table>

- To specify the short form of options, use a single hyphen (-). You can specify multiple options together. If an option requires a parameter, that option is usually the last option that you specify. For example,
  
  `fmsadmin close -ym 'Closing for maintenance' Database.fp7`

- To specify the long form of options, use double hyphens (--). Long options can be used in scripts to increase readability. You must specify each option separately, preceded by two hyphens. A space is required between the option and any parameters, for example,
  
  `fmsadmin close --yes --message "Closing for maintenance" Database.fp7`

Parameters

- Enclose any parameters that contain spaces in single or double quotation marks.
  
  Tip For computer and filenames, use names consisting of standard ASCII characters without spaces.

- You can specify file IDs instead of filenames. Use `fmsadmin list files -s` to return file IDs and other statistics. File IDs are dynamically generated.

- Symbols that may be interpreted by the shell must be escaped, that is, preceded by a backslash character (\). Refer to the documentation for your shell or command interpreter.

- Example: the following command does not prompt for confirmation (`-y`), allows clients 5 minutes to close the file (`-t300`), and sends a message (`-m`). The command operates on file IDs 20 and 22 and the folder “Solution”.

fmsadmin close -y -t300 -m "Closing for maintenance" 20 22 "filemac:/Library/FileMaker Server/Data/Databases/Solution/"

**Scripting language**

If you use a scripting language that allows execution of shell or Terminal commands, you can script many tasks with `fmsadmin`. On Mac OS, you can use tools such as `cron` or `launchd` to schedule execution of `fmsadmin` commands like `run schedule` or `backup`. On Windows, you can use the Scheduled Task Wizard to schedule scripted tasks.

**Administrator authentication**

FileMaker Server challenges the CLI for authentication if you have not enabled `Use external group` on the General Settings > Admin Console tab. If you have enabled `Use external group` and you are currently logged in to the machine as a member of the external group, FileMaker Server does not challenge the CLI for authentication.

FileMaker Server logs all administrator connections, both successful or failed.

**Related topics**

[Command line error messages](#)
**fmsadmin commands**

*Note* The following information is for server administrators.

The fmsadmin command line interface (CLI) commands are listed below. Type: fmsadmin help commands to see the list. Click a link for more information.

<table>
<thead>
<tr>
<th>Use</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTORESTART command</td>
<td>Get or set auto-restart for the Admin Server</td>
</tr>
<tr>
<td>BACKUP command</td>
<td>Back up databases</td>
</tr>
<tr>
<td>CLOSE command</td>
<td>Close databases</td>
</tr>
<tr>
<td>DISABLE command</td>
<td>Disable schedules</td>
</tr>
<tr>
<td>DISCONNECT command</td>
<td>Disconnect a client</td>
</tr>
<tr>
<td>ENABLE command</td>
<td>Enable schedules</td>
</tr>
<tr>
<td>HELP command</td>
<td>Get help pages for fmsadmin commands</td>
</tr>
<tr>
<td>LIST command</td>
<td>List clients, files, plug-ins, or schedules</td>
</tr>
<tr>
<td>OPEN command</td>
<td>Open databases</td>
</tr>
<tr>
<td>PAUSE command</td>
<td>Temporarily stop database access</td>
</tr>
<tr>
<td>REMOVE command</td>
<td>Remove databases from hosting</td>
</tr>
<tr>
<td>RESTART command</td>
<td>Restart the Database Server or Admin Server</td>
</tr>
<tr>
<td>RESUME command</td>
<td>Make databases available</td>
</tr>
<tr>
<td>RUN command</td>
<td>Run a schedule</td>
</tr>
<tr>
<td>SEND command</td>
<td>Send a message</td>
</tr>
<tr>
<td>START command</td>
<td>Start the Database Server or Admin Server</td>
</tr>
<tr>
<td>STATUS command</td>
<td>Get status of clients or files</td>
</tr>
<tr>
<td>STOP command</td>
<td>Stop the Database Server or Admin Server</td>
</tr>
<tr>
<td>VERIFY command</td>
<td>Close and verify databases</td>
</tr>
</tbody>
</table>

Related topics
- Command line error messages
- Command line reference
AUTORESTART command

**Format**

    fmsadmin AUTORESTART ADMINSERVER [FLAG]

**Description**

Enables or disables auto-restart for the Admin Server if a valid FLAG is specified. If you don’t specify a FLAG, the current auto-restart setting is displayed.

**Valid Flags**

- **ON**: Turn on auto-restart.
- **OFF**: Turn off auto-restart.

The FileMaker Server service (Windows) or the fmserver_helperd daemon (Mac OS) starts and monitors the Admin Server process. If you turn ON auto-restart, FileMaker Server will automatically restart the Admin Server process whenever it has stopped or is not responding for more than sixty seconds.

If you stop the Admin Server process by using the fmsadmin STOP ADMINSERVER command, FileMaker Server stops monitoring the process, but the auto-restart setting is not changed.

The default setting for auto-restart is ON. The auto-restart OFF setting is not persistent; whenever the FileMaker Server service or fmserver_helperd daemon starts, auto-restart is automatically turned ON.

This command works only if the FileMaker Server service (Windows) or fmserver_helperd daemon (Mac OS) is running.

**Options**

None.

**Related topics**

- [RESTART command](#)
- [START command](#)
- [STOP command](#)

[Command line reference](#)
BACKUP command

Format
fmsadmin BACKUP [FILE...] [PATH...] [options]

Description
Backs up the specified databases (FILE) or all the hosted databases in the specified paths (PATH).
By default, the BACKUP command performs a live backup of a hosted database, without interfering with client usage. Alternatively, first PAUSE the databases, then issue the BACKUP command, followed by a RESUME command to perform an offline backup. If you don’t specify a destination path, the databases are backed up to the default backup folder. If you don’t specify a database or folder to back up, all hosted databases are backed up.
Each time you use the BACKUP command, FileMaker Server creates a new subfolder within the default backup folder or the specified backup folder. The name of the new folder is the local server date and time when you use the BACKUP command.
You can use options to verify and clone your backup file after the backup has completed. A clone of a database contains all the field definitions, tables, layouts, scripts, and page setup options, but none of the record data.

Options
-d path, --dest path
  Overrides the default backup folder destination by backing up the databases to the specified path. If the path doesn't exist, FileMaker Server attempts to create it. The path to a folder must end with the slash (/) character. For example:
  Windows: filewin:/driveLetter:/folderName/
  Mac OS: filemac:/volumeName/folderName/
-n, --clone
  Clone each backup file after backup and optional verify are completed.
-x, --verify
  Verify integrity of each backup file.

Related topics
RUN command
Default folder settings
Command line reference
CLOSE command

Format

fmsadmin CLOSE [FILE...] [PATH...] [options]

Description

Closes the specified databases (FILE) or all the hosted databases in the specified folders (PATH). If no FILE or PATH is specified, closes all hosted databases.

Note  If you want to close a specific database, you must type a space between any options and the filename or file ID. For example,

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>fmsadmin close -y Database</td>
<td>Closes only the specified database.</td>
</tr>
<tr>
<td>fmsadmin close -y</td>
<td>Closes all hosted databases.</td>
</tr>
</tbody>
</table>

Options

-m message, --message message

Specifies a text message to be sent to the clients that are being disconnected.

-t seconds, --gracetime seconds

Specifies the total number of seconds to wait before forcing disconnection of clients. The default (and minimum) value is 120 seconds.

For example, if you type

fmsadmin close --gracetime 120

clients see a dialog box immediately and can click Close Now or Cancel. If the client does not click a button, the database closes in 30 seconds. If the client clicks Cancel, the dialog box will reappear 45 seconds before the specified time limit (120 seconds). If the client clicks Close Now at this point, the database closes immediately. If the client clicks Cancel again, the database closes after another 45 seconds.

-f, --force

Forces a database to be closed without a prompt for confirmation.

Related topics

DISCONNECT command
OPEN command
REMOVE command
STOP command
VERIFY command
Command line reference
DISABLE command

Format
fmsadmin DISABLE SCHEDULE [SCHEDULE_NUMBER]

Description
Disables a schedule. SCHEDULE_NUMBER is the ID of the schedule to disable. Use the LIST SCHEDULES command to obtain the ID number of each schedule.

Options
None.

Related topics
ENABLE command
LIST command
Command line reference
DISCONNECT command

Format
fmsadmin DISCONNECT CLIENT [CLIENT_NUMBER] [options]

Description
Disconnects the specified client. The CLIENT_NUMBER is the ID number of the client. Use the LIST CLIENTS command to obtain a list of clients and their ID numbers. If no CLIENT_NUMBER is specified, all clients are disconnected.

Option
-m message, --message message
   Specifies a text message to be sent to the client that is being disconnected.

Related topics
CLOSE command
LIST command
STOP command
Command line reference
ENABLE command

**Format**

fmsadmin ENABLE SCHEDULE [SCHEDULE_NUMBER]

**Description**

Enables a schedule. SCHEDULE_NUMBER is the ID of the schedule to enable. Use the LIST SCHEDULES command to obtain the ID numbers of each schedule.

**Options**

None.

**Related topics**

DISABLE command
LIST command
Command line reference
HELP command

Format
fmsadmin [options] HELP [COMMAND]

Description
Displays a help page for other fmsadmin commands.

- Type fmsadmin help for general information.
- Type fmsadmin help commands for a list of available commands.
- Type fmsadmin help [COMMAND] for help on a specific command.
- Type fmsadmin help options for a list of available options.

Related topics
Command line reference
LIST command

Format
fmsadmin LIST [TYPE] [options]

Description
Lists items of the specified TYPE.

Valid TYPES
CLIENTS: Lists the connected clients. The following example lists the currently connected users:
   fmsadmin list clients
FILES: Lists the hosted databases. The following example returns file IDs and other statistics for the currently open, hosted databases in the default folders:
   fmsadmin list files -s
PLUGINS: Lists Database Server calculation plug-ins. The following example lists all plug-ins:
   fmsadmin list plugins
SCHEDULES: Lists schedules. The following example lists all schedules:
   fmsadmin list schedules

Option
-s, --stats
   Displays statistical information about CLIENTS and FILES.

Related topics
Command line reference
OPEN command

Format
fmsadmin OPEN [FILE...] [PATH...]

Description
Opens databases in the default and additional database folders. Each FILE specified is opened, or all the databases in each folder (PATH) are opened. If no FILE or PATH is specified, all databases in the hosting area are opened.

To specify a database by its ID rather than its filename, first use the LIST FILES -s command to get a list of all currently open databases and their IDs:

    fmsadmin list files -s

After you have the database IDs, you can use the OPEN command and specify IDs of the databases to open.

For example, the following command opens database IDs 20 and 22 and databases in the folder "Solution":

    fmsadmin open 20 22 "filemac:/Library/FileMaker Server/Data/Databases/Solution/"

Options
None.

Related topics
CLOSE command
LIST command
Command line reference
PAUSE command

Format
fmsadmin PAUSE [FILE...] [PATH...]

Description
Pauses the specified databases (FILE) or all the hosted databases in the specified folders (PATH). If no FILE or PATH is specified, pauses all hosted databases.
After a database is paused, it is safe to copy or back up the database until a RESUME is performed.

Options
None.

Related topics
BACKUP command
RESUME command
Command line reference
REMOVE command

Format
fmsadmin REMOVE [FILE...] [PATH...]

Description
Removes a closed database from hosting by moving the database file into a Removed folder. Each specified database (FILE) is removed, and all databases in each PATH are removed. If no FILE or PATH is specified, all closed databases in the hosting area are removed. If a specified folder in PATH is empty, the folder will be removed.

Options
None.

Related topics
CLOSE command
Command line reference
**RESTART command**

**Format**

fmsadmin RESTART [TYPE]

**Description**

Restarts the server of the specified TYPE. This command stops the server TYPE and then starts it after a short delay.

This command works only if the FileMaker Server service (Windows) or the fmserver_helperd daemon (Mac OS) is running.

**Valid Types**

ADMINSERVER: Stops and then starts the Admin Server.
SERVER: Stops and then starts the Database Server.

**Options (applicable to SERVER only)**

- `-f`, `--force`
  
  Expedites shut down of the Database Server. All clients are immediately disconnected.

- `-m message`, `--message message`
  
  Specifies a text message to send to the connected clients.

- `-t seconds`, `--gracetime seconds`
  
  Specifies the total number of seconds to wait before forcing disconnection of clients. The default (and minimum) value is 120 seconds.

  For example, if you type
  
  fmsadmin stop --gracetime 120

  clients see a dialog box immediately and can click **Close Now** or **Cancel**. If the **client** does not click a button, the client is disconnected in 30 seconds. If the client clicks **Cancel**, the dialog box will reappear 45 seconds before the specified time limit (120 seconds). If the client clicks **Close Now** at this point, the client is disconnected immediately. If the client clicks **Cancel** again, the client is disconnected after another 45 seconds.

  The gracetime option is available only if the `--force` option is not used.

**Related topics**

[AUTORESTART command](#)
[START command](#)
[STOP command](#)
[Command line reference](#)
RESUME command

Format
fmsadmin RESUME [FILE...] [PATH...]

Description
Makes a database that has been paused available again. Resumes activity on the specified databases (FILE) or all the paused databases in the specified folders (PATH). If no FILE or PATH is specified, all paused files are resumed.

Options
None.

Related topics
BACKUP command
PAUSE command
Command line reference
RUN command

Format
fmsadmin RUN SCHEDULE [SCHEDULE_NUMBER]

Description
Manually runs a schedule specified by its SCHEDULE_NUMBER. To obtain a list of schedules and their ID numbers, use the LIST SCHEDULES command.

Options
None.

Related topics
LIST command
Command line reference
SEND command

Format
fmsadmin SEND [options] [CLIENT_NUMBER] [FILE...] [PATH...]

Description
Sends a text message to a client specified by CLIENT_NUMBER, to the clients connected to the specified databases (FILE), or to all clients connected to any database in the specified folders (PATH).

If no CLIENT_NUMBER, FILE, or PATH is specified, the message is sent to all connected clients. By default, parameters are expected to be FILES or PATHS.

To specify a CLIENT_NUMBER, you must use the -c option. For example:

    fmsadmin SEND -c 2 -m "This is a test message"

Options
-m message, --message message
    Specifies the text message to send.
-c, --client
    Specifies a CLIENT_NUMBER.

Related topics
LIST command
Command line reference
START command

Format
fmsadmin START [TYPE]

Description
Starts the server of specified TYPE. This command works only if the FileMaker Server service (Windows) or the fmserver_helperd daemon (Mac OS) is running.

Valid Types
ADMINSERVER: Starts the Admin Server.
SERVER: Starts the Database Server.

Options
None.

Related topics
AUTORESTART command
RESTART command
STOP command
Starting and stopping FileMaker Server
Command line reference
STATUS command

Format
fmsadmin STATUS [TYPE] [CLIENT_NUMBER] [FILE]

Description
Retrieves the status of the specified TYPE.

Valid TYPES
CLIENT: Retrieves the status of a client specified by CLIENT_NUMBER. For example:
    fmsadmin STATUS client 2

    Use the LIST CLIENTS command to obtain a list of clients and their ID numbers.

FILE: Retrieves the status of an open database specified by FILE. For example, to get the status of a database named “Database”:
    fmsadmin STATUS file Database

Options
None.

Related topics
LIST command
Command line reference
STOP command

Format
fmsadmin STOP [TYPE] [options]

Description
Stops the server of the specified TYPE.

Valid TYPES
ADMINSERVER: Stops the Admin Server.
SERVER: Stops the Database Server. By default, all clients are disconnected after two minutes.

Options (applicable to SERVER only)
-\f, --force
  Expedites shut down of the Database Server. All clients are immediately disconnected.
-m message, --message message
  Specifies a text message to send to the connected clients.
-t seconds, --gracetime seconds
  Specifies the total number of seconds to wait before forcing disconnection of clients. The default (and minimum) value is 120 seconds.

For example, if you type
  fmsadmin stop --gracetime 120
clients see a dialog box immediately and can click Close Now or Cancel. If the client does not click a button, the client is disconnected in 30 seconds. If the client clicks Cancel, the dialog box will reappear 45 seconds before the specified time limit (120 seconds). If the client clicks Close Now at this point, the client is disconnected immediately. If the client clicks Cancel again, the client is disconnected after another 45 seconds.

The gracetime option is available only if the \f-force option is not used.

Related topics
AUTORESTART command
CLOSE command
DISCONNECT command
LIST command
RESTART command
START command
Starting and stopping FileMaker Server
STOP command
Command line reference
**VERIFY command**

**Format**

```plaintext
fmsadmin VERIFY [FILE...] [PATH...] [options]
```

**Description**

Closes the specified databases (FILE), or all the hosted databases in the specified folders (PATH), then performs a consistency check when reopening them. Databases that fail the check are left closed. If no FILE or PATH is specified, closes and checks all hosted databases.

**Note** If you want to close and verify a specific file, you must type a space between any options and the filename or file ID. For example,

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>fmsadmin verify -y Database</td>
<td>Closes and verifies only the specified file.</td>
</tr>
<tr>
<td>fmsadmin verify -y</td>
<td>Closes and verifies all hosted files.</td>
</tr>
</tbody>
</table>

**Options**

- `m message, --message message`
  
  Specifies a text message to be sent to the clients that are being disconnected.

- `t seconds, --gracetime seconds`
  
  Specifies the total number of seconds to wait before forcing disconnection of clients. The default (and minimum) value is 120 seconds.

  For example, if you type
  ```plaintext
  fmsadmin verify --gracetime 120
  ```

  clients see a dialog box immediately and can click Close Now or Cancel. If the client does not click a button, the file closes in 30 seconds. If the client clicks Cancel, the dialog box will reappear 45 seconds before the specified time limit (120 seconds). If the client clicks Close Now at this point, the file closes immediately. If the client clicks Cancel again, the file closes after another 45 seconds.

- `f, --force`

  Forces a database to be closed without prompting clients.

**Related topics**

- [CLOSE command](#)
- [Command line reference](#)
Glossary

A

Access privileges
Permission to view and work with certain records, fields, layouts, value lists, and scripts and to perform selected activities in a file.

Account
A username and (usually) password that accesses a file with a defined level of privileges.

Active Directory
In Windows, the distributed directory service that is included with the Microsoft Windows 2000 and 2003 Server operating systems. Active Directory provides centralized, secure management of a network.

Admin Console
The application you use to configure and administer FileMaker Server, work with hosted databases, view details about connected clients, and track statistical information.

Admin Server
The FileMaker Server software component that manages the deployment of the other FileMaker Server components and displays Admin Console on client computers for configuring FileMaker Server.

Administrative tasks
Procedures performed regularly by the administrator to keep FileMaker Server running efficiently and insure data integrity in hosted databases. For example, running regularly scheduled database backups is a typical administrative task.

Administrator group
A group of hosted databases that a group administrator can manage, according to the privileges granted by the FileMaker server administrator to the group administrator.

API (Application Programming Interface)
A set of software application building blocks, such as classes, methods, data structures, variables, procedures, and functions.

AppleScript
Mac OS: A scripting language you can use to control functions of the Mac OS and of applications that support AppleScript (often called scriptable applications).

Assistants
Onscreen instructions that guide you step-by-step through a task.

Authentication
The process of checking the validity of an account and password (if one is defined) before assigning privileges and allowing access to a system or a database file.

B

Backup
A copy of a database file that can be used if the original is lost, damaged, or otherwise irretrievable.
Block
A string of data elements recorded or transmitted as an individual unit. A block is often the smallest unit of data a program reads from or writes to the hard disk.

Cache
An area of RAM reserved by a program to store frequently used data, providing faster access than if the data had to be read from the hard disk. A larger cache size increases FileMaker Server performance.

CLI
CLI is the command line interface. Using the FileMaker Server CLI, an administrator can enter `fmsadmin` commands to administer FileMaker Server.

Client
A user who opens a connection to a database hosted on FileMaker Server with FileMaker Pro, a web browser, or an ODBC/JDBC client application.

Client application
The application that requests data from a data source. Examples include FileMaker Pro, when it accesses a database hosted by FileMaker Server, and a spreadsheet, when it requests data using SQL via ODBC or JDBC.

ClientStats.log
A file that records statistical information about how FileMaker Server is performing with each FileMaker Pro client and Web Publishing Engine client.

Clone
A copy of a FileMaker Pro file that contains all the field definitions, tables, layouts, scripts, and page setup options, but none of the data.

Container field
A FileMaker Pro field that can store pictures, sounds, QuickTime movies, or files of any type.

Custom Web Publishing
A method of sharing FileMaker databases on the web using XML, XSLT, or PHP. You can create dynamic webpages that enable users to interact with databases hosted on FileMaker Server.

Database file
A collection of information in a file containing one or more tables pertaining to a subject, such as customers or invoices. (A large database can also comprise many database files.)

Database file compression
The process of removing empty fields or redundant or unnecessary data in database files to minimize the amount of disk space they require.

Database Server
The component of FileMaker Server that hosts databases. In a multiple-machine deployment, the machine running the Database Server is called the master machine. Database files are stored on the master machine’s hard disk.
Databases folder
On startup, FileMaker Server looks for databases to host in the default Databases folder, additional folder, and in subfolders one level down.

Data source
Data you want to access, for example, data in a FileMaker Pro database or in another database management system.

Data source name (DSN)
A data structure that contains the information about a specific database that an ODBC driver needs in order to connect to it.

Deployment
The process and result of installing and configuring FileMaker Server components on one or more machines. In a multiple-machine deployment, components are deployed across more than one machine and work together as a unit.

Directory service
Software with a client/server architecture that is used to store information about your organization. The primary function of a directory service is to centralize the storage of information and respond quickly to queries.

Distinguished name (DN)
Uniquely identifies an entry in a directory tree, using a series of comma-separated attributes. In a DN, the left-most component is the actual directory object, and the right-most value is the directory root.

Domain name
A name that identifies a computer on the internet.

Driver
The ODBC or JDBC driver translates SQL queries into commands that a DBMS can understand. It processes ODBC/JDBC calls, submits SQL requests to the data source, and returns the data back to the driver manager, which then routes it to the requesting application.

Event Viewer
Windows: An administrative tool that comes with the Windows operating system and displays events stored in various log files. FileMaker Server reports its events to the Application log, and these events can be viewed using Event Viewer.

Event.log
A file that records events that occur while the Database Server is running.

Extended privilege
FileMaker Pro data sharing permissions that determine if a privilege set allows users to access a hosted file using FileMaker Pro, use a database as an ODBC/JDBC data source, or access data published on the web.
**FileMaker Pro**
An application for creating and modifying database files. Clients use FileMaker Pro to access database files hosted by FileMaker Server.

**FileMaker Pro Advanced**
An application that enables database developers to build custom FileMaker solutions for use on the web or in workgroups, and to create royalty-free runtime applications and custom FileMaker plug-ins.

**FileMaker script**
One or more instructions (script steps) that you create in FileMaker Pro to automate repetitive or difficult tasks. FileMaker Server can run a FileMaker script in a Script schedule or Script Sequence schedule.

**Group administrator**
A FileMaker Server Advanced user who is delegated the authority to perform database administration tasks in Admin Console by the server administrator. The group administrator manages the databases associated with a specific administrator group and is not allowed access to the configuration sections of Admin Console. See [Server administrator](#).

**Hibernate**
Windows: A power conservation mode that saves energy on an idle system. If the computer running FileMaker Server hibernates, all client activity is suspended. Hibernation will not occur on the server machine if there are clients connected to hosted databases.

**Hosted database**
A file opened by FileMaker Server for clients to use on a computer network. One or more clients can access and change information simultaneously in hosted databases.

**IP (Internet Protocol) address**
A numerical value that uniquely identifies a computer on a network or on the Internet. FileMaker Server 11 supports IPv4 and IPv6 address formats.

**IWP (Instant Web Publishing)**
A method of sharing your FileMaker databases with other users via a web browser. Web clients are limited to the layouts that you provide and to the privilege sets assigned to their user accounts.

**JDBC**
A Java API that uses SQL statements to access data from, and exchange data with, many database management systems. The JDBC driver communicates between your Java applet and the FileMaker Pro or FileMaker Server Advanced data source.

**JDBC client driver**
A JAR (Java Archive) file that sends an SQL query to access data stored in a database and delivers the requested data to the client application.
Java Web Start
A technology that deploys applications to users by making the applications available from a standard web server. The user computer requires the Java Runtime Environment (JRE).

Lightweight Directory Access Protocol (LDAP)
This protocol, which runs over TCP/IP, makes it possible for system administrators to centrally manage users, groups, devices, and other data.

Machine roles
Each computer in a FileMaker Server deployment is assigned a machine role as either a master (only one) or a worker (one or two).

Master
The machine in a FileMaker Server deployment that runs the Database Server and manages all worker machines. The master communicates with the workers to handle database requests from users, configure the settings on all machines, and monitor the status and activity of all components.

Network protocol
A set of rules that governs how computers exchange messages on a network. Common protocols include TCP/IP, HTTP, and HTTPS.

ODBC
An API that uses SQL statements to access data from, and exchange data with, many database management systems. FileMaker Server Advanced can share data as a data source via ODBC. FileMaker Server can also interact with data from other applications (as an ODBC client application).

ODBC client driver
A DLL (Windows) or shared library (Mac OS) that sends an SQL query to access data stored in a data source and delivers the requested data to the client application.

Open Directory
Apple’s standards-based directory and network authentication services architecture for Mac OS X.

PHP (PHP: Hypertext Preprocessor)
An open-source programming language primarily used in server-side application software to create dynamic web pages. FileMaker Server lets you publish data from FileMaker Pro databases on customized web pages created with PHP.

Plug-in
Software that extends the capabilities of an application in a specific way.
Pre-processing script
A system-level script that runs before a FileMaker script in a Script Sequence scheduled task.

Post-processing script
A system-level script that runs after a FileMaker script in a Script Sequence scheduled task.

Privilege set
A defined set of permissions that determines a level of access to a database file.

Relationships graph
In FileMaker Pro, you can see the occurrences of tables both in the current file and from any external, related database files. In this relationships graph, you join tables and change relationships between fields in different tables.

Runtime solution file
A database file that has been created with FileMaker Pro Advanced software in which data can be added, deleted, and changed, but in which database fields and layouts cannot be altered.

Schedules
You can create schedules to back up hosted databases, run scripts, and send messages to clients.

Schedules and Groups settings file
The XML file that contains information required to create schedules and groups.

ScriptMaker
The term “ScriptMaker” has been changed to “FileMaker script” in FileMaker Server. See FileMaker script.

Script sequence
A scheduled task that combines a FileMaker script with an optional pre-processing system-level script and an optional post-processing system-level script.

Secure Sockets Layer (SSL)
A protocol to encrypt and authenticate communications on the Internet. Used by the HTTPS access method.

Server administrator
The server administrator is responsible for installing and configuring FileMaker Server as well as managing the FileMaker Pro databases and solutions that are hosted on FileMaker Server. The server administrator for FileMaker Server Advanced can also delegate database management tasks to the group administrator. See Group administrator.

Service
Windows: a process that runs in the background and performs functions to support other programs. FileMaker Server runs as a service in Windows.

Sleep
A feature of the operating system that saves energy on an inactive computer. If the computer running FileMaker Server sleeps, all client activity is suspended.
SMTP (Simple Mail Transfer Protocol)
A standard server-to-server protocol for transferring email messages. FileMaker Server uses this protocol to send email notifications.

SQL
A structured programming query language that controls and interacts with a DBMS.

Standby
Windows: A power conservation feature that saves energy on an idle system. If the computer running FileMaker Server enters Standby mode, all client activity is suspended. The server computer will not enter Standby mode if there are FileMaker Pro clients connected to hosted databases.

Stats.log
A file that records statistical information about how FileMaker Server is performing.

TCP/IP (Transmission Control Protocol/Internet Protocol)
The basic communication protocol that is the foundation of the Internet.

Toolbar
A collection of tools in Admin Console that execute frequently used commands.

U, V, W, X, Y, Z

Upload
To transfer data or files from one computer to a remote computer. For example, to use the Upload Database assistant to transfer a database file to FileMaker Server.

Web Publishing Core
A software component of the Web Publishing Engine that processes requests for data and converts data from the Database Server into XML.

Web Publishing Engine

Web server
The software responsible for responding to HTTP or HTTPS requests from users on the web. Required in a FileMaker Server deployment for publishing databases on the web.

Web Server Module

Worker
A machine in a FileMaker Server deployment that runs either the Web Publishing Engine or the web server. Workers are configured and monitored by the master.

XML
Instead of being a rigid file format, XML is a language for defining agreed-upon formats that groups can use for exchanging data. Many organizations and businesses use XML to transfer product information, transactions, inventory, and other business data.
**XSLT**

XSLT (XSL Transformations) is a subset of XSL (Extensible Stylesheet Language) that is used to transform, or change, the structure of an XML document into a different document format. For example, you can use an XSLT style sheet to transform an XML document into an HTML or TXT document.
Registration

Note The following information is for server administrators.

Please take the time to register your product by choosing Help menu > Register Now in FileMaker Server Admin Console. By registering your software, you may be eligible for upgrade offers and other customer services.

If you are using the FileMaker Server trial version, you must register your software prior to use.

For more information on registration, see “Registration and customer support” in FILEMAKER SERVER GETTING STARTED GUIDE on the Start Page.
Customer support and Knowledge Base

Note  The following information is for server administrators and group administrators.

For information about technical support and customer service, visit www.filemaker.com/intl.

To access resources on the FileMaker web site such as ready-made solutions and the FileMaker Knowledge Base, in FileMaker Server Admin Console choose Help menu > FileMaker on the Web.

For free online technical support, use the FileMaker Knowledge Base. It offers answers to frequently asked questions, tips, troubleshooting advice, and much more. Knowledge Base articles are available only in English.

www.filemaker.com/kb

If you do not have access to the web, please refer to the FileMaker Service Directory that comes with your software. North American customers can also call (800) 325-2747 to learn about the service options available.
Copyright information

FileMaker, Inc.
5201 Patrick Henry Drive Santa Clara, California 95054

FileMaker is a trademark of FileMaker, Inc. registered in the U.S. and other countries. The file folder logo is a trademark of FileMaker, Inc. All other trademarks are the property of their respective owners.

FileMaker documentation is copyrighted. You are not authorized to make additional copies or distribute this documentation without written permission from FileMaker. You may use this documentation solely with a valid licensed copy of FileMaker software.

All persons, companies, email addresses, and URLs listed in the examples are purely fictitious and any resemblance to existing persons, companies, email addresses, or URLs is purely coincidental. Credits are listed in the Acknowledgements documents provided with this software. Mention of third-party products and URLs is for informational purposes only and constitutes neither an endorsement nor a recommendation. FileMaker, Inc. assumes no responsibility with regard to the performance of these products.

For more information, visit our website at www.filemaker.com.
Help topics that do not appear in the table of contents (such as context-sensitive topics)
Setting up an administrator account

In this Deployment assistant step, set up the account that you’ll use to login to FileMaker Server Admin Console.

To set up an administrator account:

1. For User Name, enter the name that you want to login with.
2. For Password, enter the password that you want to login with.
   - You cannot leave Password empty.
3. Reenter your password in Confirm Password.
4. Click Next to go to the next step.
   - Click Cancel to exit the Deployment assistant.

Notes

• User Name is not case-sensitive.
• Password is case-sensitive.
• You can change the user name and password in Admin Console. You can also enable all members of a group to access Admin Console. See Admin Console settings.

Related topics

Deploying FileMaker Server
Naming FileMaker Server

In this Deployment assistant step, assign a name to your FileMaker Server deployment and optionally provide additional information.

To name your FileMaker Server deployment:

1. For **Server Name**, enter a name for your FileMaker Server deployment. FileMaker Pro users see this name when they use the Open Remote File dialog box.

2. For **Server Description**, enter an optional description of your FileMaker Server deployment. Administrators see this information on the Admin Console Start Page.

3. Under **Administrator Contact Information**, you can choose to enter contact information. This information appears on the Admin Console Start Page. You can also publish this information to a directory service. See Admin Console settings.

4. Click **Next** to go to the next step. Click **Back** to return to the previous step or **Cancel** to exit the Deployment assistant.

**Note** You can change this information in Admin Console. See Admin Console settings.

Related topics

Deploying FileMaker Server
Enabling sharing via ODBC and JDBC

In this Deployment assistant step, enable your server to be a data source via ODBC and JDBC, if you purchased a FileMaker Server Advanced license.

To enable sharing via ODBC and JDBC:

1. Click **Yes, enable ODBC/JDBC** to enable sharing or click **No, do not enable ODBC/JDBC** to disable.
2. Click **Next** to go to the next step. Click **Back** to return to the previous step or **Cancel** to exit the Deployment assistant.

Notes

- Enabling this feature allows clients to use FileMaker Server as a data source using ODBC and JDBC. For more information, see FILEMAKER ODBC AND JDBC GUIDE on the Start Page.
- This ODBC/JDBC data source feature is not needed to host FileMaker Pro databases that access an external SQL data source via ODBC. See Accessing external ODBC data sources.
- You can change this setting in Admin Console. See Enabling sharing via ODBC and JDBC.

Related topics

Deploying FileMaker Server
Enabling web publishing

In this Deployment assistant step, enable web publishing if you want to publish FileMaker databases to web users. You must enable this feature if you want to use FileMaker Server Custom Web Publishing or Instant Web Publishing. For more information, see Using Instant Web Publishing, Hosting XSLT websites, or Hosting PHP websites.

To enable web publishing:

1. Click Yes, enable Web Publishing to enable web publishing or click No, do not enable Web Publishing to disable.
2. Click Next to go to the next step.

Click Back to return to the previous step or Cancel to exit the Deployment assistant.

Notes

• To use web publishing, a supported web server must be installed and activated. For more information, see FILEMAKER SERVER GETTING STARTED GUIDE on the Start Page.

• You can change the web publishing technology settings in Admin Console. However, you must use the Deployment assistant to enable or disable web publishing as a whole (click Edit Server Deployment on the FileMaker Server Overview pane).

Related topics
Deploying FileMaker Server
Enabling technologies for web publishing
Enabling technologies for web publishing

In this Deployment assistant step, choose the technologies you want to use to publish your FileMaker databases on the web.

**To enable the technologies for web publishing:**

1. Select the web publishing technologies that you want to use.

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Enable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send HTTP requests along with XML query commands and parameters and retrieve FileMaker data as an XML document.</td>
<td>XML</td>
</tr>
<tr>
<td>Transform, filter, or format XML data in a FileMaker database using XSLT stylesheets for use in a web browser or in other applications.</td>
<td>XSLT</td>
</tr>
<tr>
<td>Quickly and easily publish FileMaker databases on the web that look and work much like they do in FileMaker Pro.</td>
<td>Instant Web Publishing&lt;br&gt;Requires a FileMaker Server Advanced license.</td>
</tr>
<tr>
<td>Access FileMaker data using the FileMaker API for PHP in PHP web applications.</td>
<td>PHP</td>
</tr>
</tbody>
</table>

2. If you enable PHP publishing, choose whether to install the FileMaker supplied version of PHP.

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Choose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install FileMaker supplied PHP and the FileMaker API for PHP</td>
<td>Yes, install the FileMaker supported version of PHP (PHP 5.2)&lt;br&gt;&lt;br&gt;If you already have PHP installed, it will be disabled.</td>
</tr>
<tr>
<td>Use your own installation of PHP</td>
<td>No, use my existing installation of the PHP engine&lt;br&gt;&lt;br&gt;FileMaker Server supports PHP versions 4.3.11, PHP 4.4.1, and PHP 5.x.&lt;br&gt;&lt;br&gt;You must manually install the FileMaker API for PHP. For instructions, see FILEMAKER SERVER CUSTOM WEB PUBLISHING WITH PHP on the Start Page.</td>
</tr>
</tbody>
</table>

3. Click **Next** to go to the next step.<br><br>Click **Back** to return to the previous step or **Cancel** to exit the Deployment assistant.

**Notes**

- You can change the web publishing technology settings in Admin Console. However, you must use the Deployment assistant to change the option to use the FileMaker supported PHP engine. See [Hosting PHP websites](https://www.filemaker.com/en/hosting-php-websites).
- If you use your own version of PHP, you must manually install the FileMaker API for PHP in order to use PHP publishing. See FILEMAKER SERVER CUSTOM WEB PUBLISHING WITH PHP for more information.
Related topics
Deploying FileMaker Server
Enabling web publishing
Changing a FileMaker Server deployment
Selecting a deployment type

In this Deployment assistant step, choose how to deploy FileMaker Server components. FileMaker Server includes three components: the Database Server, Web Publishing Engine, and Web Server components. With the Deployment assistant, you can choose to deploy these components on one, two, or three machines to meet your needs.

See [Which deployment type is right for me?](#) for more information.

To select a deployment type:

1. For Deployment Type, choose one of the following:

<table>
<thead>
<tr>
<th>Deployment type</th>
<th>Deployment details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Single Machine</strong></td>
<td>Master: all FileMaker Server components</td>
</tr>
</tbody>
</table>
| **Two Machines**      | Master: Database Server 
                        | Worker: Web Publishing Engine and web server |
| **Two Machines (Alternative)** | Master: Database Server 
                        | Worker: Web Publishing Engine 
                        | Worker: web server |
| **Three Machines**    | Master: Database Server 
                        | Worker: Web Publishing Engine 
                        | Worker: web server |

2. Click **Next** to go to the next step.

Click **Back** to return to the previous step or **Cancel** to exit the Deployment assistant.

Notes

- The master machine is always the machine that runs the Database Server.
- If you are deploying FileMaker Server components on more than one machine, install the software on the worker machines first and then the master machine to ensure a smoother deployment process.

Related topics

- [Deploying FileMaker Server](#)
- [Assigning worker machine roles](#)
Assigning worker machine roles

In this Deployment assistant step, unassigned worker machines on your local network are detected and presented with their IP addresses in the list beside each machine role. Assign a worker machine to each machine role (Web Publishing Engine or web server).

To assign a worker machine role:

1. In the Machines column beside the machine role that you want to assign, choose the IP address of an unassigned worker machine.
   
   If the address of a worker is not listed, click Rescan. Then check to see whether the worker is listed.

2. If a worker's IP address is still not listed, enter the address in IP Address and click Lookup.
   
   The IP address you entered is added to the Machines list if the machine can be contacted and is an available worker.

3. Click Next to go to the next step.
   
   Click Back to return to the previous step or Cancel to exit the Deployment assistant.

Notes

- You will not be able to see your worker machines if the necessary ports of your firewall are not open. See Ports used by FileMaker Server.

- If you are deploying FileMaker Server components on more than one machine, install the software on the worker machines first and then the master machine to ensure a smoother deployment process.

- If you cannot find the IP addresses for the worker machines on your network, see Ports used by FileMaker Server.

Related topics

Deploying FileMaker Server
Selecting a deployment type
Specifying a web server

In this Deployment assistant step, specify a web server to use for web publishing.

To specify the web server:

1. For Web server, select the web server you wish to use.
   If you want to configure the web server setting later, click Skip this step and configure later.
   Note If you skip this step, web publishing will not be available and you will have to use Edit Server Deployment to activate it later.
2. Click Next to go to the next step.
   Click Back to return to the previous step or Cancel to exit the Deployment assistant.

Notes

• If the Deployment assistant fails to detect the web server, check that you have installed and enabled the web server. Also check that the necessary firewall ports are open. Review the instructions provided in the FILEMAKER SERVER GETTING STARTED GUIDE on the Start Page.
• If you are deploying FileMaker Server components on more than one machine, install the software on the worker machines first and then on the master machine to ensure a smoother deployment process.
• If you cannot find the IP addresses for the web server on your network, see Web Server Test Failed.

Related topics
Deploying FileMaker Server
Web Server Test Failed

If the Deployment assistant cannot communicate with the web server that you specified, you can provide more information and try again.

**To change web server settings:**

1. In the Web Server Test Failed step in the Deployment assistant, specify the settings to use to communicate with the web server.

2. Click **Retry**.

3. Examine the Web Server Test Results:
   - If successful, the result is Web Server Test Passed.
   - If unsuccessful, the Deployment assistant could not communicate with the web server. This test can fail if your web server requires HTTPS or uses a port other than 80. You can re-enter this information and try to communicate with the web server again.

   Ensure that you can access the web server from the master machine — for example, using a web browser — and try these steps again.

   If still unsuccessful, then click **Skip this step and configure later**.

4. Click **Next** to go to the next step.

   Click **Back** to return to the previous step or **Cancel** to exit the Deployment assistant.

**Related topics**

- Deploying FileMaker Server
- Specifying a web server
Deployment summary

In this Deployment assistant step, review and confirm your deployment selections before FileMaker Server implements them.

To confirm your deployment:

• Click Finish if you are satisfied with your deployment details.
  
  The Deployment assistant deploys FileMaker Server according to your selections. This may take a few minutes.

• Otherwise, click Back to return to the previous step or Cancel to exit the Deployment assistant.

Notes

• If Admin Console doesn’t start after deployment on the master machine, try the following:
  
  • On the Start Page, click Click here to start Admin Console.
  
  • Open a web browser on the master machine and enter http://localhost:16000.

Related topics

Deploying FileMaker Server
Changing a FileMaker Server deployment
Users, groups, and permissions (Mac OS)

Note The following information is for server administrators and group administrators.

The Upload Database assistant automatically sets the correct ownership and permissions in Mac OS. This section describes what you must do only if you upload databases manually.

During installation, the fmserver user and the fmsadmin group are created. The fmsadmin group must have read and write access to the FileMaker Pro databases that FileMaker Server hosts. You need to change the group permission to allow members of the fmsadmin group to edit the databases.

By default, only the Mac OS X user account that installed FileMaker Server can:

- manually operate FileMaker Server from the command line
- add files to or remove files from the FileMaker Server folder
- access any of the FileMaker Pro databases stored within the FileMaker Server default database and backup folders

Note Any user with the correct login, however, can access the FileMaker Server Admin Console application.

To allow other user accounts to work with FileMaker Server and database files, you can add them to the fmsadmin group using the Mac OS X Server Admin Tools. You must be logged in with administrative privileges. For more information, see the documentation included with the Server Admin Tools.

You can also refer to the following procedures to add users using the Terminal application.

Important The following procedures are recommended only for advanced users who are familiar with the Terminal application. You must be logged in with administrative privileges.

To add a user to the fmsadmin group using the Terminal application:

1. Start the Terminal application (/Applications/Utilities/Terminal/).
2. Enter the following at the command line:
   
   sudo dseditgroup -o edit -a username -t user fmsadmin

   where username is the name of the existing user you wish to add to the fmsadmin group.

To change group permissions for database files hosted by FileMaker Server:

1. Place database files in the folder /FileMaker Server/Data/Databases/ or the optional additional database folder.
2. Start the Terminal application and use the cd command to set your path as needed.
3. Enter the following at the command line:
   
   chmod g+rw <filename>.fp7

   where filename is the name of the database

To change the group of a file or folder to the fmsadmin group:

1. Start the Terminal application and use the cd command to set your path as needed.
2. Enter the following at the command line:
   
   chgrp fmsadmin <filepath>
Example: chgrp fmsadmin dbfile.fp7

Related topics
Editing accounts and privilege sets
Uploading database files
Verifying databases are available to FileMaker Pro clients
Selecting databases to upload

**Note** The following information is for server administrators and group administrators.

**Important** Database files must be closed before you can upload them. Uploading a database file that is open in FileMaker Pro could result in data loss. If you have the databases open in FileMaker Pro, for each file choose File menu > Close.

1. Select the FileMaker Server folder where you want to place the database files.
   
   If you are a server administrator, you can upload database files to the default database folder or additional database folder (see Default folder settings). Alternatively, you can create subfolders in the default and additional database folders. Select the default or additional database folder then click Create Subfolder to create a new subfolder. Enter the new folder Name in the dialog box and click OK.
   
   If you are a group administrator, your server administrator specified the group folder where you can upload database files for your administrator group. If your server administrator specified the default database folder or the additional database folder as your group folder, then you can upload files to that folder or any subfolder and create subfolders. If your server administrator specified a subfolder of the default or additional database folder as a group folder, then you can upload databases to that subfolder only.

2. Click Add Database to open the select databases dialog.

3. Select one or more database files on your local file system that you want to upload and click Select.

   **Tip** Use Ctrl+click (Windows) or ⌘-click (Mac OS) to select multiple files.

   The Upload Database assistant lists the databases to be uploaded in the selected folder in bold type.

4. To remove a database from the list, select the database and click Remove.

   You can remove from the list only databases that have not been uploaded yet. Removing a database from the list does not delete or otherwise change the database file. You can also remove a subfolder in the same way.

5. Click Next to specify options to open the database.

   Click Cancel to exit the Upload Database assistant.

**Notes**

- If you are a group administrator, your server administrator must configure your administrator group to allow you to upload databases in your group folder. For more information, contact your server administrator.

- Folders that are not associated with an administrator group are indicated by the following folder icon in the Databases pane:

  ![Folder Icon](folder_icon.png)

- Folders that are associated with an administrator group or are parent folders of a group folder are indicated by the following group folder icon:

  ![Group Folder Icon](group_folder_icon.png)

   You can position your cursor over the group folder icon to display the name of the administrator group that is associated with the group folder.
• You can upload only files with a filename extension of .fp7 or with a filename extension of a registered runtime solution. You can't upload a folder or an application package (Mac OS), but you can select multiple files that are in the same folder and upload them at one time.

• You cannot overwrite a hosted file using the Upload Database assistant. To replace a hosted file with another file that has the same filename, you must close and remove the hosted file and then upload the new file.

• For information on how to remove databases that are already hosted, see Removing hosted files.

• Database files should be writable in Windows or Mac OS (and unlocked in Mac OS) before you upload them. You will see a warning message when you upload a read-only or locked file. See Windows Help or Mac OS Help for how to make read-only files writable and how to unlock files.

Related topics
Uploading database files
Specifying an upload option

Note The following information is for server administrators and group administrators.

1. You can optionally select **Automatically open the database after upload**.
   Select this option to open all files after the upload is complete. If you don't select this option, the uploaded databases remain closed. To open the files later, see Opening hosted files.

2. Click **Next** to begin the database upload.
   Click **Back** to return to the previous pane or **Cancel** to exit the Database Upload assistant.

Note The Upload Database assistant checks whether a database has some form of sharing enabled. If no sharing is enabled, the Database Server automatically enables sharing via FileMaker Network (extended privilege `fmapp`) for the Full Access privilege set.

Related topics

Uploading database files
Viewing the database upload status

**Note** The following information is for server administrators and group administrators. During the upload, you can view the progress. When the upload is complete, you can:

- Click **Next** when the database upload successfully completes.
- If the upload fails, click **Back** to return to a previous step to correct the problem.
- Click **Cancel** to exit the Upload Database assistant.

**Note** If you want to stop the upload, click **Cancel** next to the progress meter. The upload stops and FileMaker Server discards all files uploaded in this operation.

**Related topics**

*Uploading database files*
Reviewing the upload summary

**Note** The following information is for server administrators and group administrators.

Database files that have uploaded successfully are listed OK in the Status column. If there is an error, the Message column describes the problem uploading the associated database.

- Click **Finish** to exit the Upload Database assistant.
  
  Click **Back** to return to the previous pane.

**Note** An upload can fail because the database is open. If you have the database open in FileMaker Pro on your computer, choose File menu > **Close** and try to upload the database again.

**Related topics**

[Uploading database files](#)
Starting or stopping the FileMaker Server service (Windows)

**Note** The following information is for server administrators.

In some cases, you may need to start or stop all components of FileMaker Server on a machine. For example, after you restrict access to Admin Console (General Settings > Admin Console tab), you must restart all FileMaker Server components. You can restart all FileMaker Server components either by restarting the machine or by restarting the FileMaker Server service.

In Windows, FileMaker Server runs as a service named “FileMaker Server” that manages all FileMaker Server components on the machine. In a multiple-machine deployment, the FileMaker Server service runs on each machine.

Typically, the FileMaker Server service is automatically started when the machine is started. If you choose not to automatically start the FileMaker Server service during Windows startup or if you stopped the FileMaker Server service, you can start it again manually.

**To start or stop the FileMaker Server service:**

You must be logged in with administrator privileges on the machine where FileMaker Server is running.

1. Click **Start** button > **Control Panel** > **Administrative Tools**.
2. Double-click **Services**.
3. In the Services window, select **FileMaker Server** in the **Name** column.
4. Choose **Action** menu > **Start** to start the service or **Action** menu > **Stop** to stop the service.

**To start or stop the FileMaker Server service from the command prompt:**

- Open the Command Prompt window.

<table>
<thead>
<tr>
<th>To</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start FileMaker Server</td>
<td>net start &quot;FileMaker Server&quot;</td>
</tr>
<tr>
<td>Stop FileMaker Server</td>
<td>net stop &quot;FileMaker Server&quot;</td>
</tr>
</tbody>
</table>

Related topics

[Starting and stopping FileMaker Server](#)
Starting or stopping FileMaker Server background processes (Mac OS)

Note The following information is for server administrators.

In some cases, you may need to start or stop all components of FileMaker Server on a machine. For example, after you restrict access to Admin Console (General Settings > Admin Console tab), you must restart all FileMaker Server components. You can restart all FileMaker Server components either by restarting the machine or by restarting the FileMaker Server background processes.

In Mac OS, FileMaker Server runs as several background processes which start when FileMaker Server is installed. In a multiple-machine deployment, FileMaker Server processes run on each machine.

Typically, the FileMaker Server processes are automatically started when the machine is started. If you choose not to automatically start the FileMaker Server processes during Mac OS startup or if you stopped the processes, you can start them again manually.

To start or stop FileMaker Server manually:

You must be logged in to the machine where FileMaker Server is running.

• Open the Terminal application and enter the start or stop command:

<table>
<thead>
<tr>
<th>To</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start FileMaker Server</td>
<td>sudo launchctl start com.filemaker.fms</td>
</tr>
<tr>
<td>Stop FileMaker Server</td>
<td>sudo launchctl stop com.filemaker.fms</td>
</tr>
</tbody>
</table>

Note The sudo command requires you to authenticate.

Related topics
Starting and stopping FileMaker Server
Specifying directory service settings

In this Directory Service assistant step, specify the server settings.

1. For Directory Server Information, enter the following information:
   - **Address** (host name or **IP address**).
   - **Port** number for the **LDAP** connection.
     - If **Use Secure Sockets Layer (SSL)** is not enabled, the default port number is 389. If you enable **Use Secure Sockets Layer (SSL)**, the default port number automatically changes to 636.
   - **Entry Point**. The distinguished name that specifies the location of FileMaker Server in the **directory service**.
     - For example:
       - Windows: `ou=FileMaker,dc=mydomain,dc=filemaker,dc=com`
       - Mac OS: `cn=filemakerservers,dc=myservername,dc=mydomain,dc=com`
       - Spaces after commas are optional.
   - To encrypt the user names and passwords that FileMaker Server and FileMaker Pro clients use to log in to LDAP servers, select **Use Secure Sockets Layer (SSL)**.
     - **Important** If you select **Use Secure Sockets Layer (SSL)**, signed client and server root CA certificates issued by a trusted certificate authority (CA) are required. The client certificate must be installed on the FileMaker Server **master** machine and on FileMaker Pro computers that are using SSL to connect to an LDAP service. You cannot use self-signed certificates for a secure SSL connection to an LDAP server. For more information, see **Using SSL with an LDAP directory service**.

2. For **Login Information**, choose the **authentication** method for the directory service:
   - If the directory services requires a login, select **My directory service requires me to log on**, and enter the **Name** and **Password**.
   - If the user name and password you specified are defined in a Windows domain, enable **Use Windows authentication** to access Windows **Active Directory**.

3. Click **Test Directory Service Settings** to verify that FileMaker Server can communicate with the directory service.

4. Click **Next**.
   - Click **Cancel** to exit the Directory Service assistant.

For more information, see **FileMaker Pro client settings**.
Publishing directory server settings

In this Directory Service assistant step, choose the information you want to publish.

1. Select **Publish FileMaker Server** to publish the FileMaker Server name, host name, and **IP address** to the directory service.

2. Select **Publish administrator contact information** to publish the administrator’s contact information specified in the **General Settings > Server Information** tab.

3. Click **Finish** to update the directory service information in the **Database Server > FileMaker Pro Clients** tab. (Clicking **Save** in this tab is not required.)

   Click **Back** to return to the previous step or **Cancel** to exit the Directory Service assistant.

For more information, see [FileMaker Pro client settings](#).
About user details

**Note**  The following information is for server administrators and group administrators.

The User Details tab lists detailed information about the client connected to FileMaker Server.

<table>
<thead>
<tr>
<th>Detail</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Computer Name</strong></td>
<td>The client's computer name.</td>
</tr>
<tr>
<td><strong>MAC Address</strong></td>
<td>The MAC (Media Access Control) address for the computer network adapter that the client is using to connect to FileMaker Server.</td>
</tr>
<tr>
<td><strong>Operating System</strong></td>
<td>The name of the client computer operating system.</td>
</tr>
</tbody>
</table>
| **Client/Browser Version** | For FileMaker Pro clients, the version of FileMaker Pro that the client is using.  
For Instant Web Publishing, the name of the Web Browser that the client is using. |
| **Language**        | The language used by the client.                                                                                                           |

Related topics

[Administering databases](#)
About databases open details

**Note** The following information is for server administrators and group administrators.

The **Databases Open** tab lists detailed information about the client and the databases the client is currently using.

<table>
<thead>
<tr>
<th>Detail</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Name</td>
<td>The database that the client is using. If the client is connected to more than one database, the databases will be listed here.</td>
</tr>
<tr>
<td>Account Name</td>
<td>The account name used to log in to FileMaker Server.</td>
</tr>
<tr>
<td>Privilege Set</td>
<td>The FileMaker Pro privilege set used by the account to access the hosted database.</td>
</tr>
<tr>
<td>Connect Time</td>
<td>The date and time the client connected to the database.</td>
</tr>
</tbody>
</table>

**Related topics**

[Administering clients](#)
Viewing activities in the Event Viewer (Windows)

**Note** The following information is for server administrators.

To view information about FileMaker Server activities, you can use the Windows Event Viewer. To open Event Viewer, click **Start** menu > **Control Panels** > **Administrative Tools** > **Event Viewer**. Select the **Application** log.

In the **Source** column, look for events logged by FileMaker Server. Double-click an event to display details about it.

**Note** The Event Viewer messages are saved in the Event.log text file. If the Event.log file is unreadable, you can choose **Action** menu > **Export List** to save information displayed in the Event Viewer as a tab-delimited text file (.TXT) and then import the information into a FileMaker Pro database for further analysis.

**Related topics**
- Event log
- Viewing log file entries
Changing the language of the Event log

**Note** The following information is for server administrators.

If you prefer to use a different language in the Event log than the one used by your computer at the time you installed FileMaker Server, you can change the language of the Event.log by modifying a preferences file (Mac OS) or the registry (Windows) on the master machine.

In the steps below, you can change the locale setting to the name of one of the following supported languages exactly as shown here: English, French, German, Japanese, Italian, or Swedish. (Locale names are case-sensitive.)

**To change the language used for the Event.log (Mac OS):**

**Important** The following procedure is recommended only for advanced users who are familiar with the Terminal application. You must be logged in as the root user.

1. Start the Terminal application (/Applications/Utilities/Terminal/).
2. Stop the Database Server. For more information, see Starting and stopping FileMaker Server.
3. Log in as the root user.
4. Navigate to the .plist file in the following location:
   /Library/FileMaker Server/Library/Preferences/ByHost
5. In the line after `<key>System Locale</key>`, change the name of the locale to one of the values given above.
   For example, change `<string>Japanese</string>` to `<string>French</string>`.
6. Save your changes.
7. Restart the Database Server for the change to take effect.
   The next time you open Event.log, the entries will appear in the new language.

**To change the language used for the Event.log (Windows):**

**Important** The following procedure is recommended only for advanced users who are familiar with the Windows registry. You must be logged in with an account that has administrator privileges.

1. Stop the Database Server. For more information, see Starting and stopping FileMaker Server.
2. Start Registry Editor.
   Click Start button > Run. In the Run dialog box, enter regedit.
   **Tip** Use Registry Editor to export a copy of the registry before you continue.
3. In Registry Editor, find the following key:
   HKEY_LOCAL_MACHINE\SOFTWARE\FileMaker\FileMaker Server\11.0\Preferences
4. In this key, double-click the SystemLocale entry.
5. Change the value of the SystemLocale entry to one of the values given above, then click OK.
For example, change Japanese to French.

6. Exit Registry Editor.

7. Restart the Database Server for the change to take effect.
   The next time you open Event.log, the entries will appear in the new language.

Related topics
Event log
Viewing log file entries
Selecting a task

**Note** The following information is for server administrators and group administrators.

In this Schedule assistant step, select a task to perform.

**To select a task:**

1. Select one of the task options:

<table>
<thead>
<tr>
<th>Choose</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Back Up Databases</strong></td>
<td>Back up one or more hosted databases.</td>
</tr>
<tr>
<td><strong>Verify Databases</strong></td>
<td>Verify the integrity of one or more hosted databases.</td>
</tr>
<tr>
<td><strong>Run Script</strong></td>
<td>Run a FileMaker script or system-level script on FileMaker Server.</td>
</tr>
<tr>
<td><strong>Send Message</strong></td>
<td>Send a message to one or more FileMaker Pro users connected to a hosted database. The message appears in a dialog box within FileMaker Pro.</td>
</tr>
</tbody>
</table>

2. Click **Next**.

Click **Cancel** to exit the Schedule assistant.

**Note** If you are a group administrator, your server administrator must configure your administrator group to allow you to select each type of task to perform on the databases in your group folder. For more information, contact your server administrator.

**Related topics**

- Scheduling database backups
- Verifying the integrity of databases
- Running server-side scripts
- Sending scheduled messages to clients of hosted databases
- Scheduling administrative tasks
**Database backup schedule**

*Note* The following information is for server administrators and group administrators.

In this Schedule assistant step, choose a preset backup schedule or a custom schedule. You can choose a preset schedule as a starting point and change the details later in the Schedule assistant.

**To select a backup schedule:**

1. Select a preset or a custom backup schedule:

<table>
<thead>
<tr>
<th>Choose</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hourly</td>
<td>Back up all databases to the default backup folder daily, every hour from 8 am to 5 pm.</td>
</tr>
<tr>
<td>Daily</td>
<td>Back up all databases to the default backup folder once daily, starting at 11 pm.</td>
</tr>
<tr>
<td>Weekly</td>
<td>Back up all databases to the default backup folder once weekly, starting at 11 pm.</td>
</tr>
<tr>
<td>Custom</td>
<td>Create a custom backup schedule.</td>
</tr>
</tbody>
</table>

2. Click **Next**.

   Click **Back** to return to the previous step or **Cancel** to exit the Schedule assistant.

**Related topics**

- Scheduling database backups
- Default folder settings
- Scheduling administrative tasks
Selecting databases

**Note** The following information is for server administrators and group administrators.

In this Schedule assistant step, choose which databases to include in this scheduled task.

**To choose databases to include in this scheduled task:**

1. Choose the databases to include in this scheduled task:

<table>
<thead>
<tr>
<th>Choose</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>All Databases</strong></td>
<td>• (Server administrators) Include all databases in the default database folder and the additional database folder, including databases in subfolders. For information about the additional database folder, see Default folder settings.</td>
</tr>
<tr>
<td></td>
<td>• (Group administrators) Include all databases in the group folder for your administration group. If the group folder is the default or additional database folder, databases in subfolders are also included.</td>
</tr>
<tr>
<td><strong>Databases in Folder</strong></td>
<td>Include all databases in the selected folder. If the selected folder is the default or additional database folder, databases in subfolders are also included. See the following notes.</td>
</tr>
<tr>
<td><strong>Select a Database</strong></td>
<td>Include the selected database. Select only one database file.</td>
</tr>
</tbody>
</table>

2. Click **Next**.

Click **Back** to return to the previous step or **Cancel** to exit the Schedule assistant.

**Notes**

- If you are a group administrator and your server administrator did not select the default database folder or the additional database folder to be the group folder for your administrator group, the **Databases in Folder** option is not available. For more information, contact your server administrator.

- In previous versions of FileMaker Server, you could choose **Databases in Folder** in the Schedule assistant and select the default or additional database folder to create a schedule that operated only on databases in the default or additional database folder, excluding databases in subfolders. In this version, if the default or additional database folder is selected for **Databases in Folder**, databases in subfolders are now automatically included. If necessary, change any command-line scripts that are affected by this change.

**Related topics**

- Scheduling database backups
- Verifying the integrity of databases
- Scheduling administrative tasks
Selecting the backup folder and options

**Note** The following information is for server administrators and group administrators.

In this Schedule assistant step, be sure to specify a backup folder that is not the same as the default database folder or the optional additional database folder. Otherwise, your backed up files could accidentally be hosted when FileMaker Server starts up.

You can specify the maximum number of backup files to keep. You can also select options to verify the backed up files and save a clone of your backed up files. If your database becomes damaged, you can possibly import the data from the damaged database into a clone of the backed up database. For more information on recovering FileMaker Pro files, see FileMaker Pro Help.

**To select the backup folder and options:**

1. For **Backup Folder**, enter the path to the backup folder.
   - You can specify the path to your own backup folder or use the default backup folder. To specify the path, enter:
     - Windows: `filewin:/pathname-to-backup-folder/`
     - Mac OS: `filemac:/pathname-to-backup-folder/`
   - **Note** Click **Restore** to undo changes made to the path.

2. Click **Validate** to verify that the path of the backup folder exists and is accessible. If the path is not valid, see **Tips for valid folders**.

3. For **Maximum number of backups to keep**, select the maximum number of backups of the selected databases you want to keep for this scheduled backup.
   - For more information, see **About keeping multiple backups of a scheduled backup**.

4. Select **Verify backup integrity** to check whether the backup file passes the block-level validity tests. (The Consistency Check feature in FileMaker Pro performs the same tests.)
   - If you choose to send email notification later in the Schedule assistant, the status of this check is included in the email message.
   - For more information, see **Tips for database backups**.

5. Select **Clone the backup file** to save the tables, layouts, scripts, page setup options, and field definitions in your backed up databases without the data.

6. Click **Next**.
   - Click **Back** to return to the previous step or **Cancel** to exit the Schedule assistant.

**Notes**

- You can configure the default backup folder that appears in this step of the Schedule assistant. See **Default folder settings**.
- If you select **Clone the backup file**, FileMaker Server saves the clone files after the backup process is completed, and after verification is completed if you also select **Verify backup integrity**. FileMaker Server saves the clone files with the filenames `[original-filename] Clone.fp7` in a subfolder called `Cloned_by_FMS_[timestamp]`. This subfolder is located in the `ScheduleName_[timestamp]` backup folder.

**Related topics**

- Scheduling database backups
- Scheduling administrative tasks
Adding database close options

**Note**  The following information is for server administrators and group administrators.

In this Schedule assistant step, specify options that affect how FileMaker Server closes the selected databases.

**To add database close options:**

1. For **Delay time**, enter the number of minutes between when the notification is sent and when clients are disconnected.

2. In the text box, type the message to send to clients before they are disconnected.

   Clients see a notification dialog box with your message requesting they close their connection to a file.

   When the delay time elapses, FileMaker Server disconnects any remaining clients and closes the selected databases.

**Related topics**

*Scheduling administrative tasks*
Selecting the schedule frequency

*Note* The following information is for server administrators and group administrators.

In this Schedule assistant step, specify when and how often to run the scheduled task.

**To specify the schedule frequency:**

1. For *Frequency*, choose *Daily*, *Every n days*, *Once Only*, or *Weekly*.
2. Specify the *Schedule Details*, which depend on the frequency selected:

<table>
<thead>
<tr>
<th>Choose</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start Date</strong></td>
<td>Select the start date for this schedule. Click the calendar to select a date.</td>
</tr>
<tr>
<td><strong>End Date</strong></td>
<td>Select <em>End Date</em> and enter an optional ending date for this schedule. Click the calendar to select a date.</td>
</tr>
<tr>
<td><strong>Once per day</strong></td>
<td>Run the schedule at the selected <em>Start Time</em>. Enter the time of day to start.</td>
</tr>
<tr>
<td><strong>Run every</strong></td>
<td>Run the schedule at the interval specified in <em>Hours</em> or <em>Minutes</em>. You can also specify when to start and end running the schedule by selecting the <em>Start Time</em> and <em>End Time</em>.</td>
</tr>
<tr>
<td><strong>Days</strong></td>
<td>Select the days of the week to run the schedule.</td>
</tr>
<tr>
<td><strong>Start Time</strong></td>
<td>Select the start time to run the schedule.</td>
</tr>
</tbody>
</table>

For more information, see [Examples of repeating schedules](#).

3. Click **Next**.

   Click **Back** to return to the previous step or **Cancel** to exit the Schedule assistant.

*Note* If you have scheduled a Backup schedule and a Verify schedule on the same databases, allow enough time for the first schedule to complete before starting the second schedule.

**Related topics**

[Scheduling administrative tasks](#)
Naming the schedule

**Note** The following information is for server administrators and group administrators.

In this Schedule assistant step, specify a unique name for this schedule. This is the name that appears in the Schedules pane.

**To name the schedule:**

1. Enter a **Schedule Name**.
   **Note** The schedule name can contain up to 31 characters.

2. Click **Next**.
   Click **Back** to return to the previous step or **Cancel** to exit the Schedule assistant.

**Related topics**

*Scheduling administrative tasks*
Enabling email notifications in schedules

**Note**  The following information is for server administrators and group administrators. In this Schedule assistant step, you can enable a schedule to send an email notification when a task is completed.

**To enable email notification:**

1. Select **Send email notification**.
2. Enter the email addresses that you want to notify.
   
   You can enter multiple addresses separated by a comma.
   
   Example: `user1@email.com,user2@email.com,...`
3. Click **Next**.
   
   Click **Back** to return to the previous step or **Cancel** to exit the Schedule assistant.

**Notes**

- Email notifications are sent whether the schedule completes successfully or not. If email notification for errors or warnings is enabled on the General Settings > Email Notifications tab, a second email message is sent to the email addresses specified on the tab. If an email address appears on both lists, the addressee receives two email messages about the same event. See Receiving email notifications only when a schedule fails.

- Email notification requires the SMTP server configuration settings specified on the General Settings > Email Notifications tab. The SMTP server settings are checked when this Schedule assistant pane is displayed. If the SMTP server has not been configured, and you are a server administrator, the Schedule assistant opens a dialog box prompting you to configure the SMTP server after this schedule is created. See Email notification settings for configuration instructions. If you are a group administrator, you must contact the server administrator to configure the SMTP server for you.

**Related topics**

Scheduling administrative tasks
Receiving email notifications only when a schedule fails

Note The following information is for server administrators.

Administrators may want to receive email notifications only when a scheduled task fails. If you enable email notifications for a scheduled task, all addressees receive emails every time the task completes, whether the task fails or succeeds. To stop receiving these email messages, you can disable email notifications (or remove your email address from the list) for a specific schedule using the Schedule assistant.

Because FileMaker Server adds an entry in the Event.log file whenever a schedule fails, you can enable notifications for warnings and errors and receive an email only when a schedule fails.

To receive email notification only when a schedule fails to complete:

1. Create a new schedule or edit an existing schedule.
   For instructions on creating or editing a scheduled task, see Creating schedules or Editing schedules.

2. Confirm the schedule settings in each step and click Next in the Schedule assistant until you reach the Enable Email Notifications step.

3. To disable all email notifications for this schedule, clear Enable email notification.
   To continue sending email notifications to other addressees, leave email notifications enabled but remove the email addresses that you don’t want to receive email notifications.

4. Click Next, then Finish.

5. Choose the General Settings > Email Notifications tab.

6. Select Enable email notifications.

7. Choose Warnings or errors to send email notifications.

8. For Send Email Notifications to, enter the email address that you want to receive email notifications of errors and warnings.

Related topics
Enabling email notifications in schedules
Viewing log file entries
Reviewing schedule details

Note  The following information is for server administrators and group administrators.

In this Schedule assistant step, review the details of this schedule, then optionally enable this schedule to run at the times specified.

To review and enable the schedule:
1. Review the details. Select Back to return to the previous steps to change the schedule settings.
2. SelectEnable this schedule.
3. Click Finish to save the schedule.
   Click Back to return to the previous step or Cancel to exit the Schedule assistant.

Related topics
Scheduling administrative tasks
Selecting the script type

**Note** The following information is for server administrators and group administrators.

In this Schedule assistant step, you can choose to run a FileMaker script or a system-level script on FileMaker Server. For more information, see Running server-side scripts.

You can also run optional pre-processing and post-processing system-level scripts before and after a FileMaker script in a Script Sequence scheduled task. For more information, see Creating Script Sequence tasks.

Place system-level script files in the Scripts folder before starting the Schedule assistant:

- **Windows (32-bit):** `[drive]:\Program Files\FileMaker\FileMaker Server\Data\Scripts\`
- **Windows (64-bit):** `[drive]:\Program Files (x86)\FileMaker\FileMaker Server\Data\Scripts\`
- **Mac OS:** `/Library/FileMaker Server/Data/Scripts/`

**Note** (Windows only) If FileMaker Server is installed in a non-default location, the beginning portion of the default path shown above, \Program Files\FileMaker\FileMaker Server (Windows 32-bit) or \Program Files (x86)\FileMaker\FileMaker Server (Windows 64-bit), is replaced with the path that was specified during installation. For example: \My_Path\Data\Scripts\`

**To select the script type:**

1. Select the **Script Type**:

<table>
<thead>
<tr>
<th>Choose</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileMaker Script</td>
<td>Run a FileMaker script defined in a hosted database.</td>
</tr>
<tr>
<td>System-level Script</td>
<td>Run a system-level script file — such as a Windows batch command, VBScript, or Mac OS shell script (bash, Perl, Python) — that is in the Scripts folder.</td>
</tr>
<tr>
<td>Script Sequence</td>
<td>Run optional system-level script files before and after a FileMaker script runs.</td>
</tr>
</tbody>
</table>

2. Click **Next**.

   Click **Back** to return to the previous step or **Cancel** to exit the Schedule assistant.

**Notes**

- If you are a group administrator, your server administrator must configure your administrator group to allow you to create schedules that run scripts on the databases in your group folder. For more information, contact your server administrator.

**Related topics**

- Running FileMaker scripts
- Running system-level script files
- Scheduling administrative tasks
Selecting a database to run the FileMaker script

**Note** The following information is for server administrators and group administrators.

In this Schedule assistant step, select the database containing the FileMaker script that you want to run. For more information, see Running FileMaker scripts.

**To select a database with the FileMaker script to run:**

1. Select the **Database** from the list.
2. Choose the type of **account** that you want FileMaker Server to use when it runs the script.

<table>
<thead>
<tr>
<th>To</th>
<th>Choose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the built-in Guest account</td>
<td><strong>Guest Account</strong></td>
</tr>
<tr>
<td></td>
<td>No account name or password is necessary.</td>
</tr>
<tr>
<td>Use any other account</td>
<td><strong>Account Name and Password</strong></td>
</tr>
<tr>
<td></td>
<td>Choose the account that FileMaker Server uses to access the database every time the script runs. The account must have sufficient privileges to perform the script. For more information about accounts and privilege sets, see FileMaker Pro Help.</td>
</tr>
<tr>
<td></td>
<td>Enter the <strong>Account Name</strong> and <strong>Password</strong>.</td>
</tr>
</tbody>
</table>

3. Click **Next**.
   
   Click **Back** to return to the previous step or **Cancel** to exit the Schedule assistant.

**Related topics**

[Scheduling administrative tasks](#)
Selecting a FileMaker script to run

**Note** The following information is for server administrators and group administrators.

In this Schedule assistant step, select the FileMaker script that you want to run.

**To select a FileMaker script to run:**

1. Select the script from the **Script Name** list.
   
   **Tip** If a script group in the list is closed, click the icon beside the group name to open the group and view the scripts.

2. Enter an optional **Script parameter**.
   
   **Note** For more information on script parameters, see FileMaker Pro Help.

3. Click **Next**.
   
   Click **Back** to return to the previous step or **Cancel** to exit the Schedule assistant.

**Related topics**

- Running FileMaker scripts
- Scheduling administrative tasks
Selecting a system-level script to run

Note The following information is for server administrators and group administrators.
In this Schedule assistant step, you specify the system-level script to run, optional script parameters, and the user account to use to run the script. For more information, see Running system-level script files.

Place system-level script files in the Scripts folder before starting the Schedule assistant:

- Windows (32-bit): \[drive]\Program Files\FileMaker\FileMaker Server\Data\Scripts\n- Windows (64-bit): \[drive]\Program Files (x86)\FileMaker\FileMaker Server\Data\Scripts\n- Mac OS: /Library/FileMaker Server/Data/Scripts/

Note (Windows only) If FileMaker Server is installed in a non-default location, the beginning portion of the default path shown above, \Program Files\FileMaker\FileMaker Server (Windows 32-bit) or \Program Files (x86)\FileMaker\FileMaker Server (Windows 64-bit), is replaced with the path that was specified during installation. For example: \My_Path\Data\Scripts\n
If you do not see the script you want, click Cancel to exit the Schedule assistant, copy the script to the Scripts folder on the FileMaker Server computer, and run the Schedule assistant again.

To select a system-level script to run:

1. For Script name, select the system-level script.
2. Enter optional Parameters for the system-level script. Separate each parameter with a blank space. To include a blank space in a parameter, use quotation marks around the entire parameter. For example, “two words” is one parameter.
   Note For information on system-level script parameters, see the documentation for the scripting language you are using.
3. For Account to Run the System-level Script, select one of the following:
   - Default Account: In Mac OS, the default account is the fmserver user account. In Windows, the default account is Local System.
   - User Account: Specify a User Name and Password.
     In Mac OS, the User Name must refer to a local account on the master machine only and be specified without a domain name. In Windows, the User Name can refer to a local account on the master machine or a network domain account and be specified in any of the following formats: username, domainname\username, or username@domainname
4. Click Validate to verify that the account with the specified user name and password exists and is accessible.
5. Click Next.
   Click Back to return to the previous step or Cancel to exit the Schedule assistant.

Notes

- To use a user account to run a script in Mac OS, you must add the following entries to the /etc/sudoers file:
  
  Host_Alias FMSHOST = yourhostname
  Defaults:fmserver targetpw, timestamp_timeout=0, passwd_tries=1
  fmserver FMSHOST = (ALL) /Library/FileMaker\ Server/Data/Scripts/*, /bin/kill
For the Host Alias, enter the name of the host running FileMaker Server. You cannot use “localhost” or 127.0.0.1. To find out the correct host name to use, enter the following command in the Terminal application:

`hostname`

To edit the `/etc/sudoers` file, you must be the Administrator (root) and have Administrative privileges. You can edit the `/etc/sudoers` file using this command in the Terminal application:

`sudo visudo`

- **The User Account** you can use to run system-level scripts must have the correct privileges for the actions you want the script to perform. The type of account depends on your operating system:
  - In Windows, you can use the Local System account or a user account. The account can be a local account on the master machine or a network domain account.
  - In Mac OS, you can use the `fmserver` user account or a local user account on the master machine only. You cannot use a network domain account.

  If you choose the `fmserver` user account, you may need to modify file permissions for the script. Your script is executed with the `fmserver` user ID and `fmsadmin` group ID, so your script file must have read and execute permissions for the `fmsadmin` group. Therefore, if you choose the `fmserver` user account, you cannot call some privileged commands from your scripts. For example, your script does not have access to the `/etc` folder.

- **Script name** and **Parameters** added together can be a maximum of 2048 characters.
- In Windows, **User Name** can be a maximum of 104 characters, and **Password** can be a maximum of 128 characters.
- In Mac OS, **User Name** can be a maximum of 255 characters, and **Password** can be a maximum of 31 characters.

**Related topics**

*Scheduling administrative tasks*
Adding script sequence options

**Note** The following information is for **server administrators** and **group administrators**.

In this Schedule assistant step, you can select the optional **pre-processing** and **post-processing** system-level scripts to run before and after the FileMaker script, optional script parameters, and specify the account to use to run the scripts.

Place system-level script files in the Scripts folder before starting the Schedule assistant:

- Windows (32-bit): `{drive}\Program Files\FileMaker\FileMaker Server\Data\Scripts\`
- Windows (64-bit): `{drive}\Program Files (x86)\FileMaker\FileMaker Server\Data\Scripts\`
- Mac OS: `/Library/FileMaker Server/Data/Scripts/`

**Note** (Windows only) If FileMaker Server is installed in a non-default location, the beginning portion of the default path shown above, `{Program Files\FileMaker\FileMaker Server (Windows 32-bit)` or `{Program Files (x86)\FileMaker\FileMaker Server (Windows 64-bit)`, is replaced with the path that was specified during installation. For example: `\My_Path\Data\Scripts\`

If you do not see the script you want, click **Cancel** to exit the Schedule assistant, copy the script to the Scripts folder on the FileMaker Server computer, and run the Schedule assistant again.

**To add script sequence options:**

1. For **Run before**, choose an optional pre-processing system-level script that runs before the selected FileMaker script.
2. Enter optional **Parameters** for the pre-processing system-level script. Separate each parameter with a blank space. To include a blank space in a parameter, use quotation marks around the entire parameter. For example, "two words" is one parameter.

   **Note** For information on system-level script parameters, see the documentation for the scripting language you are using.

3. For **Run after**, choose an optional post-processing system-level script that runs after the selected FileMaker script.
4. Enter optional **Parameters** for the post-processing system-level script.
5. For **Account to Run the System-level Scripts**, select one of the following:
   - **Default Account**: In Mac OS, the default account is the `fmserver` user account. In Windows, the default account is Local System.
   - **User Account**: Specify a **User Name** and **Password**. In Mac OS, the **User Name** must refer to a local account on the `master` machine only and must be specified without a domain name. In Windows, the **User Name** can refer to a local account on the `master` machine or a network domain account and can be specified in any of the following formats: `username`, `domainname\username`, or `username@domainname`

6. Click **Validate** to verify that the account with the specified user name and password exists and is accessible.
7. Click **Next**.

   Click **Back** to return to the previous step or **Cancel** to exit the Schedule assistant.

**Notes**

- The **User Account** you can use to run system-level scripts must have the correct privileges for the actions you want the script to perform. The type of account depends on your operating system:
• In Windows, you can use the Local System account or a user account. The account can be a local account on the master machine or a network domain account.

• In Mac OS, you can use the fmserver user account or a local user account on the master machine only. You cannot use a network domain account.

  If you choose the fmserver user account, you may need to modify file permissions for the script. Your script is executed with the fmserver user ID and fmsadmin group ID, so your script file must have read and execute permissions for the fmsadmin group. Therefore, if you choose the fmserver user account, you cannot call some privileged commands from your scripts. For example, your script does not have access to the /etc folder.

• **Script name** and **Parameters** added together can be a maximum of 2048 characters.

• In Windows, **User Name** can be a maximum of 104 characters, and **Password** can be a maximum of 128 characters.

• In Mac OS, **User Name** can be a maximum of 255 characters, and **Password** can be a maximum of 31 characters.

• If you choose to send email notification later in the Schedule assistant, the email message includes any error or warning conditions or confirmation of a successful completion of the Script Sequence scheduled task.

For more information, see [Creating Script Sequence tasks](#).

**Related topics**

[Creating Script Sequence tasks](#)
Adding script options

**Note** The following information is for server administrators and group administrators.
In this Schedule assistant step, you can select time limit options for the script schedule.

**To add script options:**

1. For **Time limit**, select the maximum amount of time you expect the sequence to complete.
2. Select **Abort schedule if time limit reached or server stopped** if you want to abort the scheduled task if the script or script sequence takes longer to run than the specified **Time limit**, or if the Database Server stops.
3. Click **Next**.
   Click **Back** to return to the previous step or **Cancel** to exit the Schedule assistant.

**Notes**

- If you select **Abort schedule if time limit reached or server stopped** and the specified **Time limit** is exceeded, or if the Database Server stops, the script or script sequence is aborted and FileMaker Server logs an Error message in the Event log.
- If you do not select **Abort schedule if time limit reached or server stopped**, FileMaker Server logs a Warning message and the script scheduled task continues to run if the specified **Time limit** is exceeded, or if the Database Server stops. Use the following methods to stop a script that hangs in an incomplete state such as an infinite loop:
  - To stop a FileMaker script, select the FileMaker script in the **Clients** pane and choose **Disconnect** from **Actions**.
  - To stop a system-level script, locate the script's process ID in the Event log and terminate the process in the Activity Monitor on Mac OS or Task Manager on Windows.

**Related topics**

*Scheduling administrative tasks*
Selecting users to send a message to

**Note** The following information is for server administrators and group administrators.

In this Schedule assistant step, select the users that you want to receive a message. You select users by choosing one or more databases. Any FileMaker Pro user who is connected to one of these databases will receive the message.

**To select users to send a message to:**

1. Select one of the following options for sending a scheduled message:

<table>
<thead>
<tr>
<th>Choose</th>
<th>To</th>
</tr>
</thead>
</table>
| **All FileMaker Pro users (all databases)** | • (Server administrators) Send a scheduled message to all FileMaker Pro users connected to hosted databases.  
• (Group administrators) Send a scheduled message to all FileMaker Pro users connected to hosted databases in your administration group. See the following note. |
| **FileMaker Pro users of databases in folder** | Send a scheduled message to FileMaker Pro users connected to hosted databases in a specified folder. See the following note. |
| **FileMaker Pro users of a selected database** | Send a scheduled message to FileMaker Pro users connected to a selected hosted database. |

2. Click **Next**.

   Click **Back** to return to the previous step or **Cancel** to exit the Schedule assistant.

**Note** If you are a group administrator and your server administrator did not select the default database folder or the additional database folder for your administrator group, the **FileMaker Pro users of databases in folder** option is not available. For more information, contact your server administrator.

**Related topics**

- Sending scheduled messages to clients of hosted databases
- Scheduling administrative tasks
Creating a message

*Note*  The following information is for server administrators and group administrators.

In this Schedule assistant step, create a message for FileMaker Pro users.

**To create the message:**

1. Type the message that you want to send.
2. Click **Next**.
   
   Click **Back** to return to the previous step or **Cancel** to exit the Schedule assistant.

**Related topics**

- Sending scheduled messages to clients of hosted databases
- Scheduling administrative tasks
Ports used by FileMaker Server

**Note** The following information is for server administrators.

When running FileMaker Server in an environment that uses a firewall, be sure to configure the firewall on each machine to allow FileMaker Server to communicate. The table below lists all the ports used in a FileMaker Server deployment.

**Note** Not all of the ports listed below need to be open to end users or between all machines in a FileMaker Server deployment. For more information on deploying on multiple machines, see FILEMAKER SERVER GETTING STARTED GUIDE on the Start Page.

End users need only these ports to be open:

- Port 80 for web publishing, or another port if your web server uses a port other than the default
- Port 5003 for FileMaker Pro clients.

Admin Console users need ports 16000 and 16001 to be open.

<table>
<thead>
<tr>
<th>Port number</th>
<th>Used by</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>80</td>
<td>Web server machine, end users</td>
<td>HTTP</td>
</tr>
<tr>
<td>5003</td>
<td>Master machine, end users</td>
<td>FileMaker Pro and FileMaker Server for hosting files</td>
</tr>
<tr>
<td>5013</td>
<td>Master machine (local only)</td>
<td>FileMaker Server Helper service (Windows) or background process (Mac OS)</td>
</tr>
<tr>
<td>16000</td>
<td>All machines, Admin Console users</td>
<td>HTTP: Admin Console Start Page, Admin Helpers</td>
</tr>
<tr>
<td>16001</td>
<td>Master machine, Admin Console users</td>
<td>HTTPS: Admin Console communications</td>
</tr>
<tr>
<td>16004</td>
<td>All machines</td>
<td>Admin Console</td>
</tr>
<tr>
<td>16006</td>
<td>Web Publishing Engine machine</td>
<td>FileMaker Internal</td>
</tr>
<tr>
<td>16008</td>
<td>Web Publishing Engine machine</td>
<td>FileMaker Internal</td>
</tr>
<tr>
<td>16010</td>
<td>Web Publishing Engine machine</td>
<td>Custom Web Publishing Engine</td>
</tr>
<tr>
<td>16012</td>
<td>Web Publishing Engine machine</td>
<td>FileMaker Internal</td>
</tr>
<tr>
<td>16014</td>
<td>Web Publishing Engine machine</td>
<td>FileMaker Internal</td>
</tr>
<tr>
<td>16016</td>
<td>Web Publishing Engine machine</td>
<td>Apache Jakarta Protocol (AJP) 1.3</td>
</tr>
<tr>
<td>16018</td>
<td>Web Publishing Engine machine</td>
<td>Apache Jakarta Protocol (AJP) 1.3</td>
</tr>
<tr>
<td>50003</td>
<td>Master machine (local only)</td>
<td>FileMaker Server service (Windows) or background process (Mac OS)</td>
</tr>
</tbody>
</table>

**Related topics**

Network problems
**Tips for valid folders**

**Note** The following information is for server administrators and group administrators.

The folders you specify as a backup folder and as an additional database folder must be valid.

- Specify a folder on a local volume, not on a remote volume.
  - If you want to store database backups on a remote volume, first backup the database to a local volume, and then copy the backup to a remote volume.
- Ensure that the folder has permissions set correctly so that FileMaker Server can read and write to the folder.
  - (Mac OS) The folder must be owned by the user `fmserver` (or in the group `fmsadmin`).
- Specify the folder as an absolute path:
  - Windows: The path you enter must start with `filewin:/` and end with a slash (`/`).
    - For example, `filewin:/driveLetter:/folderName/`
  - Mac OS: The path you enter must start with `filemac:/` and end with a slash (`/`).
    - For example, `filemac:/volumeName/folderName/`
- The backup folder cannot be a parent or a subfolder of the default database folder, the additional database folder, or the Scripts folder. The additional database folder cannot be a parent or a subfolder of the default database folder, the backup folder, or the Scripts folder. See Default folder settings and Tips for valid folders.

Refer to the FileMaker Knowledge Base for more information. See Customer support and Knowledge Base.

**Related topics**
Default folder settings